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Introduction 

Trademarks 
MatchWare, MatchWare Mediator, MatchWare MindView and MatchWare ScreenCorder are trademarks or 
registered trademarks of MatchWare A/S. 

Mind Map and Mind Mapping are registered trademarks of the Buzan Organisation. 

Microsoft, Microsoft Office, Microsoft Word, Microsoft PowerPoint, Microsoft Excel, Microsoft Project, 
Microsoft Outlook, Microsoft FrontPage, Microsoft Windows, Windows Media Player, Windows Explorer and 
Internet Explorer are trademarks or registered trademarks of Microsoft Corporation. 

The 2007 Microsoft Office Fluent User Interface is subject to protection under U.S. and international 
intellectual property laws and is used by MatchWare A/S under license from Microsoft. 

Netscape is a registered trademark of Netscape Communications. 

Flash is a trademark of Adobe Systems Inc. (formerly Macromedia, Inc.). 

Other brand or product names are trademarks or registered trademarks of their respective holders. 

 

This Product is copyrighted © 2002-2009 by MatchWare A/S. All rights reserved. 

MatchWare and MatchWare MindView are trademarks or registered trademarks of MatchWare A/S. Other brand 
or product names are trademarks or registered trademarks of their respective holders. 

Information given in this documentation can be changed and represents no obligation on MatchWare, its 
Publishers or Agents. This documentation is copyrighted © 2002-2009 by MatchWare A/S. All rights reserved. 
This documentation is not to be copied, photocopied, reproduced, translated or transferred to an electronic media 
or machine sensible form without a written authorization from MatchWare or its Publishers. 
 

IMPORTANT You should read the following MatchWare License Agreement (EULA) carefully. If you install, 
copy, download, or use this software Product, you agree to be bound by the terms of this agreement. If you do 
not agree with the conditions, you are not entitled to install and use the software, and should immediately return 
the software package and all other material in this package along with proof of payment, to the authorized dealer 
from whom you obtained it for a full refund of the price you paid. Do not make any illegal copies. 
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MatchWare License Agreement 
USE 

This is a legal agreement between you, the end user, and MatchWare A/S ("MatchWare"). The enclosed software 
program ("Product") is licensed, not sold, to you by MatchWare for use under the term of this license. 

Prior to using the license to the Product you must assign it to a device, which becomes the "licensed device". A 
hardware partition, blade, external hard drive, Flash drive etc. is considered to be a separate device. 

You may install and use one copy of the Product on the licensed device. Further, the primary user of the licensed 
device may install and use another copy of the Product on a laptop. 

This Product may be freely moved from one computer or location to another, so long as there is no possibility of 
it being used by more than one person at a time. You may make one (1) backup copy of the Product. 

A Terminal Server is a computer allowing other Client computers to run applications on the Terminal Server 
such as but not limited to a Microsoft Terminal Server and a Citrix Server. If the Product is installed on a 
Terminal Server you need a license for each Client computer that can run the Product. 

You may add users by paying for a separate license for each device you wish to add. When installing the Product 
on a server which allows multiple, concurrent users to access and run the Product, you must license (purchase) 
additional licenses for each computer. 

When using Remote Desktop technologies you may access and use the Product provided that only the primary 
user of the device hosting the remote desktop session accesses and uses the Product with a remote access device. 
You are not permitted to use the Product on both the device hosting the remote desktop session and the access 
device at the same time. 

You may not rent, lease, loan or license this Product or any copy. 

You may not reverse-engineer, disassemble, decompile, modify or create derivative work of this Product. 

ACTIVATION 

Mandatory activation is required when using the Product. When activating the Product certain information about 
the Product and the device will be sent to MatchWare. This information includes version, language, product ID 
of the Product, device internet protocol address and hardware configuration. By using the Product you consent to 
the transmission of this information. 

EDUCATIONAL LICENSES 

Commercial use of Educational Licenses of this Product is prohibited. 

You agree to not use an Educational License to engage in commercial activities including, without limitation, the 
following activities:  

• offering for sale any products or services;  

• soliciting for advertisers or sponsors;  

• conducting raffles or contests that require any type of entry fee;  

• displaying a sponsorship banner of any kind, including those that are generated by banner or link exchange 
services; and  

• displaying banners for services that provide cash or cash-equivalent prizes to users in exchange for 
hyperlinks to their web sites. 

Some educational multi-user licenses offer home use rights for teachers (and students). Any additional DVDs 
purchased to facilitate such home use may not be installed or used on the respective educational institution 
premises, buildings or campus. 
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TRANSFER OF THE PRODUCT 

You may transfer all of your rights to use the Product to another person, provided that you transfer to that person 
the entire Product package, DVDs, documentation, and this statement, and transfer or destroy all copies in any 
form. Once you transfer the Product you no longer have any rights to use it. Only the person to whom the 
Product is transferred may use it in accordance with the copyright law, international treaty and this statement. 

If you have purchased an upgrade version of the Product, it constitutes a single product with the MatchWare 
Product that you upgraded. For instance, the upgrade and the Product that you upgraded cannot both be available 
for use by two different persons at the same time and cannot be transferred separately. 

COPYRIGHT 

All intellectual property rights in the Product and user documentation are owned by MatchWare A/S or its 
suppliers and are protected by United Kingdom copyright laws, other applicable copyright laws and international 
treaty provisions. MatchWare A/S retains all rights not expressly granted. 

CLIPART 

This Product may contain clipart ("Clipart") such as images, sounds, video clips etc. All intellectual copyright 
for the Clipart is owned by MatchWare A/S or licensed by MatchWare A/S. 

MatchWare grants you a non-exclusive, non-sublicensable right to use the Clipart in presentations or web sites 
created with this Product, including in runtime versions of the Product. There is no royalty due for such use to 
MatchWare. The Clipart may not be sublicensed or made available to any person or entity that does not have a 
legal license of this Product. 

RUNTIME VERSIONS 

In some MatchWare products (including this Product) you have the opportunity to make runtime versions or web 
sites of your applications. Your runtime versions or web sites and the distribution of them are subject to all of the 
following conditions: 

• You may not remove or alter any MatchWare copyright, trademark, or any other proprietary rights. 

• You may not use MatchWare's or any of its suppliers' names, logos, or trademarks to market your runtime 
version. You may state that your runtime version was made using this MatchWare Product. 

• You will remain solely responsible to anyone receiving your runtime versions or web site for support, 
service, upgrades, or technical assistance. The recipients will have no right to contact MatchWare for such 
services or assistance. 

• You will indemnify and hold MatchWare, its related companies and its suppliers harmless from and against 
any claims or liabilities arising out of the distribution of your runtime versions. 

LIMITED WARRANTY 

MatchWare warrants the physical media and physical documentation provided by MatchWare to be free of 
defects in materials and workmanship for a period of ninety (90) days from the original purchase date. 
MatchWare will replace defective media or user documentation at no charge, provided you return the item within 
the warranty period. If MatchWare is unable to replace defective media or user documentation, MatchWare will 
refund the amount you paid for the Product. These are your sole remedies for any breach of warranty. 

LIMITATION OF LIABILITY 

The entire and exclusive liability and remedy for breach of the foregoing limited warranty shall be limited to 
replacement of defective media or documentation. In no event shall either party be liable to the other party for 
any special, indirect, consequential, exemplary, punitive, incidental, or similar damages, including but not 
limited to, loss of profit, data, or use of the Product, even if MatchWare has been advised of the possibility of 
such damages. MatchWare makes no representation or warranty that the Product or documentation are "error 
free" or meet any of the user's particular standards, requirements, or needs. In no event shall MatchWare's 
liability exceed the aggregate amounts paid by you pursuant to this Agreement. To the extent that applicable law 
does not allow the exclusion or limitation of implied warranties or limitation of liability for incidental or 
consequential damages the above limitation or exclusion may not apply to you. 
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INTELLECTUAL PROPERTY INDEMNITY 

MatchWare will, at its expense, indemnify, defend and hold Customer harmless against any and all action 
brought against you to the extent that it is based on a claim that the MatchWare Product or any part thereof or 
any MatchWare trademark used in relation thereto, when used within the scope of this Agreement, infringes any 
trademark, copyright, trade secret, patent or other intellectual property right, and MatchWare will pay any costs, 
damages and/or attorneys' fees awarded against you in such action or payable pursuant to a settlement agreed to 
by MatchWare. The foregoing obligation shall be subject to you notifying MatchWare promptly in writing of the 
claim, giving MatchWare the exclusive control of the defense and settlement thereof, and providing all 
reasonable assistance in connection therewith.  

U.S. GOVERNMENT RESTRICTED RIGHTS 

This Product and documentation are provided with RESTRICTED RIGHTS. The Product and documentation are 
developed at private expense and no part of them is in the public domain. Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subparagraph c(1) and (2) of the Commercial Computer 
Software Restricted Rights clause at FAR 52.277-19 or subparagraph c(1) (ii) of the Rights in Technical Data 
and Computer Software clause at DFARS 252.227 - 7013. Manufacturer is MatchWare A/S, Vestergade 48F, 
8000 Århus C, Denmark.  

GENERAL 

This agreement is governed by English law and any dispute connected with this agreement and/or the Software is 
subject to the exclusive jurisdiction of the English courts. The export of this product is governed by U.S and UK 
export regulations. 
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Welcome 

 

 

Welcome to MatchWare® MindView™, the perfect tool for businesses, educators and students who need to 
organize information! Easy to learn and easy to use, MindView is a highly effective way of brainstorming, 
developing and structuring ideas visually. Ideal for use by individuals, small teams or large groups, MindView 
generates illustrated Mind Maps® which you can use in presentations, reports, web sites and more. With a 
comprehensive range of export options to Microsoft® Office applications, MatchWare® Mediator, HTML and 
other formats, MindView is an effective and versatile concept development tool. 

Mind Maps are illustrated frameworks of organized, prioritized, linked ideas that develop or relate to a subject or 
concept. 

 

Mind Maps have been demonstrated to help individuals and businesses achieve higher levels of performance by 
increasing productivity and organization skills. 

Outlining written documents 
Using the Mind Mapping technique makes it very easy to outline your written documents such as meeting 
agendas, proposals and marketing plans. MindView allows you to brainstorm ideas for your main topics in a 
completely free and non-linear way. One of the great benefits of using MindView, as opposed to brainstorming 
on a piece of paper, is that MindView allows you to reorganize your ideas in the right order by dragging and 
dropping them in the Mind Map once you have finished listing them. 

When you export your Mind Map to Microsoft® Word, you can choose from a variety of creative templates 
designed to give your document a professional look instantly. Main ideas are exported as main headings, sub-
ideas are exported as sub-headings and so on. All the text notes, comments, pictures and other elements which 
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you have placed on the Mind Map are also exported. This means that you can actually start writing your report 
while brainstorming in MindView, as the complete text is included in the exported Word document. 

Once you start developing your document in Word, you may realize that you have forgotten some key ideas that 
you would like to brainstorm in MindView first. All you need to do in that case is to import your Word 
document back into MindView, add the new ideas to your Mind Map, and then re-export to Word. 

Working with numbers 
The Calculation module of MindView Business Edition allows you to add values to the branches of your Mind 
Map, for example sales numbers, costs, exchange rates and so on, as well as formulas to carry out calculations on 
the values. Built-in functions allow you to display values automatically rolled up from lower sub-branches to 
higher ones. 

If for instance you have created a Mind Map to track worldwide sales, you can then export it as an Microsoft® 
Excel spreadsheet in order to continue working directly in Excel. 

Conversely, you can also import an Excel spreadsheet in MindView. Values and formulas (provided they are 
supported by MindView) will be preserved in the Mind Map created by this process. 

 

Working with task lists 
Use Mind Mapping to brainstorm, visualize and organize your tasks. Then convert your Mind Map into a 
detailed implementation plan by adding task information such as dates, resources, priorities and completion 
percentages. 

Task lists can be created in an instant and displayed in the Outline view or exported to Microsoft® Outlook. 
You can also import task lists from Outlook and synchronize information between MindView and Outlook to 
eliminate redundancies. 

Working with project plans 
The MindView Gantt view, specific to the Business Edition, is a specialized view, dedicated to the creation, 
editing and management of project plans according to the rules of project management. 

MindView lets you build, view and manage complex project plans in the Gantt view. Setup deadlines, milestones 
and dependencies while keeping an eye on the critical path to ensure your team delivers on time every time. 
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If necessary, you can easily export your project plan to Microsoft® Project to take advantage of its advanced 
project management capabilities. You can also import existing project plans directly from Microsoft Project or 
via the Microsoft Project XML format if you prefer to use the easy-to-understand, visual MindView interface. 

 

Working with timelines 
The MindView Timeline view is a great way of displaying time-related information such as company history, 
marketing plans, production plans and historical data. Simply add dates or times to your branches and switch to 
the Timeline view to see the information displayed along a horizontal time axis. Different timescales (for 
example standard, weekly or daily) let you tailor the timeline to suit your needs. You can zoom in or out, expand 
or contract the timeline scale, and condense empty stretches of the timeline by inserting break marks. 

 

Working on presentations and web sites 
MindView has been optimized for storyboarding and planning web sites and multimedia presentations, which 
you can then export to Microsoft® PowerPoint, MatchWare® Mediator or HTML: 

• When storyboarding presentations, an idea in your Mind Map represents a slide (PowerPoint) or a page 
(Mediator) in your presentation, a sub-idea represents a sub-page or sub-slide and so on. 

• You can attach files to branches (ideas) in the Mind Map, such as Flash files, pictures, text, sounds and 
videos. These files are included when you export to PowerPoint, Mediator or HTML and displayed on their 
respective pages. 

• MindView lets you create hyperlinks, branch connections and other interactivity that is also included when 
exporting. 

• The Export Wizards include a range of ready-made templates with built-in navigation, which you are free to 
customize and save for further use. 
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• MindView allows basic web editing during the HTML export. You can for instance place the various 
elements where required on each individual page. No coding or scripting necessary! 

• Once exported, you can import your Mediator or PowerPoint presentation back into MindView if you need 
to storyboard more pages or slides. 

Using the ready-made templates 
MindView provides you with detailed business templates for use in the standard Mind Mapping views, as well as 
ready-made project plans specific to the Gantt view, covering a range of common business activities. 

You can base your own documents on any of these templates, and customize them as required to meet your 
particular needs. Comments and suggestions for expansion are given in their notes and pop-up comments. 
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What's new in MindView 3 

 MindView 3 has many new features, which are fully described in the User Guide part of this 
documentation. Here is a brief description of the most important enhancements. 

New interface: MindView 3 has a brand new user interface based on the Microsoft Office Fluent™ interface 
used in Microsoft Office 2007 (also referred to as the Ribbon), which helps you create, present and share 
impressive mind maps much more efficiently than you could in earlier versions of MindView. This new interface 
has several major advantages: 

• Its features and commands are organized in task-oriented tabs and groups of related options, enabling you to 
find what you need quickly, using an intuitive and visual approach. 

• Rather than applying single properties one by one, you can select predefined styles for your branches and 
map elements from easily accessible galleries, making it much easier and much faster to create great-looking 
documents.  

• The live preview feature lets you review the effect of the various formatting options before you commit to 
them, resulting in a significant time gain. 

For more information on this new interface, see "Setting up your workspace". 

Templates: MindView 3 Business Edition includes a number of new business templates, which you can 
customize as required to meet your particular needs. Ideas and suggestions for expansion are given in their many 
notes and pop-up comments. 

To help you get started, MindView also includes various ready-made project plans for common business 
activities (organizing a tradeshow, producing a publication, launching a product and so on) for use in the Gantt 
view. You can use these for training purposes, or as a basis for your own project plans. 

 To access a template click the MindView Button, choose New From Template and select the template you 
want to use from the appropriate category. 

Map layouts and styles: For each view, MindView 3 offers you a choice of predefined layouts, styles and 
galleries, letting you change the overall look of the map and apply branch shapes, branch colors and other 
coordinated attributes in one step. Simply hover over the contents of a particular gallery to visualize the effect of 
the different options on your map, then click your choice to apply it. 

Calculation: MindView 3 Business Edition allows you to add values to the branches of your Mind Map, for 
example sales numbers, costs, exchange rates and so on, and also formulas to carry out calculations on the 
values. Built-in functions allow you to display values automatically rolled up from lower sub-branches to higher 
ones. You enter values using the Calculation panel, conveniently accessed from a tab on the right of the 
workspace. 

Values appear on the Mind Map under the branch labels. For any branch, you can choose to display or hide the 
values as you wish. 

For more information, see "Inserting calculation values". 

Excel export and import: With MindView 3 Business Edition you can export your Mind Map as a Microsoft® 
Excel spreadsheet and import an Excel spreadsheet as a Mind Map. Values and formulas (provided they are 
supported by MindView) are preserved. If for instance you have created a Mind Map to track worldwide sales, 
you can export it as an Excel spreadsheet in order to continue working directly in Excel. 

When exporting, you can choose from several professionally designed templates to enhance the look of the 
spreadsheet. 

For more information, see "Exporting to Microsoft Excel" and "Importing from Microsoft Excel". 

Timeline layouts: MindView 3 gives you the choice of several timeline layouts, letting you change the overall 
appearance of your timeline in one step to the format that suits your purpose best. Once you've selected your 
timeline layout, you can easily customize it further by selecting a different color scheme, applying a numbering 
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scheme, turning duration bars on or off and so on. Individual colors can also be applied to each event (branch) 
for emphasis. 

Timeline editing: MindView now lets you enter events directly on the timeline. Simply double-click the time 
axis and a dialog box will pop up, prompting you for the name of the event and its associated time. You can also 
move events directly on the timeline simply by dragging them to a different time position. 

For more information, see "Using the Timeline view". 

Numbering schemes: MindView 3 comes with various numbering schemes that let you visualize how your map 
branches are ordered and make it easy to understand how they will be exported. On a timeline, a numbering 
scheme is useful for identifying branches (events) that belong together. 

New icons: MindView 3 features new sets of branch icons, including dynamic icons denoting priorities, 
completion levels and other values which you can quickly increase or decrease by simply clicking the icon. See 
"Inserting icons" for more information. 

Branch boundaries: MindView 3 allows you to do extensive customization of the boundaries surrounding your 
sets of branches and sub-branches. You can for instance apply color gradients of different directions to the area 
within the boundary, change the width or type of the boundary line, while always seeing the effect produced on 
the live preview before applying the option. 

Focus mode: MindView's new Focus mode is designed to help you present your Mind Map. As soon as you 
click the branch you want to concentrate on, the map becomes centered on that branch. If necessary, the zoom 
factor is also increased automatically for maximum legibility. This lets you present and review your Mind Map 
by focusing on each branch in turn while discussing all the issues involved, returning to the normal mode of 
working at the end of the presentation. 

See "Viewing a Mind Map" for more information. 

Advanced filter: The new MindView filter lets you define criteria, and then locate the branches of your 
document that meet these criteria by hiding all the other branches. Using filters, you can for instance display 
only branches containing a specific label, or timeline events starting at a specific date. You can combine a range 
of criteria in the same filter, define different filters and save filters for future use. 

See "Filtering a Mind Map" for more information. 

New export templates: To ensure that your maps maintain their professional appearance when exported, 
MindView 3 includes new and innovative templates for Word and PowerPoint, as well as for HTML. 

Pack & E-mail: MindView 3 lets you create a complete packed version of your Mind Map, ready to be sent via 
email, shared over the network or distributed via DVD or CD-ROM. When packing a map, all the external files 
that are attached to it (floating pictures, branch pictures, attachments and so on) are integrated within the packed 
map file.  

Once a map is packed, you can continue working with it as normal. Any attached file you activate from within 
the map opens in the relevant external application, letting you edit it as you wish. When you close this external 
application, all the changes you have made are saved in the version of the attachment that is integrated to the 
packed map file. 

See "Packing a Mind Map" for more information. 

The new Send function creates a message in your default mail program, containing not only the packed map, but 
also a link to a free MindView viewer in case your recipients do not have MindView installed on their computer. 

See "Sending a Mind Map" for more information. 

Desktop search: MindView 3 supports Windows Search on Windows XP and above, letting you locate specific 
data within the Mind Maps stored on your hard disk and identify the relevant files instantly. All the data 
contained within your MindView documents is searched, including branch text, comments and searchable 
embedded files (such as Word documents). 

For more information, see "Finding and replacing text". 

Collaboration: MindView 3 supports SharePoint, the Microsoft browser-based collaboration and document 
management platform as well as WebDAV, the set of extensions to HTML that allows users to collaboratively 
edit and manage files on remote web servers. MindView is therefore able to open and save documents directly 
on a WebDAV or SharePoint server. 
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Tablet PC/ Interactive whiteboard support: MindView 3 now supports pen input as well as standard 
keyboard/mouse input, letting you insert digital ink data such as handwritten text and hand-drawn pictures on 
your branches. Although MindView's pen input features let you treat your computer mouse as a pen, they are 
designed for use with dedicated pen input devices such as tablet PC's, external digitizers, touch screens and 
interactive whiteboards. The only requirement is that the operating system on which MindView is installed must 
also support pen input (e.g. Windows XP Tablet PC Edition, all editions of Windows Vista with the exception of 
the Home Basic and Starter editions, Windows 7). 

See "Working in Pen Mode" for more information. 
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Important terms 
Many of the terms used in MindView belong to the standard Windows terminology. Some terms, however, are 
specific to MindView or related to the Mind Map concept and may be unfamiliar to you.  

Attachments and hyperlinks 

MindView allows you to attach various objects to the root or branches of your Mind Map, such as text 
documents, pictures, videos, sounds, Flash™ files or URL links, which you can activate from within the Mind 
Map. These objects are listed in the MindView Object list, and can all be exported when exporting your map to a 
different format. See "Attaching objects" and "Creating hyperlinks" for more information. 

Branch connections 

A branch connection is used to indicate visually that two branches are conceptually related. This relationship is 
identified on a map by an arrow-headed line joining the source branch to the end branch. See "Creating branch 
connections" for more information. 

Calculation values 

MindView 3 allows you to add values to the branches of your Mind Map, for example sales numbers, costs, 
exchange rates and so on, as well as formulas to carry out calculations on the values. You enter values using the 
Calculation panel, accessed from a tab on the right of the workspace. 

For more information, see "Inserting calculation values". 

Comments 

Comments are short notes that you can add to the root of your map, to a branch or to the workspace itself. See 
"Inserting comments" for more information. 

Document 

Each MindView document you create opens in a separate tab bearing the name of the document. A MindView 
document can contain several maps. You can also keep several documents open at the same time in MindView. 
MindView documents are saved with the extension .mvdx. See "Creating a Mind Map" for more information. 

Export 

Once you have finished the design of your document, you can export it to other formats, such as a Microsoft® 
PowerPoint presentation, a Microsoft® Word or .RTF document, a Microsoft® Excel spreadsheet, a Microsoft® 
Project document, a Microsoft® Outlook task list, a MatchWare Mediator document or a picture. You can also 
export to HTML and XML. 

See the section "Exporting" for more information. 

Gantt view 

The MindView Gantt view, specific to the Business Edition, is dedicated to the creation, editing and 
management of project plans according to the rules of project management. The Gantt view is made of two parts, 
an Outline on the left which represents the project plan as a hierarchical list of tasks, and a Gantt chart on the 
right, which shows the tasks as horizontal bars arranged against a background calendar display. 

See "Using the Gantt view" for more information about project plans and project management. See also the 
definition of a project plan in this topic. 

Import 

Not only can you export your document to PowerPoint, Word, Excel, Outlook, Microsoft Project or Mediator, 
but you can re-import the exported document into MindView as a new document, while preserving much of the 
additional work you might have done on the document in these external applications. You can also import into 
MindView documents originally created in PowerPoint, Word, Excel, Microsoft Project or Mediator as well as 
task lists from Outlook and XML documents. 

See the section "Importing" for more information. 
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Icons 

MindView lets you place icons on the branches of your Mind Map to attract attention or illustrate a particular 
idea. Using icons, you can for instance represent visually the status of a particular topic, its importance, and so 
on. See "Inserting icons" for more information. 

Left/Right view 

This view represents your Mind Map as a list of topics placed either on the right of the root (Right view) or on 
the left of the root (Left view). It is a good choice when you need to present data in a list form and want to be 
able to fully explore each point in the list before going on to the next point. See "Using different views" for more 
information. 

Main branch 

The main branches are the branches that are directly connected to the root. They represent the main topics related 
to the subject of your Mind Map. See "Inserting branches" for more information. 

Mind Map 

A Mind Map is made up of its root, all its branches and sub-branches and all inserted elements (icons, 
comments, text notes and so on) and attached objects (text files, picture files, video files, hyperlinks and so on). 
Note that MindView allows you to create several different maps in the same document. 

Mind Map view 

This is the default view when creating a new Mind Map. It represents the map with the root in the center, and all 
the main branches radiating from it in a clockwise direction. This is a good view to use when brainstorming 
ideas for a Mind Map without worrying about evaluating or structuring them. See "Using different views" for 
more information. 

Outline view 

The Outline view represents the map as a hierarchical list which you can expand and collapse as required. It 
allows easy navigation through the document from top to bottom and gives you another way to brainstorm ideas. 
For detailed information about working in the Outline view, see "Using the Outline view". 

Pack & Unpack 

This feature allows you to distribute your Mind Map to other users very easily. With a few mouse clicks, you can 
create a packed map containing all the pictures and files you may have attached to it, ready to be accessed over 
the network or distributed by email. See "Packing a Mind Map" for more information. 

Pre-branch 

A pre-branch is a branch that you insert before the currently selected branch. See "Inserting branches" for more 
information. 

Project plan 

A project plan is a series of interdependent tasks that need to be performed in a particular order. A project plan 
has a specific start date, corresponding to the start of the first task, and a specific end date, corresponding to the 
end of the last task and the completion of the project. If one task runs late, all the tasks that are dependent on the 
delayed task are affected and their dates are automatically recalculated. MindView lets you build, view and 
manage complex project plans in the Gantt view. See "Using the Gantt view" for more information about project 
plans and project management. 

MindView also supports the creation of task lists, which are much simpler than project plans. See the definition 
of a task list in this topic. 

Root 

The root is the central block that appears when you create a new Mind Map. It represents the subject of the map. 
Any branch that you attach directly to the root is a main branch. See "Inserting branches" for more information. 

Sub-branch 

Any branch belonging to a main branch is called a sub-branch. Each sub-branch can have its own sub-branches. 
Sub-branches represent various levels of sub-topics. See "Inserting branches" for more information. 
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Task list 

A task list is a series of individual tasks which are not connected to each other. If one task is delayed, this has no 
effect on any of the other tasks. MindView lets you add task information such as dates, priorities and resources 
to the branches of your document in order to create simple task lists. See "Inserting task data" for more details. 

MindView also lets you build and manage project plans, which are more complex than task lists. See the 
definition of a project plan in this topic. 

Templates 

MindView comes with a large number of educational, business and personal templates on which you can base 
your own Mind Maps. You can also save your own Mind Maps as templates for future use. See "Saving a Mind 
Map" for more information. Templates are saved with the extension .mvtx. 

Text notes 

Text notes, unlike comments, are comprehensive notes that you can enter using the Text Note editor and 
associate with the root or any branch of your map. See "Inserting text notes" for more information. 

Timeline view 

The Timeline view lets you see all the branches of your Mind Map that contain time information displayed in 
chronological order along a horizontal time axis. Different timescales (for example standard, geological and 
historic) let you tailor the timeline to suit your needs. For more information on the Timeline, see "Using the 
Timeline view". 

Top Down view 

This view represents your Mind Map as a hierarchical pyramid, with the root at the top, the main branches 
underneath, the sub-branches below the main branches and so on. It is a useful representation for structured data 
which needs to be viewed in a hierarchical manner, in other words from the higher level to the lowest levels. See 
"Using different views" for more information. 
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MindView Installation 

Stand-alone installation 
 Insert the DVD in the drive. 

 Follow the instructions on the screen when the MindView Install program starts. 

If the MindView Install program does not start automatically: 

 Choose Start - Run. 

 Type the following: 

X:\start.exe 

where X represents the DVD drive letter. 

Administrative installation (system administrators only) 
The Windows® Installer can perform an administrative installation of an application or product to a network for 
use by a workgroup. An administrative installation installs a source image of the application onto the network 
that is similar to a source image on a DVD. The administrative installation package can then be pushed by 
system administrators to client computers in a domain via Group Policies. This is only possible from Windows 
2000 Server onwards. 

To find out more about Windows® Installer and administrative installations, please refer to the Microsoft web 
site. 

Creating an administrative installation 
Administrators can create an administrative installation from the command line by using the /a command line 
option. 

 Choose Start - Run. 

 Type the following: 

msiexec.exe /a X:\install\setup.msi 

where X represents the DVD drive letter. 

(please check the location of the setup.msi on the DVD) 

 Specify the following in the dialog that appears: 

• Where you want to unpack the .msi file 
• The user name and company name to use as default 
• The serial number 

 (optional) Check 'Force activation when MindView is run' if you want MindView to be automatically 
activated the first time the program runs.  

 (optional) Check 'Automatically activate during installation' if you want to activate MindView during 
installation. 

 These two activation options are "silent" (i.e. they do not display any messages). 

 The above options are stored in a file called "admin.ini" in the destination folder. You can edit this file using a text 
editor like Notepad if you want to change the options without making a new administrative installation. 
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Applying a patch package to an administrative installation 
 Choose Start - Run. 

 Type: 

msiexec.exe /p <path to .msp file> /a <path to administrative .msi file>  

Members of the workgroup using MindView must then reinstall the application from the new administrative 
source image to receive the update. 

To completely reinstall the application and cache the updated .msi file on their computer, users may enter either 
of the following commands: 

• msiexec.exe /fvomus //server/<administrative .msi file> 

• msiexec.exe /I //server//<administrative .msi file> REINSTALL=ALL 
REINSTALLMODE=vomus 

Troubleshooting 
Changing the location of the activation file 
By default, the activation data is stored in: 

• C:\Documents and Settings\All Users\Application Data\mwas\MindView3.0BE.mwas 

(Windows 2000 and Windows XP), or 

• C:\ProgramData\mwas\MindView3.0BE.mwas 

(Windows Vista) 

In some rare situations, client computers may be setup with restricted access to the above folder, and this will 
cause the activation file not to be saved. If you have a client server system setup in this way, you can move the 
activation file to another location by adding an entry to the admin.ini file as follows: 

[Activation] 

mwas=c:\different folder with write access\MindView3.0BE.mwas 

Storing several activation files on the server 
You can store several activation files in the same folder of the server by adding an entry to the admin.ini file as 
follows: 

[Activation] 

mwas=\\server\activations\MindView3.0BE_%COMPUTERNAME%.mwas 

Where: 

server = the name of the server 

activations = the share name on the server 

%COMPUTERNAME% will be replaced with the client computer name 

Problem applying a patch 
Q. Nothing happens when I double-click the patch file (ex. patch.msp). 

A. The .msp file extension may be allocated to an application other than the Windows installer. 

In this case, you can apply the patch as follows: 

 Chose Start - Run. 
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 Type the following command: 

msiexec.exe /p c:\temp\patch.msp 

(assuming that you have copied the .msp file to c:\temp) 
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Support 

Getting help 
The MindView documentation is provided as online help in the program. It can also be found in PDF format in 
the MindView installation folder. 

Online Help 
You can access the online help system by pressing F1 or by clicking the small question mark  on the top right 
of the MindView window. 

To obtain help on a particular dialog, click the small question mark  on the top right of the dialog in 
question. 

The FAQ Knowledge Base 
For additional information, please refer to our FAQ Knowledge Base: 

http://faq.matchware.com/en/ 

As well as answering the most commonly asked technical questions concerning the MatchWare products, this 
database allows you to post comments and send questions to MatchWare. 

Service Packs 
If you encounter a problem that you are not able to solve by referring to the FAQ, check that you have installed 
the latest MindView service pack available. MatchWare releases service packs regularly to provide 
enhancements and correct errors reported by its users. 

You can find service packs for MatchWare products at: 

http://www.matchware.com/en/support/default.htm  

MatchWare Web Site 
The MatchWare web site contains extensive information on all the products offered, as well as tutorials, 
templates and reviews. Updates are posted regularly. To see what is currently available, please visit: 

http://www.matchware.com/en  

Reporting a problem 
To report a problem, bug or any other error in MindView, please send a message to MatchWare via our FAQ 
Knowledge Base: 

http://faq.matchware.com/en/ 

MatchWare is registered with the Windows® Quality Online Services. In the unfortunate event of an application 
failure, the Windows Error Reporting system will capture relevant product data and enable you to forward this 
data to MatchWare automatically. 
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Quick Start 

This Quick Start takes you through all the basic steps required to build a Mind Map from scratch and enhance it 
with design effects, icons, comments, pictures, attachments and so on. 

The map we are going to create here is about planning a weekly meeting. 

 

The complete Mind Map, "Weekly Meeting.mvdx", can be found in the MindView program folder, in 
"…\MatchWare\MindView 3.0\QuickStart". 

 

First step: Creating the Mind Map 
In this first step of our Quick Start example, we are going to create all the branches we require for our meeting 
agenda. 

We start by creating a new MindView document. 

 Start MindView and choose New Document in the Welcome dialog. 

 If you have closed the Welcome dialog, you can create a new document by pressing Ctrl + N. 

The New Document dialog opens. 
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In this Quick Start, we will use the Mind Map view, which is the default view in MindView. 

 On the New Map tab, select the Mind Map thumbnail and click Open. 

Your new map appears with the root block ready for you to fill in. 

 

Entering the subject 
 Type "Weekly Meeting" and press Enter. 

 

The default file name "Weekly Meeting" is now shown on the document tab. 

 

The asterisk to the right of the name indicates that the document contains data which has not yet been saved. 

Inserting the main branches 

 We are now going to insert a few branches, corresponding to various topics we would like to include in 
our agenda, namely: 

• A section for the opening remarks 

• A section on budget issues 
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• A section on the upcoming office relocations 

• A section for the closing remarks 

Let's start by inserting the first branch. 

 Press Enter. 

The first branch is now visible. Its default label is "Idea". 

 Type "Opening remarks" and press Enter. 

 Press Enter again to insert the second branch. 

 Type "Budget" and press Enter. 

 Insert two more branches by pressing Enter and label them "Relocations" and "Closing remarks". 

As you can see, branches are inserted in a clockwise direction around the root. 

 

Inserting the sub-branches 

 We now want to insert some sub-branches, corresponding to the sub-topics of our main topics. 

 To add the first sub-branch to the Opening remarks topic, click the corresponding branch to select it and 
press Insert. 

 Type "Welcome" and press Enter. 

 Press Enter again to add the second sub-branch. 

 Type "Objectives" and press Enter. 

 Type "Previous minutes" and press Enter. 

 Now select the "Budget" branch and press Insert to add its first sub-branch. 

 Continue in the same way until you have added all the other sub-branches shown below. 

 

 To correct typing errors, click the branch label and press F2. Then place the cursor at the required position, press 
Delete or Backspace to remove the incorrect characters, type the correct ones and press Enter. 
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Saving the document 
Let us save the work we have done so far before going on to the second step. 

 Click the Save Document icon  in the Quick Access Toolbar or press Ctrl + S. 

 In the Save As dialog that opens, choose a folder, enter a file name for your new Mind Map and click Save. 

The default file name, derived from the subject of the map, is "Weekly Meeting.mvdx". 

Second step: Enhancing the Mind Map 
In this second step of our Quick Start example, we are going to enhance our meeting agenda by adding a variety 
of visual elements and multimedia objects to it. 

Choosing a style 
MindView contains galleries of predefined layouts and styles, which allow you to apply branch shapes, branch 
colors and other coordinated attributes in one step. 

 Click the Design tab in the main menu. 

This tab contains all the design options applicable to the current view, in this case the Mind Map view. 

 Browse through the Layouts gallery to choose your preferred layout. 

As you browse through the options, MindView shows you an immediate preview of their effect on the map. To 
apply a particular option, just click it. As we are designing a standard Mind Map, we are going to keep the 
default layout. 

 Browse through the Styles gallery to choose your preferred style. 

 (optional) To further customize the visual aspect of your map, explore the options available in the Effects 
and Properties panels. 

All the design options you choose here apply to the entire map. You can come back to this Design tab at any 
stage to change or add design options to your map. You might even prefer to leave the design phase to the end, 
once you have put in place all the contents of your map. 

As well as specifying global design options, MindView lets you apply different design effects to individual 
branches of the map, as we will see at the end of this Quick Start. 

Inserting pictures 

 It is considered good Mind Mapping practice to insert a picture in the root block to illustrate the theme of 
the map, so we are going to do just that: 

 Click the View tab in the main menu. 

 Click Show/Hide | Multimedia Catalog. 

The Multimedia Catalog opens. 

 Click the 'Search for' field of the Multimedia Catalog and type "meeting". 

Various pictures appear in the Multimedia Catalog display area. 
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 Drag the picture of the meeting over the root block and let go of the mouse button. 

The root block now contains a picture of a meeting. 

This type of picture, which "sits" on the branch to which it belongs, is called a "branch picture". 

 

We also have a picture of a removal truck which we are going to insert as a "floating picture" to illustrate the 
Relocations branch. 

 Click the Relocations branch to select it. 

 Click the Insert tab in the main menu. 

 Choose Pictures | Floating Picture. 

 Browse to "…\MatchWare\MindView 3.0\QuickStart" in the Program Files folder, select the file 
"Truck.png" and click Open. 

A picture of a truck now appears on the map. You can move this picture wherever convenient by dragging it with 
the mouse. Note that a thin line connects it to the branch to which it belongs. 

 

Inserting icons 

 Inserting icons on the map is a useful way of attracting attention or illustrating a particular idea. 
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 Select the Budget branch. 

 Click the Insert tab in the main menu. 

 Click the small arrow under the Icons icon at the far right. 

 Click the dollar sign icon in the Standard icon palette. 

 

The icon now appears next to the branch label name. 

 

 Select the Relocations branch and add the red flag icon to it to indicate that the deadline for the office move 
is approaching. 

 

Inserting a text note 

 The MindView Text Note editor lets you add comprehensive text notes to any branch of your map. 

We want to add a note to the Closing remarks branch to explain why we might want to broaden the list of 
attendees for the next meeting. 

 If it is not already visible, open the Text Note editor by choosing View | Show/Hide | Text Note Editor. 

 Select the Closing remarks branch and type the following text (or any other) in the Text Note editor. 

 

As soon as you click the Text Note editor window, an Edit tab appears at the right of the ribbon to help you 
format your note. 

 Format the text to your liking and click outside the Text Note editor. 

A paperclip icon  now appears to the right of the Closing remarks branch label, indicating that this branch 
contains an object. 

 

Inserting comments 

 We would also like to insert a couple of shorter comments and reminders in our map. 

We start by adding a "floating comment" to the Relocations branch to indicate that the planning deadline is 
approaching. Floating comments stay visible on the screen at all times. 
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 Click the Relocations branch to select it. 

 Choose Insert | Text | Floating Comment in the main menu. 

A floating comment box opens with the default text "Insert Floating Comment". 

 Enter the text of the floating comment as shown below and press Enter. 

 (optional) Move the floating comment by dragging it wherever convenient. 

 

We are now going to insert a "pop-up" comment in our Opening remarks branch as a reminder to welcome new 
staff. Pop-up comments are normally hidden. 

 Select the Opening remarks branch. This time, rather than using the main menu, press F11 (MindView's 
more commonly used commands have function key equivalents). 

A yellow comment box opens. 

 Enter the text of the comment as shown below and click outside the yellow box. 

 

The comment box disappears, but a yellow comment icon  now appears next to the branch label, indicating 
that this branch contains a pop-up comment. You can view the comment at any time by moving the mouse 
pointer over the icon, and edit it by clicking the icon. 

 

Attaching a file 

 Since we have developed a spreadsheet to help us plan next year's budget, we are going to include it as a 
file attachment on our map. 

 Click the Budget branch to select it. 

 Choose Insert | Links | Attachment in the main menu. 

 Browse to "…\MatchWare\MindView 3.0\QuickStart", select "Budget.xls" and click OK. 

A paperclip icon  now appears to the right of the Budget branch label, indicating that this branch contains 
attached objects. 

 To view the attachment, move the pointer over the paperclip icon. 

The object pop-up list appears. 
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Assuming Microsoft® Excel is installed on your computer, all you have to do to view the spreadsheet is to click 
the attachment in this list. 

The attachment is also listed in the Object list for the branch. 

 To view the Object list, choose View | Show/Hide | Object List in the main menu. 

 

Creating a branch connection 

 Since we want to consider this year's underspent areas when planning next year's budget, we want to 
create a visual link between the two topics on the map. 

 Choose Insert | Links | Branch Connection in the main menu. 

The mouse pointer changes shape. 

 Move the mouse pointer to the Underspent areas branch, click it, drag the pointer to the Next year branch 
until it gets highlighted and let go of the mouse button. 

A line now joins the Underspent areas branch to the Next year branch, indicating that the two branches are 
related. 

 

The paperclip icon appears to the right of the Underspent areas branch, denoting the presence of the branch 
connection. 

If you select the Underspent areas branch again, you will notice that the branch connection is also listed in its 
Object list. By default, it bears the name of the branch where the connection ends. 

 

Formatting the branches 

 To finish off our map, we are going to add boundaries around the main branches. 

At the start of this topic, we have seen how to choose global design options for the view using the Design tab. 

If required, you can also apply specific design options to individual branches using the Format tab. 

 Click the Opening remarks branch to select it. 
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 Click the Format tab that appears at the right of the ribbon. 

This tab contains all the commands that are specific to the selected object, in this case the Opening remarks 
branch. 

 Click the Boundary icon in the Boundary group. 

 (optional) To choose a fill color for the boundary, click the small arrow under the Fill Color icon. This also 
lets you apply a color gradient, choose the direction of the gradient and change the start and end color of the 
gradient. 

 (optional) To choose an outline style for the boundary, click the small arrow under the Outline icon. This 
lets you choose a different color for the outline, a different width or a different line type. 

    

You can of course also use the Format tab to customize your branches further, by changing their shape, the color 
of their background and/or outline, the color and width of the line joining the branch to its parent branch and so 
on. 

 If after experimenting with all these options, you want to restore your branches to the default style you chose for the 
view at the start of this topic, just press Reset Style. 

Our simple Quick Start example is now complete. In a very short time you have created and enhanced your first 
MindView Mind Map. You have also learnt the most common operations in MindView. Please refer to the User 
Guide for more information about any of the features described here. 
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User Guide 

Setting up 

Setting up your workspace 
The MindView window is made up of several components: 

 

• The MindView Button is displayed in the upper left corner of the MindView window. It opens the 
MindView Menu, which contains commands affecting the entire document, such as New, Open, Save, Print 
or Export. 

• The Quick Access Toolbar is a component of the Microsoft Office 2007 interface. It is a customizable 
toolbar that is available at all times, regardless of the menu tab currently open on the ribbon. By default, it is 
located in the upper left corner of the MindView window, next to the MindView Button. 

• The Ribbon is also a component of the Microsoft Office 2007 interface. Its tabs, corresponding to the main 
activities in MindView, contain all the necessary commands, options and icons, organized in groups. It is 
designed to help you quickly find the commands that you need to complete a task. 

The Design tab that appears at the right of the ribbon is a special tab. It contains all the design options 
applicable to the current view. 

When a particular branch or map element is selected, a Format tab may appear after the Design tab. It 
contains all the commands that are specific to the selected object. 

• Three Panels are displayed by default on the right of the MindView window. 

• The Workspace is the area you use to design your document. 

Customizing the Quick Access Toolbar 
The Quick Access Toolbar contains the most frequently used commands. By default, it is located in the upper 
left corner of the MindView window, next to the MindView Button. 
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To move the Quick Access Toolbar closer to the workspace area: 

 Click the Customize Quick Access Toolbar arrow  on the right of the toolbar. 

 Choose Show Below the Ribbon. 

You can also add the commands you use most frequently to the Quick Access Toolbar, or remove commands 
you use less often. See "Setting up your preferences" for more information. 

Minimizing the ribbon 
MindView lets you minimize the ribbon to increase the workspace available: 

 Click the Customize Quick Access Toolbar arrow  on the right of the toolbar. 

 Choose Minimize the Ribbon. 

 To use the ribbon while it is minimized, click the tab you want to use, and then click the command you want 
to use. 

As soon as you have made your choice, the ribbon returns to its minimized form. 

 To restore the ribbon, click the Customize Quick Access Toolbar arrow again and uncheck Minimize the 
Ribbon. 

You can also minimize the ribbon as follows: 

 Double-click the current tab. 

 To restore the ribbon, just double-click any of its tabs. 

 You can also press Ctrl + F1 to minimize or restore the ribbon. 

The layout of the commands, options and icons in the ribbon changes when the width of the MindView 
application window is reduced. Controls normally represented by large icons may for instance now be 
represented by small icons. If the width of the application window is greatly reduced, a group may be 
represented only by its icon. 

 

 To view the contents of such a collapsed group, just click its icon. 

Using access keys and shortcut keys 
To select a command from the ribbon, all you need to do is click the relevant tab to open it, then choose the 
command. 

You can also use access keys for this purpose. Access keys are different from shortcut keys. 
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• Access keys are used to navigate through the interface and select its different commands using the 
keyboard. Each command shown in the MindView Button menu, the Quick Access Toolbar and the Ribbon 
has an access key. 

• Shortcut keys are key combinations such as F1 or Ctrl + O used to perform frequently used commands. 
Shortcut keys are not related to the organization of the commands in the interface. You will find a list of all 
the shortcut keys used in MindView in "Keyboard shortcuts". 

 To select a command using an access key, start by pressing the Alt or F10 key. You will now see the first 
layer of access keys you can use at that point displayed as small labels underneath each tab or command. 

 

 Press the access key for the tab or command you require to see the second layer of access keys. 

For instance, pressing H above will open the Home tab and display its access keys, as shown below. 

 

 Press the key or keys corresponding to the command you want to select. 

For instance, pressing B above will insert a branch in your map. 

Using the MindView panels 
• Three Panels are displayed by default on the right of the MindView window. 

• The Task/Timeline Info panel 

This panel lets you enter dates, times and other information on the branches of your Mind Map to create 
timelines, task lists or project plans. 

For more information on this panel, see "Inserting timeline data" and "Inserting task data". 

• The Multimedia Catalog 

This catalog contains an extensive collection of high quality clipart pictures which you can add to your map 
to illustrate the topics. 

See "Inserting pictures" and "Using the Multimedia Catalog" for more information. 

• The Calculation panel 

This panel lets you enter and modify values on the branches of your Mind Map, for instance sales numbers, 
costs, exchange rates and so on, as well as formulas to carry out calculations on the values. 

See "Inserting calculation values" for more information. 

MindView includes other panels which you can show or hide using the View | Show/Hide command: 
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• The Text Note editor 

The Text Note editor, which is placed by default at the bottom of the workspace, lets you associate 
comprehensive notes to the root or any branch of your map. 

See "Inserting text notes" for more information. 

• The Timeline Outline 

This panel is only used in the Timeline view. It shows all the branches of your map as a hierarchical list 
which you can expand and collapse as required. 

• The Properties dialog 

This dialog shows the properties of the MindView element currently selected, for example the root, a branch 
or a floating comment. If nothing is selected the properties of the current view are shown. 

See "Using the Properties dialog" for more information. 

• The Overview panel 

The Overview panel allows you to bring the different parts of your map into view. 

See "Using the Overview panel" for more information. 

• The Object list 

This lists all the objects placed on the currently selected branch of your map. 

See "Using the Object list" for more information. 

Resizing panels 
 To resize a panel, move the pointer on one of its edges until it changes to a double arrow and drag with the 

mouse in the required direction. 

Undocking panels 
The Task/Timeline Info panel, the Multimedia Catalog and the Calculation panel are always anchored on the 
right of the workspace. 

All the other panels open by default on the left of the workspace, except for the Text Note editor, which opens at 
the bottom. 

You can however move any of these panels freely on the workspace or dock them to a different position: 

 To undock a panel, just drag its title bar away from its current position until it is completely free, then let go 
of the mouse button. 

 You can also double-click the title bar of the panel to undock it and double-click it again to redock it. If you want to 
undock a panel and move it freely on the workspace without it "snapping" to a docked position, press the Ctrl key and hold it 
down while dragging the title bar of the panel. 

Docking panels 
You can dock an undocked panel to the left, top or bottom edge of the workspace as follows: 

 Drag the title bar of the panel and move it in the direction required until you see the arrow shapes left , 

up  and down  appear on the edges of the workspace. 

 Drag the panel on top of the required arrow until you see a darker shade of blue outline the new position. 
Release the mouse button if you are happy with this new position, else continue dragging to the required 
position. 

You can also dock a panel above, below or on the side of another panel. To do this: 
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 Drag the title bar of the panel and move it in the direction of the target panel until you see a three-arrow 
shape appear. 

 

You now have different possibilities: 

• ide of the underlying 
panel. 

Here for instance, the Object list is being docked to the left of the Properties dialog. 

Moving the panel over the left, up or down arrow will dock it on the corresponding s

 

• l, converting it to a 
multi-tab panel. 

Here, the Object list is being integrated with the Properties dialog as a tabbed panel. 

Moving the panel to the middle square will integrate it as a tab of the underlying pane

 

To free such a ta bbed panel, drag it by clicking its tab, not its title bar. 

To separate the Object list from the Properties dialog in the example below, you would therefore click the 
Object List tab. 
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Resetting panels to their default position 
If necessary, you can reset all the panels to the default position they had when you first installed MindView: 

 Click the MindView Button. 

 Click MindView Options in the bottom right corner of the dialog. 

 Click Preferences on the left. 

 Click Reset Interface. 

When using this command, note that other components, such as the Quick Access Toolbar or the list of recently 
opened files, are also restored to their defaults. 

Setting up your preferences 

 The MindView Options dialog lets you customize your environment and gives you access to external web 
resources. 

 Click the MindView Button. 

 Click MindView Options in the bottom right. 

The MindView Options dialog that opens contains several panels, corresponding to different options. 

Proofing options 
This dialog contains various options which you can set to determine the type of errors reported by the 
spellchecker. 

It is described in detail in the topic "Spellchecking options". 

Saving options 
Create backup of document files: Creates a backup of the MindView file and saves it as a *.bak file. The *.bak 
file is a copy of the last saved version of your document. See "Saving a Mind Map" for more information on this 
feature. 

Save auto-recovery info: MindView automatically saves a copy of your open documents at regular intervals in 
a temporary backup file. If a problem occurs that prevents MindView from closing properly, you can choose to 
auto-recover your file from this backup file when next starting MindView. This field allows you to set the 
interval between automatic saves. 
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Advanced options 
Display options 
Draw map antialiased: Antialiasing improves the appearance of your map by smoothing its edges. This option 
is checked by default. However, antialiasing makes a heavy use of the computer resources. If your computer is 
not very powerful, you might prefer to disable this option to speed up the display of the map. 

Draw text antialiased: This option is unchecked by default. However, text looks smoother when it is 
antialiased. Enable this option if your computer resources allow it. 

Show Welcome dialog on startup: If you disable this option, MindView displays an empty workspace when 
starting rather than the Welcome dialog. See "Creating a Mind Map" for more information. 

Reset Multimedia Catalog: Clicking this button restores the original contents of the Multimedia Catalog. Your 
User Area is left unchanged, but all the elements you might have added to any other category are removed. See 
"Using the Multimedia Catalog" for more information. 

Reset Interface: Clicking this button resets all the panels to their default positions. When using this command, 
note that other components, such as the Quick Access Toolbar or the list of recently opened files, are also 
restored to their defaults. See "Using the MindView panels" for more information on resizing and docking 
panels. 

Animation options 
These options allow you to disable the animation effects used by MindView if your computer is not powerful 
enough to produce a good result. If the animation effects appear slow and jerky rather than fast and smooth, you 
can disable the following options: 

• Comments: This relates to the way the comment window opens when you insert or edit a yellow pop-up 
comment . 

• Object list pop-up: This relates to the way the Object list pop-up opens when you move the mouse pointer 
over the paperclip icon  shown next to the label of any branch containing attached objects.  

• Zoom: This relates to the way the map is displayed by increments when zooming in and out. 

Undo options 
Enable Undo: Check this box if you want to be able to undo any operation you have performed on your map. 
This gives you the freedom to experiment, as you can easily undo the last change made by choosing Undo  in 
the Quick Access Toolbar (or Ctrl + Z), and reapply the change if necessary with Redo  or (Ctrl + Y). 

Note that you can also click the arrow to the right of the Undo icon to select a number of changes to undo. 
Similarly, the Redo icon allows you to restore the last change or changes undone. 

Undo levels: This field lets you specify the maximum number of changes that you want to be able to undo. If for 
instance you set the number of Undo levels to 5, you will be able to reverse up to 5 changes by selecting the 
changes in the Undo list  or pressing Ctrl + Z several times. Note that increasing the number of undo levels 
increases the amount of memory used. 

Updates 
Check for program update every: This option allows MindView to check automatically for program updates 
on the MatchWare web site at the start of the program. You can set the frequency of the checks in the time field, 
or disable the feature by removing the check mark. 

Text Note editor 
These options let you specify a default font, text size and text color for all the text notes you enter using the Text 
Note editor. You can of course change these settings for individual text notes when working in the editor. For 
more information about the Text Note editor, see "Inserting text notes". 
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Calendar options 
This tab is only relevant if you intend to create project plans for use in the Gantt view. It lets you modify the 
default calendar settings which provide the basic information about working and non-working time used by 
MindView to schedule the tasks of a project plan. 

For details about how to use this dialog, see "Defining calendar settings" in the "Gantt view" chapter. For general 
information about the Gantt view, see "Using the Gantt view". 

Customize options 
This panel lets you add the commands you use most frequently to the Quick Access Toolbar, or remove 
commands you use less often. 

 In the field Choose commands from, choose the ribbon tab containing the required command. 

 Choose the required command in the Commands field and click Add. 

You can also add entire groups to the Quick Access Toolbar. Groups are denoted by a drop-down symbol 
. 

 A quicker way to add a command to the Quick Access Toolbar is to click the ribbon tab containing the command you 
want to add, right-click the command and choose Add to Quick Access Toolbar. 

Clicking Reset will restore the original contents of the Quick Access Toolbar. 

 You can also access this panel by clicking the Customize Quick Access Toolbar arrow  on the right of 
the toolbar. 

Resources 
This dialog lets you access the MatchWare web site and obtain the latest product updates. 

Pen input options 
This dialog is only displayed if your operating system supports pen input. It lets you choose different input 
options when working in Pen Mode. For more information, see "Working in Pen Mode". 
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Basic tasks 

Creating a Mind Map 

 When you start MindView, the first screen you see is the Welcome dialog. 

 

Here you can select to: 

• Create a new document  

• Open an existing document 

• Open a recently used document 

 You can check 'Do not show this dialog again' to bypass this dialog next time you start MindView. If you 
want to show the Welcome dialog again at a later stage, click 'Show Welcome dialog on startup' in the 
MindView Options dialog. See "Setting up your preferences" for more information. 

 Choose New Document to create a new Mind Map document. 

 Although the topics in the "Basic tasks" and "Further tasks" sections of this documentation assume that you 
are using one of the standard Map views, namely Mind Map, Top Down or Left/Right, most of the procedures 
they describe apply equally to all views. Procedures that are specific to particular views are described in the 
topics dealing with these views in the Views section of this documentation. 

Creating a new document 
The New Map tab of the New Document dialog allows you to create an empty document based on one of the six 
views provided, namely Mind Map, Top Down, Left/Right, Timeline, Outline and Gantt. 

See "Using different views" for more information about each view. 
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 If you have closed the Welcome dialog, you can also display this dialog by pressing Ctrl + N. 

Once you have created your document, you can display it at any time in another view by choosing that view in 
the Home | View or View | View panels in the main menu or by right-clicking the workspace and choosing View 
Map As in the local menu. 

Going from one view to another only affects the way the document is displayed. The contents of the document 
are not modified, unless you edit them yourself while working in the new view. 

The only exception to this rule is the Gantt view. Going to the Gantt view automatically enables project 
management features. This may have consequences for your data. See "Using the Gantt view" for more 
information. 

 Click one of the thumbnails. 

 Click Open. 

The map appears with the root block ready for you to fill in. 

 

See "Entering a branch label" to find out how to do this. 

Using an existing template 

 The Templates tab of the New Document dialog allows you to create a document based on one of the 
many educational, business and personal templates included in MindView. The curriculum-aligned educational 
templates cover a range of learning levels and are supported by over a thousand high quality clipart images 
created specifically to match all areas of the curriculum. 

 You can also display this dialog by clicking the MindView Button and choosing New From Template. 
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MindView also includes various ready-made project plans for common business activities (organizing a 
tradeshow, producing a publication, launching a product and so on) for use in the Gantt view. You can use these 
for training purposes, or as a basis for your own project plans. 

Once you have created your Mind Map from one of these templates, you can easily tailor it to meet your 
particular needs. Ideas and suggestions for expansion are given in text notes and pop-up comments. 

If you have already created and saved your own templates, you can base your new Mind Map on one of them by 
selecting it in the My Templates category. See "Saving a Mind Map" for more information on how to save 
templates. 

You can see a preview of each template by moving the pointer over its name on the right part of the dialog. 

 

Saving a Mind Map 

 MindView documents are saved as .mvdx files. 

To save a document: 

 Click the MindView Button. 

You can now choose either: 

• Save to save your document under its existing name and continue working in MindView. 

• Save As to save your document under a different name. This is also a way of creating a copy of your 
document. 

 To save your document, you can also click the Save icon  in the Quick Access Toolbar or press Ctrl + S. 

By default, the previous version of your document is automatically saved as a .bak file. To disable automatic 
backups, uncheck 'Create backup of document files' in the MindView Options dialog. 

Recovering a backup file (*.bak) 
If you save a document after having made some changes which you wish you had not made, you can restore the 
previous version of the document as follows: 
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 Click the MindView Button and choose Open. 

 Browse to the folder containing your MindView document and enter the file name *.* in the Open dialog to 
view the list of all the files contained in that folder. 

 Select the filename.bak file, where filename is the name of your MindView document and click Open. 

 Click the MindView Button and choose Save As to save the .bak file under its original .mvdx name to 
overwrite the incorrect version of the document. 

Auto-recovery 
By default, a temporary copy of your document is also saved automatically at regular intervals to allow auto-
recovery in the event of a program failure. To disable automatic saving of auto-recovery information, uncheck 
'Save auto-recovery info' in the MindView Options dialog. 

 This feature is only available if your document has been saved at least once. 

Saving your document as a template 

 You can also save your document as a custom template for future use. This allows you to create new 
documents based on your existing ones. To do this: 

 Click the MindView Button. 

 Choose Save As Template. 

The Save as Template dialog appears. Its left part contains a list of the templates you've already saved. Clicking 
one of these templates gives you a preview of it on the right part of the dialog. 

 

To create a new template: 
 Enter the name of your new template and click Save. 

To overwrite an existing template: 
 Select an existing template and click Save to overwrite it with your new template. 
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To delete an existing template: 
 Select an existing template and click Delete. 

 Custom templates are saved with the extension .mvtx in your Document and Settings folder. 

Opening a Mind Map 

 When you start MindView, the first screen you see is the Welcome dialog. This dialog lets you browse for 
an existing document or select a recently used document. 

If you have closed the Welcome dialog, you can open an existing document as follows: 

 Click the MindView Button. 

 Choose Open. 

 You can also press Ctrl + O. 

Note that you can open several Mind Maps in MindView at the same time. Each one is displayed in a separate 
tab in the MindView workspace and is treated as a separate document. 

 

An asterisk on the right of the document name indicates that you have made changes to the document which you 
have not yet saved. 

 You can easily go from one document to the other by clicking the relevant tab or pressing Ctrl + Tab. 

Notes: 

• If you are trying to open a password-protected document created with MindView Business Edition, you will 
need to enter the password before proceeding. 

• If you open a document created with MindView Business Edition in the standard version of MindView, any 
data relating to MindView Business Edition features which are not supported in the standard version (such 
as task data or calculation values) will not be visible. If you then save the file in the standard version of 
MindView, this data will be lost. If the file has been password-protected in MindView Business Edition, this 
password will also be removed when saving the file in the standard version. 

• MindView also lets you open MindManager® files (with extension .mmap) from versions X5 and 6 
upwards. 

Opening documents created with previous versions of MindView 
MindView 3 lets you open documents created with previous versions of MindView. However once you make 
changes to the document and save it with MindView 3, the document is no longer compatible with the previous 
version. 

 The auto-recovery feature (see "Saving a Mind Map") will only become active once you have saved the 
document in the new format. 

Entering a branch label 
By default, the root of a newly created Mind Map contains the label "Subject" and new branches appear with the 
label "Idea". 

Replacing the default label 
 Just click the root or branch to select it and start typing. 
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 When you have finished, press Enter or click outside the root or branch. 

 

Unless your label is quite short, a resizing handle appears when you hover the right side of the frame 
surrounding the label. You can use this handle to resize the branch label by dragging it in the direction required. 

 By default, the text wraps around automatically when you type long labels. If you want to force the next par
of your label to start on a new line, press Ctrl + Enter at the end of the line. You can disable the automatic tex
wrapping by unchec

t 
t 

king the relevant property in the View properties. See "View properties: General tab" for 
more information. 

 Your map will be clearer if you keep your root and branch labels short. If you need to enter longer notes, use the Text 
Note editor. You can also enter comments to serve as reminders while you build up your map. See "Inserting text notes" and 

re information. 

e new label. 

 ways of entering Edit mode: 

time, or 

 choose Edit Text in its local menu. 

 

"Inserting comments" for mo

Editing a label 
 To replace the existing label, just click the branch to select it and start typing th

You can also edit the existing label. There are several

• Click the label once to select it and press F2, or 

• Click the label once to select it and click it again after a short 

• Right-click the label and

Once you are in Edit mode: 

 Place the cursor at the required position and start typing. 

When you have finished, press Enter or click outside the label. 

 Pressing Esc while in Edit mode will leave the existing label unchanged. 

Inserting branches 
MindView lets you insert main branches, sub-branches and pre-branches in your Mind Map: 

• A main branch  is a branch directly connected to the root. 

Main branches represent the main topics related to the subject of your map. 

• A sub-branch  is a branch belonging either to a main branch or to a sub-branch of higher level. 

Sub-branches represent the various levels of sub-topics in your map. 

• A pre-branch  is a branch you insert before a sub-branch. 

MindView automatically arranges the main branches, sub-branches and pre-branches as you insert them to 
prevent any overlap. 

 You can however choose to reposition the main branches yourself after their insertion by disabling Auto-layout mode. 
See "Moving a branch" for more information. 

 48



As soon as you add a branch, sub-branch
The procedure for replacing the default la

 or pre-branch, the new branch appears with the default label "Idea". 
bel is the same as for the root. See "Entering a branch label" for more 

information. 

Inserting a main branch 

 To insert a main branch: 

ter or Insert. 

• Click the root and choose Insert | Branches | Branch or Insert | Branches | Sub-Branch, or 

• Right-click the root and choose Insert | Branch or Insert | Sub-Branch in its local menu. 

 Click the root and press En

You can also: 

• Double-click the root, or 

• Click the root and choose Home | Insert | Branch or Home | Insert | Sub-Branch, or 

 

Inserting branches at the same level 

 To add a branch at the same level as an existing branch: 

• Click the branch and choose Insert | Branches | Branch, or 

• Right-click the branch and choose Insert | Branch in its local menu. 

 Click the existing branch and press Enter. 

You can also: 

• Click the branch and choose Home | Insert | Branch, or 

 

Inserting a sub-branch 

 To add a sub-branch to an existing branch: 

 Click the existing branch and press Insert. 

 Double-click the branch, or 

 Click the branch and choose Home | Insert | Sub-Branch, or 

You can also: 

•

•
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• Click the branch and choose Insert | Branches | Sub-Branch, or 

• Right-click the branch and choose Insert | Sub-Branch in its local menu. 

 

Inserting a pre-branch 

 To insert a branch between an existing branch and its parent branch, you can: 

• Click the branch and choose Insert | Branches | Pre-Branch, or 

• Right-click the branch and choose Insert | Pre-Branch in its local menu. 

• Click the branch and press Shift + Enter, or 

 

Formatting a branch 
As soon as you insert a branch in the map, a Format tab appears at the right of the ribbon. 

 fill 

asier to use the Design tab, 
ing a Mind Map" for more 

You can easily create a branch structure with main branches and sub-branches by copying several lines of text 

ur MindView document. Any line indented with spaces or tabs in the 
her level line. 

ther application by copying it from MindView and 

 to a main branch or to another sub-branch, a small minus sign 

This tab lets you perform different operations on the branch, such as changing its shape, choosing a different
color, defining a branch boundary, or selecting different text attributes. See "Formatting a branch" for more 
information. 

To apply the same formatting attributes to all the branches, it is however much e
whose predefined styles and design options apply to the entire map. See "Design
information. 

Copying branches from an external application 

from an external document, such as a Microsoft Word document, a Notepad text file or a Microsoft Excel 
spreadsheet, and pasting them into yo
external application will be inserted as a sub-branch of the hig

Similarly, you can copy a MindView branch structure to ano
pasting it in the external application. 

Expanding and collapsing a branch 
As soon as you add a sub-branch  appears 
between it and the higher-level branch. Th he newly inserted sub-branch and any further 

 to do this: 
is allows you to hide t

sub-branches and concentrate on the higher-level branches. There are several ways

• Click the minus sign , or 

 or • Right-click the higher-level branch and choose Collapse in its local menu, 
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• Press Ctrl + Shift + "-". 

The sub-branch is n hidden, and the minus sign  changes to a plus sign . ow 

 

To redisplay the sub-branch with all its sub-branches, do one of the following: 

• Click the plus sign , or 

• Right-click the higher-level branch and choose Expand in its local menu, or 

• Press Ctrl + Shift + "+". 

 

Navigating between branches 
T ect a b

T win  to the other: 

to the left of the currently selected branch.  

of the currently selected branch. 

o sel ranch, all you need to do is click its label. 

he follo g keyboard shortcuts allow you to navigate easily from one branch

Up Select the branch placed above the currently selected branch. 

Down Select the branch placed below the currently selected branch. 

Left Select the branch 

Right Select the branch to the right 

Deleting a branch 
There are several ways of doing this: 

• Click the branch you want to delete and press Delete, or 

• Click the branch and choose Home | Editing | Delete  in the main menu, or 

• Right-click the branch and choose Delete | Entire Branch in its local menu. 

If a br Delet
h

anch contains sub-branches, you can delete it without deleting its sub-branches by choosing e | 
Branch Section in its local menu. This causes the sub-branches to move up one level in the hierarc y to become 
sub-branches of the parent branch. 

 Remember that if you delete a branch by accident, you can always cancel the deletion by clicking Undo  in the Quick 
Access Toolbar or pressing Ctrl + Z. 

Designing a Mind Map 
You can customize the look of your map at any time by applying design options to it. 

 Mos efore easier to judge the overall effect 
once

 Click the Design tab at the right of the ribbon. 

This tab contains all the design options applicable to the current view. 

t design options give you a live preview of their effect on the map. It is ther
 you have entered a few branches and sub-branches in the map. 
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 Browse through the Layouts gallery to choose your preferred layout. 

For more information about these views, see "Using different views". 

 The layouts available depend on the view you are using. If you are using one of the three Map views for 
instance, you can choose between the traditional Mind Map layout, the Left or Right layout or the Top 
Down layout. 

 Browse through the Styles gallery to choose your preferred style. 

 (optional) To further customize the visual aspect of your map, explore the options available in the Effects 
and Properties panels. 

 All the design options you choose here apply to the entire map. You can however apply different design 
options to selected branches. To find out how to do this, refer to "Formatting a branch". 

View properties 
In addition to the design options available on the Design tab, the view also has properties that you can edit in the 
Properties dialog. The Properties dialog always lists all the properties applicable to the element currently 
selected in the workspace. 

 Click the workspace so that no other element is selected. 

 Choose View | Show/Hide | Properties to open the Properties dialog. 

  

See "Using the Properties dialog" for a general description of the Properties dialog. 

See "View properties: General tab" in the Reference section for a detailed description of the general properties 
applicable the view and "View properties: Branches tab" for a description of the default properties applicable to 
branches. 

Viewing a Mind Map 
As your map grows, parts of it may fall outside the display area and no longer be visible. 

You can use the scroll bars or your mouse scroll button to bring them back into view: 

 To scroll your map vertically, use the vertical scroll bar or the scroll button of your mouse. 

 To scroll your map horizontally, use the horizontal scroll bar or press Ctrl while using the scroll button of 
your mouse. 

You can also pan the view to reach different areas as follows: 

 Press the Shift key and drag the area of the view that you want to reposition within the workspace. 

When you pan the view in this way, you will notice that the shape of the mouse pointer changes from an arrow to 
a hand. 
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You can also easily move the map within the workspace by dragging its root to the position of your choice. 

There are other viewing options available to you: 

• You can use the Zoom slider  or the Zoom icons of the View tab to change the 
level of magnification of your map. See "Zooming in and out" for more information. 

• You can view the map in full screen mode by choosing View | Zoom | Full Screen  or pressing F9. To 
return to normal viewing mode, choose Close Full Screen in the floating Full Screen toolbar, press Esc or 
press F9 again. 

• If you want to present your map to others, you can focus on one branch at a time while you discuss the 
issues related to that branch by choosing View | Detail | Focus Mode  or pressing F3. As soon as you 
click the branch you want to concentrate on, the map becomes centered on that branch. If necessary, the 
zoom factor is also increased automatically for maximum legibility. 

To recenter the map on its root so that you can select other branches that may no longer be visible, just click 
anywhere on the workspace. 

To return to the normal mode of working at the end of your presentation, click the Focus Mode icon again to 
deselect it or press F3. 

• The Detail Level icons  of the View tab let you collapse the entire Mind Map to just one level of 
branches, two levels, three levels or four levels. To show all levels, click the All Levels icon . 

 You can also press Ctrl + 1 to display just one level of branches, Ctrl + 2 to show two levels etc. Ctrl + 5 shows 
all levels. 

• The Apply Branch Focus icon  of the View tab allows you to restrict the display to a particular branch 
or set of branches. See "Focusing on a branch" for more information. 

• The Numbering Scheme icon  of the Home tab lets you apply sequential numbers to the branches of the 
Mind Map (starting from the top right in a clockwise direction) and choose between various numbering 
styles. 

• The Filter icon  of the View tab lets you define criteria, and then locate the branches of your document 
that meet these criteria by hiding all the other branches. Using filters, you can for instance display only 
branches containing a specific label or timeline events starting at a specific date. 

See "Filtering a Mind Map" for more information. 

• The Overview panel allows you to concentrate on particular areas of your map. See "Using the Overview 
panel" for more information. 

Zooming in and out 

 This topic describes the zoom features provided by MindView to let you change the level of magnification 
of your Mind Map. 

Other MindView options let you focus on particular areas by hiding all the other branches, apply a filter based 
on the conditions you define, or choose the number of levels of branches to display. For a description of these 
options, see "Viewing a Mind Map". 

The easiest way to change the level of magnification of your map is to use the Zoom slider shown in the bottom 
right of the workspace. 
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Zooming in 
There are several ways of zooming in on an area of your map: 

• Click the Zoom In icon  of the Zoom slider shown in the bottom right of the workspace, or 

• Press Ctrl + "+", or 

• Press Alt while scrolling your mouse wheel. 

 The maximum zoom factor is 400%. 

Zooming out 
Conversely, you can zoom out in several ways: 

• Click the Zoom Out icon  of the Zoom slider shown in the bottom right of the workspace, or 

• Press Ctrl + "-", or 

• Press Alt while scrolling your mouse wheel. 

 The minimum zoom factor is 5%. 

Viewing the map at 100% 
To view the map in its default zoom factor of 100%: 

 Choose View | Zoom | 100%  in the main menu. 

Fitting the map to the workspace 
To make the best possible use of the space available, you can resize the map so that it completely fills the 
workspace: 

 Choose View | Zoom | Fit All , or press F4. 

Selecting a zoom factor 
You can also choose a predefined zoom factor or enter your own zoom factor as follows: 

 Choose View | Zoom | Zoom  in the main menu. 

The Zoom dialog opens. 
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 Choose one of the predefined zoom factors or enter your own value. 

the workspace. 

• Fit all resizes the map so that it completely fills the workspace. 
• Fit selection resizes the map so that the selected branch together with its sub-branches completely fills 

 You can also open the Zoom dialog by clicking the left part of the Zoom slider . 

Viewing the map in full screen mode 
To give your map as much screen space as possible, you can temporarily hide all the menus and panels by 
viewing the map in full screen mode: 

 Choose View | Zoom | Full Screen , or press F9. 

 To return to normal viewing m
or press F9 again. 

ode, choose Close Full Screen in the floating Full Screen toolbar, press Esc 

Inserting text notes 

 The MindView Text Note editor is a powerful tool which lets you add comprehensive text notes to the 
f 

 If the Text Note editor is not already visible, choose View | Show/Hide | Text Note Editor to open it. 

root and any branch or sub-branch of your map. You can add as many different text notes as you like to any o
these elements. 

 You can resize, dock and undock the Text Note editor according to your needs. See "Using the MindView panels" in the 
topic "Setting up your workspace" for more information. 

 In addition to text notes, you can also associate brief comments to the branches of your map. For more 
information on comments, see "Inserting comments". You can also attach an entire text file to a branch by using 

ing 

The eas

 ou want to add a text note. 

 Click the Text Note editor window (or press F8) and start entering your note. 

the Home | Insert | Attachment command. For more information on attaching text files, see "Attach
objects". 

Creating a text note 
iest way to add a text note to a root or branch is as follows: 

Select the root or branch to which y
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As soon as you click the Text Note editor window, an Edit tab appears at the right of the ribbon to help you 
format your note. 

 

 e text from the clipboard or even import text ng the local 

 

 

You can now type text, past  from an RTF file usi
menu. 

If necessary, click Undo in the Quick Access Toolbar to undo the last change(s) made. 

 Once you have finished editing your text, simply click outside the Text Note editor or select another branch.

  Once you are out of text edit
since entering text editing mode. 

ing mode, clicking Undo will undo all the changes made in the text note 

As soon as you select another branch or element in the map, the text note is automatically saved and added to the 
Object list of the root or branch. A paperclip icon  also appears to the right of the root or branch label to 
indicate the presence of an attached object. Moving the mouse pointer over the icon displays a pop-up list of all 

Ad
You can attach an additional text note to a root or branch as follows: 

New Text Note tab

the objects attached. 

ding a text note 

 Click the   at the bottom of the Text Note editor or press Ctrl + F8. 

 When the Text Note editor is not visible, you can also enter a text note by selecting the relevant root or 
branch and choosing Home | Insert | Text Note or Insert | Text | Text Note in the main menu or Insert | Text 

 the same way as with most word processors and you will recognize many of 
 in the mini toolbar that appears when you 

 To s . 

Note in the local menu. 

Formatting a text note 
Text editing in MindView works in
the commands below. Some of these commands are also included
select text with the mouse. 

ee what a particular icon does, place the mouse pointer over it until you see its descriptive label appear

 To select the entire contents of your text note, press Ctrl + A. 

 These fields let you view and change the font and font size of the currently 
selected text. 

Note that yo

 Click the 

 Choose the required options in the Text Note editor section. 

u can set a default font, text size and text color for all the text notes you enter in the MindView 
Options dialog as follows: 

MindView Button. 

 Click MindView Options in the bottom right. 

 Open the Preferences panel. 

 These icons let you increase and decrease the font size from their current values. If a piece of text is 
selected, the size of each character is increased (or decreased) individually from its current value. 
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 These icons help you set and remove formatting attributes in the usual way. You 
can set the selected characters as superscript or subscript by clicking the relevant icon. 

 The first of these icons let you change the color of the background of the selected text so that it 
looks highlighted. The second icon lets you change the color of the text itself. 

 Use these icons to create bulleted lists or numbered lists. Place the pointer in the relevant 
paragraph or at the beginning of a new line and click the appropriate icon. Clicking the arrow next to the icon 
lets you choose between different bullet styles and numbering formats. Clicking the icon again removes the 
formatting. 

 Use these icons to increase or decrease the indent level of the selected paragraph. 

 To adjust margins and indents, click the ruler icon (if the ruler is not already displayed). Drag the margin 

markers  at the left and right ends of the ruler to change the left and right margins. Drag
(which by default is shown directly below the left margin marker on the ruler) to set the inden

 the indent marker 
t margin. To indent 

 required position and type a tab 
stops by clicking on the ruler and then 

ay from the ruler. 

an entire paragraph (including the first line), set the indent marker to the
character at the beginning of the paragraph. You can insert standard tab 
dragging them into position. To remove tab stops, drag them aw

 These icons let you align the current paragraph within the text note. You can align it to the 
left margin, center it, align it to the right margin or justify it so that it is aligned with both left and right margins. 

 Clicking this icon displays all the special marks and symbols within your text note, such as line feeds and 
spaces. Click it again to hide these symbols. 

 Click this icon to insert a picture in the text note. 

Creating a hyperlink 
• To convert the selected text to a hyperlink, click  or press Ctrl + H. This lets you create a link between 

the selected text and an external element such as a URL. 

• To edit the hyperlink, press Ctrl + H again or choose Edit Hyperlink in its local menu. 

• To delete a hyperlink, choose Delete Hyperlink it its local menu. 

• To activate a hyperlink, press Ctrl while clicking the link. 

lt Hyperlink You can set the format of the selected hyperlink as default for all hyperlinks by choosing Defau
Style in its local menu. 
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• If you select No change, the hyperlink keeps the current italic, bold or underline attribute. 

• Set applies the relevant formatting (e.g. italic, bold or underline) to the hyperlink. 

• Clear removes the relevant formatting from the hyperlink. 

ue and checking the box to the left of the 

o apply the options selected to all the existing hyperlinks. 

 table 

You can also select a font, size and color for the text by choosing a val
relevant option to apply it. 

The Change All button allows you t

Creating a
The next group of icons relates to tables. 

 

• To insert a table in your text note, click the Table icon and choose the initial number of rows and columns 
required. The table is inserted at the cursor position. To change the height of table rows, or the width of 
table columns, drag the row or column dividers. You can add and remove rows and columns later using the 
Insert commands. 

• To delete the entire table, click the upper part of the Delete icon. 

• To delete the selected cell(s), row(s) or column(s), click the arrow in the lower part of the Delete icon and 
choose the relevant command. 

• To insert a row or column, place the cursor at the point of insertion, and choose the relevant Insert 
command. 

• To change the interior color of the selected cell(s), choose Shading and select your preferred color. 

• To add and remove borders or change the border color, choose Borders. 

You can also change the interior and border colors of the cells by clicking the diagonal arrow in the bottom 
right of the Table group to open the Table Borders and Shading dialog. 
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You can assign a background color to all the cells in the table or to the selected cells only. You can also 
assign a border width and color to the left, right, top or bottom edges of the entire table or to each of the 

rrent border width, just leave the Width field empty. Similarly, to keep the 
r field(s) unchanged (diagonal line on a white background). 

 and choose Merge Cells. 

d choose Split Cell. 

Spellchecking a text note 

selected cells. To keep the cu
current colors, leave the Colo

• To merge cells, select them

• To split a cell into two, select it an

 To check the spelling of the text contained in your text note, choose Spelling. 

enable you to choose a different language and set the spelling options. 
n about this feature. 

e attached to a root or branch, you can display the one you want to view as follows: 

onding to the required text note at the bottom of the Text Note editor, or 

• 

Clicking the lower part of the icon will 
See "Using the spellchecker" for more informatio

Selecting a text note 
When several text notes ar

• Click the tab corresp

Move the mouse pointer over the paperclip icon  to the right of the root or branch label and click the 
required text note in the pop-up list, or 

• Click the required text note in the Object list of the root or branch. 

Deleting a text note 

• Press Delete, or 

• Choose Delete in its local menu. 

To delete a text note, select it in the Object list and do one of the following: 

 Remember that if you delete a text note by accident, you can always cancel the deletion by clicking Undo  in the 
Quick Access Toolbar or pressing Ctrl + Z. 

Inserting comments 
MindView lets you associate comments with the elements of your map, including the workspace itself, the root 
and any branch or sub-branch. There are two kinds of comments: 

• Floating comments 

• Pop-up comments 

 In addition to these types of comments, you can also associate longer text notes with the branches of your 
map. For more information on text notes, see "Inserting text notes". 

Floating comments 

 Floating comments are brief notes that stay visible on the screen at all times. You can add as many 
floating comments as you like to the workspace itself, the root or any branch of your map. 
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Inserting a floating comment on a root or branch 
 Select the root or branch to which you want to add a floating comment and choose Insert | Text | Floating 

Comment in the main menu or Insert | Floating Comment in the local menu. 

he ribbon. 
A small window opens to let you type your comment, and a Format tab specific to the comment appears at 
the right of t

 

 By default, the text wraps around automatically after a certain number of characters. If you want to 

yping, press Enter or click outside the comment window. 

If necessary, you can move your comment to a more convenient place by dragging it with the mouse or by 
rd. 

force the next part of the comment to start on a new line, press Ctrl + Enter at the end of the first line. 

 Once you've finished t

A thin line now connects your new comment with the root or branch you attached it to. 

using the arrow keys of the keyboa

 (optional) Click the Format tab at the right of the ribbon. 

This tab contains formatting options applicable to the floating comment. 

 

 Browse through the options available in the different panels, checking their effect on your floating comment 

he Properties dialog to make changes to the floating comment. 

 detailed description of the properties applicable to a floating comment. For a general description of 
es dialog, see "Using the Properties dialog". 

Inserting a floating comment on the workspace 
 Right-click the workspace and choose Insert | Floating Comment in its local menu. 

as you go. 

As well as the Format tab, you can also use t

See "Floating comment properties: General tab" and "Floating comment properties: Text tab" in the Reference 
section for a
the Properti
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When you add a floating comment to the workspace in this way, the comment is not attached to anything and no 

en move your comment by dragging it with the mouse or by using the arrow keys of the 
en connect it to a particular branch by moving it on top of its label. 

just click it to select it and start typing the new comment. 

mment. As for branch labels, there are several ways of entering Edit mode: 

• Click the comment once to select it and press F2, or 

Once you are in Edit mode: 

 Place the cursor at the required position to edit the existing comment. 

 When you have finished, press Enter or click outside the comment window. 

connecting line is visible. 

If necessary, you can th
keyboard. You can ev

Editing a floating comment 
 To replace the existing comment, 

You can also edit the existing co

• Click the comment once to select it and click it again after a short time, or 

• Right-click the comment and choose Edit Text in its local menu. 

 Pressing Esc while in Edit mode will leave the existing comment unchanged. 

Detaching a floating comment 
 To detach a floating comment from a root or branch, select the comment and choose Detach in its local 

menu. 

space itself rather than to the root or any of its branches. 

ng: 

• Pre

• 

The comment now belongs to the work

Deleting a floating comment 
To delete a floating comment, select it and do one of the followi

ss Delete, or 

Choose Home | Editing | Delete  in the main menu, or 

• Choose Delete in its local menu. 

Pop-up comments 

 By contrast with fl ting comments, pop-up comments are normally hidden. You can add a pop-up 
comment to the root or to any branch of your map, but not to the workspace itself. This type of comment can be 
very useful as a "designer note" while you build your map. You could for instance insert a pop-up comment on
branch to list all the elements that you still need to add to that branch. 

oa

 a 

 

Inserting a pop-up comment 
 Sel  you want to add a pop-up comment choose Insert | Text | Comment in 

the main menu or Insert | Comment in the local menu. 
ect the root or branch to which
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 You can also just press F11. 

The comment window opens to let you type your comment. 

s and 

ng, press Esc, click outside the comment window or click the Close icon in the top 

A yellow comment icon

 (optional) Resize the comment window by placing the mouse pointer on one of its edges or corner
dragging in the required direction. 

 Once you've finished typi
right corner of the comment window. 

  now appears next to the branch name, indicating that there is a comment associated 
with  so 

 
w again. 

 or branch name, or 

con and click the comment window, or 

anch containing the pop-up comment and choose Insert | Edit Comment in its 
local menu. 

this branch. Moving the mouse pointer over this yellow comment icon re-opens the comment window
that you can read the comment. As soon as you move the mouse pointer away from it, MindView hides the
comment windo

If necessary, you can easily move your comment to a more convenient place by dragging its title bar with the 
mouse. 

Editing a pop-up comment 
There are several ways of entering Edit mode: 

• Click the yellow comment icon on the right of the root

• Move the mouse pointer over the yellow comment i

• Right-click the root or br

 You can also just press F11. 

Deleting a pop-up comment 
There are two ways of doing this: 

• Right-click the branch containing the comment and choose Delete | Comment in its local menu. 

• Right-click the title bar of the comment window and choose Delete in its local menu. 

Inserting icons 

 MindView lets you place icons on the branches of your Mind Map to attract attention or illustrate a 
particular idea. 

You could for instance use one of the Team icons  for all the topics of your map involving a discussion with 

others, or the Clock icon  for all topics associated with a deadline. Make sure however that you use such 
icons consistently and sparingly to avoid overloading the map. 

Inserting an icon on a branch 
 Select the branch to which you want to add an icon. 

 Choose Insert | Icons to open the gallery of icons. 

 Click the required icon. 
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The selected icon appears on the left of the branch name.  

 You can choose as many icons as you like in the Standard set. However, you can only choose one icon in 
each of the other sets. If for instance you have attached a Priority 3 icon to your branch, choosing a Priority 5 
icon for the same branch will remove the Priority 3 icon and replace it with the Priority 5 icon. 

 Once you have inserted an icon from a set other than the Standard set on a branch, clicking that icon on the branch 
replaces it with the next icon in the set. If for instance you have inserted a Priority 3 icon on a branch, clicking it replaces it 
with the Priority 4 icon and so on until Priority 9, then Priority 1 again. 

Deleting an icon 
You can delete an icon in two ways: 

• Click the icon to select it, then choose Delete Icon in its local menu. 

You can also choose Delete All Icons to remove all the icons from the branch. 

• Right-click the branch, choose Delete | Icons and select the icon to be deleted. 
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Inserting pictures 
MindView lets you add pictures to the workspace itself, the root and any branch or sub-branch. 

As all the research done in this area indicates that the use of pictures significantly enhances memory retention, 
you should try to use pictures wherever possible to illustrate your map. 

Three different types of pictures are available: 

• Branch pictures  

A branch picture "sits" on the root or branch to which it belongs. You can only add one branch picture to a 
particular root or branch. 

It is considered good practice to insert a branch picture on the root to illustrate the subject of a map, as 
shown below. 

 

• Floating pictures  

Unlike branch pictures, floating pictures can be moved wherever convenient on the workspace. Floating 
pictures can be connected to the root or particular branches, or just "float" freely on the workspace. 

 

• Attached picture files   

MindView also allows you to attach various objects to the root and branches of your map, such as text files, 
picture files, video files, Flash files and so on. Not only can you activate these objects from within 
MindView, but you can also choose to include them when exporting your map to a different format, such as 
HTML or Mediator. See "Attaching objects" for more information on attached picture files. 

Inserting a picture 
Inserting a branch picture on a root or branch 

 Select the root or branch to which you want to add a branch picture and choose Insert | Pictures | Branch 
Picture in the main menu or Insert | Branch Picture in the local menu. 

 You can also choose Home | Insert | Branch Picture in the main menu. 

 Choose the picture required in the Open dialog. 
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The picture is now inserted over the root or branch label. 

 (optional) Resize the picture as necessary by moving the mouse pointer on the required edge until it changes 
to a double arrow and drag with the mouse until the picture reaches the correct size. 

If necessary, you can reset the picture to its original size by using its aspect ratio property. See "Picture 
properties" below. 

Inserting a floating picture on a root or branch 
 Select the root or branch to which you want to add a floating picture and choose Insert | Pictures | Floating 

Picture in the main menu or Insert | Floating Picture in the local menu. 

 Choose the picture required in the Open dialog. 

The picture appears on the screen, scaled down from its original size if necessary. 

 (optional) You can resize the picture as described above. You can also move the picture to a more 
convenient place by dragging it with the mouse or by using the arrow keys of the keyboard. 

A thin line now connects your new picture with the root or branch you attached it to. 

Inserting a floating picture on the workspace 
 Click the workspace and choose Insert | Pictures | Floating Picture in the main menu or Insert | Floating 

Picture in the local menu. 

 Choose the picture required in the Open dialog. 

When you add a floating picture to the workspace in this way, the picture is not attached to anything and no 
connecting line is visible. 

 (optional) As above, you can resize or move the picture as necessary. You can even connect it to a particular 
branch by moving it on top of the branch. 

Dragging a picture 
Instead of using the MindView commands described above, you can also add a picture by dragging it from the 
Multimedia Catalog, Windows Explorer or the Windows Desktop. 

 For a full description of the Multimedia Catalog, see "Using the Multimedia Catalog". 

Dragging a picture on a root or branch 
 Just drag the picture from the Multimedia Catalog, from Windows Explorer or from the Windows Desktop 

and drop it on the relevant root or branch when it becomes highlighted. 

By default, this creates a branch picture. If necessary, you can convert this branch picture to a floating 
picture by right-clicking the branch picture and choosing Detach | Branch Picture in its local menu. 

Dragging a picture on the workspace 
 Just drag the picture from the Multimedia Catalog, from Windows Explorer or from the Windows Desktop 

and drop it on the workspace at the required position. 

Detaching a picture 
Detaching a branch picture 

 To detach a branch picture and convert it to a floating picture, select the branch to which it belongs and 
choose Detach | Branch Picture in its local menu. 

Detaching a floating picture 
 To detach a floating picture from a root or branch, select the picture and choose Detach in its local menu. 

The picture now belongs to the workspace itself rather than to the root or any of its branches. 
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Replacing a picture 
Replacing a branch picture 
You can replace a branch picture by another picture as follows: 

 Select the branch to which the picture belongs. 

 Press the Ctrl key while double-clicking the branch picture. 

The Open dialog appears, letting you choose a different picture. 

Replacing a floating picture 
 Double-click the floating picture. 

The Open dialog appears, letting you choose a different picture. 

Deleting a picture 
Deleting a branch picture 
You can delete a branch picture in two ways: 

 Start by selecting the branch to which the picture belongs, and then either: 

• Click the branch picture itself (resizing handles appear around it) and press Delete, or 

• Choose Delete | Branch Picture in the branch local menu. 

 If you press the Delete key by mistake, the whole branch will be deleted. You can restore it by clicking Undo  
in the Quick Access Toolbar or pressing Ctrl + Z. 

Deleting a floating picture 
To delete a floating picture, select it and do one of the following: 

• Press Delete, or 

• Choose Home | Editing | Delete  in the main menu, or 

• Choose Delete in its local menu. 

Picture properties 
Pictures have properties, which you can edit with the Properties dialog. 

Branches containing branch pictures have an extra Picture tab in their Properties dialog containing the picture 
properties. See "Branch properties: Picture tab" for a detailed description of the properties applicable to branch 
pictures. 

See "Floating picture properties: General tab" and "Floating picture properties: Picture tab" for a detailed 
description of the properties applicable to floating pictures. 

See "Using the Properties dialog" for a general description of the Properties dialog. 

 If the Properties dialog is not visible, choose View | Show/Hide | Properties to open it. 

Inserting task data 

 MindView Business Edition lets you enter task and time-related information on any of the branches of 
your Mind Map in order to create different types of documents, such as timelines, task lists and project plans. 

This topic explains how to enter task data on the branches of your document to create a simple task list or a 
project plan. For information about entering time data for a timeline, see "Inserting timeline data". 
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Although you can also enter task data directly in other views such as the Outline view (task lists and project 
plans) and the Gantt view (project plans only), the Task/Timeline Info panel described here allows you to enter 
task data on your branches while brainstorming your document in one of the standard Mind Mapping views. 

Building a task list 
 Click the Task/Timeline Info tab on the right of the workspace or choose View | Show/Hide | 

Task/Timeline Info Panel to open the panel. 

 Make sure the document type is set to Task management. 

 Select a branch for which you want to add task data. 

 (optional) Enter a Start date. 

 (optional) Enter an End date. 

 (optional) Choose a Priority level. 

 (optional) Choose a percentage value to indicate how far the task has progressed to Completion. 

 (optional) Assign Resources to the task by typing their names separated by semi-colons. 

You can also click the Resources button to the right of the field to open the Task Resources dialog. See 
"Assigning resources" in the "Gantt view" chapter for details about using this dialog and information on how 
to create a global resources list. 

 Repeat the procedure to add task data to other branches. 
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 (optional) To display, directly on the branches of the Mind Map, the task data you just entered, choose View 
| Branch Data | Show Branch Data  (or right-click the workspace and choose Show Branch Data on 
Map) and check the fields you want to see in the sub-menu. 

 You can then hide or show the fields on individual branches with the Show Branch Data icon of the Format tab 
(or the Show Branch Data on Branch option in the branch local menu). 

You can delete the time information inserted on a branch at any time by selecting it and clicking the Delete 
Times button. 

Once you have finished brainstorming your task list, you can display it in grid format in the Outline view for a 
better overview and faster editing. You can also obtain a chronological display of the tasks along a horizontal 
axis by switching to the Timeline view. See "Using the Outline view" and "Using the Timeline view" for more 
information on these two views. 

You can also import an existing task list from Microsoft Outlook or export your task list to it, as well as 
synchronize different versions of the same task list stored in both programs. 

For more information on the procedures involved, see "Exporting to Microsoft Outlook" and "Importing from 
Microsoft Outlook". 

Building a project plan 
A project plan is a series of interdependent tasks that need to be performed in a particular order. 

The MindView Gantt view, specific to the Business Edition, is dedicated to the creation, editing and 
management of project plans according to the rules of project management. It is the best view to use when 
working on a project plan, since it allows you to visualize immediately the consequences on the overall plan of 
any changes you make. 

There are two important differences between the way in which MindView handles a simple task list and the way 
in which it handles a project plan: 

• In a project plan, all parent branches become summary tasks. The start dates, end dates and durations of 
summary tasks are calculated automatically from their sub-tasks and cannot be edited. 

• In a project plan, tasks are only scheduled during working time, as defined by the project calendar. 

For a full description of the Gantt view, including how to set up, create and manage a project plan, see "Using 
the Gantt view" and the topics that follow it in the "Gantt view" chapter. 

The Task/Timeline Info panel described here gives you an alternative way of viewing and editing the 
information associated with the tasks of your project plan. It is useful if you want to brainstorm your project plan 
in one of the standard Mind Mapping views rather than using the Gantt view. Once you have finished 
brainstorming, switching to the Gantt view will enable you to take advantage of the full capabilities of the 
project management features offered by MindView. 

 Click the Task/Timeline Info tab on the right of the workspace or choose View | Show/Hide | 
Task/Timeline Info Panel to open the panel to open the panel. 

 Make sure the document type is set to Task management. 

There are now two possibilities: 

• If you want to create a new project plan, click the Enable Project Management button at the bottom of the 
panel. This not only enables project management but also automatically converts any existing task list data 
to conform to the rules of project management, as described above. 

• If you are working on an existing project plan, project management will already be enabled. In that case, the 
button is labeled 'Disable Project Management'. It allows you to convert your project plan back to a simple 
task list. 

 Select a branch for which you want to add task data. 

 (optional) Enter a Duration. 
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For detailed information about the different ways of entering a duration and how MindView uses this value to 
schedule tasks in a project plan, refer to the paragraph "Entering a task duration" in "Entering and editing tasks" 
(Gantt view). 

Although you can add start dates and end dates to your project tasks, it is not recommended unless you 
understand the implications of doing so. It is normally better to let MindView calculate the start and end dates of 
the tasks automatically with reference to the project start date, the task durations, and the task links that you 
might have set up in the Gantt view. For detailed information about how MindView handles start and end dates 
in a project plan, refer to the paragraph "Specifying start and end dates" in "Entering and editing tasks" (Gantt 
view). 

 (optional) Choose a Priority level. 

 (optional) Choose a percentage value to indicate how far the task has progressed to Completion. 

 (optional) Assign Resources to the task by typing their names separated by semi-colons. 

You can also click the Resources button to the right of the field to open the Task Resources dialog. See 
"Assigning resources" (Gantt view) for details about using this dialog and information on how to create a 
global resources list. 

 Repeat the procedure to add task data to other branches. 

 

 (optional) To display, directly on the branches of the Mind Map, the task data you just entered, choose View 
| Branch Data | Show Branch Data  (or right-click the workspace and choose Show Branch Data on 
Map) and check the fields you want to see in the sub-menu. 

 You can then hide or show the fields on individual branches with the Show Branch Data icon of the Format tab 
(or the Show Branch Data on Branch option in the branch local menu). 
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MindView lets you export your project plans to Microsoft Project for further work. You can also import existing 
Microsoft Project plans into the Gantt view, directly from Microsoft Project or via the Microsoft Project XML 
format. 

For more information on exporting and importing directly from Microsoft Project, see "Exporting to Microsoft 
Project" and "Importing from Microsoft Project". For the export and import options using the XML format, see 
"Exporting to XML" and "Importing from XML". 

Inserting timeline data 
MindView Business Edition lets you enter time-related information on any of the branches of your Mind Map in 
order to create different types of documents, such as timelines, task lists and project plans. 

This topic explains how to enter time information on the branches of your document in order to create a timeline. 

For information about how to enter time information for a task list or a project plan, see "Inserting task data". 

Entering time information on the branches of your document allows you to display these branches as 
chronological events along a horizontal axis in the Timeline view, as shown here: 

 

For a full description of the Timeline view, see the topic "Using the Timeline view". This topic also explains 
how you can present and export your timelines. 

Although you can work directly in the Timeline view when creating a timeline, the Task/Timeline Info panel 
described here allows you to enter time information on your branches while brainstorming your document in one 
of the standard Map views. 

Choosing a timescale 
Regardless of whether you are working in one of the Map views or in the Timeline view, the first thing you need 
to do when you are creating a timeline is to define the timescale of your document. 

 Click the Task/Timeline Info tab on the right of the workspace or choose View | Show/Hide | 
Task/Timeline Info Panel to open the panel. 

 Choose the document type Timeline in the first field.  

 Select a timescale for the document. The default timescale is Standard. 
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MindView lets you choose between several timescales to cater for different timeline projects: 

Standard: Use this timescale for normal dates and times. It is also suitable for historical times where you do not 
need to show BC dates. You can specify the year, month, day and time. The range is 1 AD to 3,000 AD. 

Daily: Use this timescale to plot time by day number, without reference to specific dates or days of the week. 
For example, you could use it to chart the life cycle of an insect or to map out a process. You can specify day 
number and time: Day 1 is the first day, Day 17 the seventeenth, Day -3 the third day before the first day, and so 
on. The range is ±1,000,000. 

Weekly: Use this timescale to plot time by week number, without reference to specific dates. You can specify 
week number, day (Monday to Sunday) and time. The range is ±100,000. 

Historic: Use this timescale for historical dates. You can specify the year (BC or AD), month and day (not the 
time). The range is 5,000,000 BC to 3,000 AD. 

Geological: Use this for plotting astronomical, geological or prehistoric events. You can specify dates in 
thousands or millions of years. Decimal numbers are allowed. The range is ±20,000,000,000. 

  It is worth taking trouble to choose the timescale that is most appropriate for your subject. If you change the timescale 
later, you will have to re-enter the time information on all the branches. 

Entering dates and times 
 Select a branch for which you want to add time information. 

 Click the Start time field in the Task/Timeline Info panel (or press F12). 

 

 Specify a Start time for the event in the dialog that opens. You do not have to make selections in all the 
boxes. For example, if you are using the Standard timescale, you can choose just a year, or just a year and 
month, without specifying an exact date or time. 
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If you make a mistake or enter a date that in hindsight is too specific for your needs, you can click Reset one 
or more times to undo your choices one by one. If for instance, you specify a date by selecting '2001', 
'January' and '22', clicking Reset will remove the information about the day to leave the date as 'January 
2001'.  

 Click OK. 

 If necessary, you can specify an End time by clicking the End time field or pressing Ctrl + F12. You do not 
need to specify an end time if your event has no extended duration. For example, to enter the date of an 
event that happened on a particular day, all you need to do is to specify the date as the Start time. 

 Repeat the procedure to add time information to other branches. 

 (optional) To display the time information you just entered on the branches of the map, choose View | 
Branch Data | Show Branch Data  (or right-click the workspace and choose Show Branch Data on 
Map) and check Start/End time in the sub-menu. 

 You can then hide or show the time information on individual branches with the Show Branch Data icon of the 
Format tab (or the Show Branch Data on Branch option in the branch local menu). 

You can delete the time information inserted on a branch at any time by selecting it and clicking the Delete 
Times button. 

 As well as using this panel, you can also enter time information on branches from the Outline view or from 
the Timeline Outline panel shown in the Timeline view. Just double-click the relevant Start Time or End Time 
cell and fill in the time picker as described above. 

Advanced options 
The End Times Definitions dialog which opens when you click the Advanced button at the bottom of the panel 
allows you to specify the way MindView should handle end times. These settings are only relevant when 
viewing the document in the Timeline view. 

 

The simplest way to explain how this works is by means of an example. Suppose you are entering dates for a 
branch concerning World War II. As start date you specify 1939, so the branch displayed on the timeline will 
start at the beginning of 1939. As end date you enter 1945. There are now two possibilities: 
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• If the setting for End time year on this dialog is set to Is included, the end time will be the end of 1945. In 
other words the duration bar for the World War II branch will stretch from the beginning of 1939 to the end 
of 1945. 

 

• If the setting for End time year on this dialog is set to Is not included, the end time will be the beginning 
of 1945. In other words the duration bar will stretch from the beginning of 1939 to the beginning of 1945. 

 

The settings for the other time periods, namely month, week and day, work in the same way. 

Important: The choices you make in this dialog will apply only to the end times you insert from now on, and 
only for the current timeline. The next time you create a timeline, the settings of this dialog will revert to their 
default values. You are therefore free to choose different options for different timelines. 

Inserting calculation values 

 MindView Business Edition lets you enter numerical data on any of the branches of your Mind Map. This 
allows you to display values, such as sales numbers, costs, exchange rates and so on, and to enter calculations. 
Built-in functions allow you to display values automatically rolled up from lower sub-branches. 

Entering values on branches 
To enter a value for, let us say, 'Units sold' on one or more branches: 

 Select the branch(es). 

 Click the Calculation tab on the right of the workspace or choose View | Show/Hide | Calculation Panel to 
open the panel. 

 In the grid, click <Insert New> under Name and type "Units sold". 
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 If you have entered a value for 'Units sold' on the Mind Map before, you can skip this step as the 'Units 
sold' field will already exist. 

 In the Value column enter the value, for example 2500. 

 

The value now appears below the branch on your Mind Map, and the 'Units sold' field (called a 'calculation 
field') becomes available for use in other branches.  

 

 Calculation fields do not display on the Mind Map if they are empty. So, if a calculation field is created but 
no value is assigned (for example, if you omitted the final step in the above procedure), it will be available for 
use but not displayed anywhere. When you give it a value for a branch (even if that value is zero) it will display 
on that branch. 

Values you add directly on branches will override any default values you may have entered (see "Entering 
defaults" below). If you enter a branch value by mistake you can type Ctrl + Z to undo your entry, or right-click 
the value and choose Reset to Default. 

 Rather than adding values (or formulas) branch by branch, it is often quicker to add them using the Defaults and 
Formats dialog instead. See "Entering defaults" below. 

Entering an automatic sum 
You can use the built in function SUM to add up values entered on the outermost sub-branches, providing a 
grand total on the root and sub-totals on the intermediate branches. To do this for a calculation field called, say, 
'Units sold': 

 Click the Calculation tab to open the Calculation panel. 

 Click Settings to open the Defaults and Formats dialog. 

 If 'Units sold' already exists, go to the next step. Otherwise, click <Insert New> and type "Units sold". 

 Type SUM as the default value for 'Units sold'. Alternatively, you can click the sum symbol  at the right 
of the field. 

The entry SUM is a simple formula comprising just one function. For more information about formulas see 
"Entering formulas" below. 

 Click OK. 

The result is shown below. Values entered for 'Units sold' in the outermost branches are progressively totaled to 
a grand total on the root branch. 
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Editing values 
To edit values on one or more branches: 

 Click the Calculation tab to open the Calculation panel. 

 Select the branch(es). 

 On the Calculation panel, make the changes in the Values column. Any changes you make will overwrite 
existing values on all of the selected branch(es). 

Entering defaults 
To save unnecessary typing it is often useful to enter defaults for calculation fields. To do this: 

 Click the Calculation tab to open the Calculation panel. 

 Click Settings to open the Defaults and Formats dialog. 

 Enter values or formulas (see the next section) in the appropriate rows of the Default values column. 

 

The values or formulas you enter here will always be used unless you override them by making different 
entries for specific branches on the Calculation panel, as described above. 

A blank entry means that there is no default. For calculation purposes the value of a blank entry is taken to 
be zero. An entry explicitly set to zero is not regarded as blank but as a default set to zero. 
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 (optional) You can add a new calculation field to the Mind Map by entering its name in <Insert New>, or 
delete an existing field by selecting it and clicking Delete. 

 (optional) You can change the order in which the values display on the Mind Map, by moving the 
calculation fields up or down in this list by selecting them and clicking the Move Up or Move Down button. 

Entering formulas 
You can enter formulas directly on branches or as defaults. The procedures are the same as those described 
above, except that you enter a formula instead of a value. 

You type the formula in the usual way, using values and any of the mathematical operators + - * /  ( ). In 
addition, the right-hand section of the function icon, , opens a drop-down list that lets you reference the 
other calculation fields on the branch. If you include any of these, the formula will use their current values at the 
relevant points in the calculation (if a field is blank its value is taken to be zero). Field names appear inside curly 
brackets in the formula. 

 

You can also use the built-in functions SUM, AVG, MIN, MAX, COUNT by selecting them in the drop-down 
list under 'Sub-Branches'. To enter SUM, the most commonly used function, you can simply click the sum 
symbol . The functions carry out the following operations: 

• SUM gives the total created by adding the values, for this calculation field, from the sub-branches one level 
below the current one. It is useful for creating sub-totals throughout your Mind Map. 

• AVG gives the average of the values for this field from the sub-branches one level below the current one. 

• MIN gives the minimum value for this field from the sub-branches one level below the current one. 

• MAX gives the maximum value for this field from the sub-branches one level below the current one. 

• COUNT gives the number of sub-branches one level below the current one. 

In the Calculation panel, it is the result of the formula that is displayed in the Value column, not the formula 
itself. To edit or view the underlying formula, double-click to enter edit mode. On the Mind Map itself, the 
formula never displays, always the result. 

If there is an error in a formula you will see the value #NAN or #NULL!: 

• The value #NAN indicates a division by zero, which leads to an invalid result. Check the divisor(s) in the 
formula to ensure that they cannot become zero. 

• The value #NULL! indicates that a value needed by the formula is missing. This can happen if you have 
deleted a calculation field referenced by the formula. If you have just deleted the field, you can restore it by 
pressing Ctrl + Z. To help identify missing fields, they are shown in black, rather than the usual green, in the 
formula. If you reinstate a previously deleted field, the error will disappear, but you may have to re-enter 
values for the field.  

Formatting values 
To specify formats for values: 

 Click the Calculation tab to open the Calculation panel. 

 Click Settings to open the Defaults and Formats dialog. 

 For each calculation field, specify one or more of the following: 

• In the  column enter text to precede the number, for example "$" to indicate a dollar value. 

• In the  column enter text to follow the number, for example " 000s" to indicate thousands. 

• In the  column enter a number to specify the number of decimal places to be displayed. 

• In the  column, check the box to display thousands separators in large values. 
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Reviewing values 
Current values are displayed directly on the Mind Map. 

The Calculation panel shows further information about the values on a selected branch: 

• A difference marker at the bottom left of a calculation field alerts you that its value is different from its 
default. This is useful because it is easy, while developing a Mind Map, to mistakenly overwrite a default 
value by entering a value or formula directly on a branch. 

 

 The difference marker relies on there being a default for the value: if there is no default (in other words 
a blank entry on the Defaults and Formats dialog), the marker never appears. 

• If you move the cursor over an entry in the Values column the hover text will show you the value and, if it is 
generated by a formula, the formula as well. 

Showing or hiding values 
To display or hide calculation fields for the whole Mind Map: 

 Select the View tab in the ribbon. 

 Select Show Branch Data. 

 Select (or deselect) the calculation fields you want to show (or hide). If you deselect a field here it will not 
be displayed and will not be available for selection in Show Branch Data on the Format tab. 

To display or hide calculation fields for a selected branch or branches: 

 Select the branch(es). 

 Select the Format tab in the ribbon. 

 Select Show Branch Data. 

 Select (or deselect) the calculation fields you want to show (or hide). If a field is grayed, it means that it has 
been deselected on the View tab (above). 

Example 
Here is an example of part of a Mind Map that uses calculation fields. 
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The calculation fields are: 

• Units sold For the outermost sub-branches, values are added branch by branch. A default value of SUM 
creates subtotals for the remaining branches and a grand total for the root. 

• Cost/unit This is the cost of each unit in dollars: it is displayed only on the outermost sub-branches. In most 
cases the value is $2.30, so this is entered as a default. A different value has been entered directly on one of 
the branches. In such cases, and wherever a value is different from its default, you will see a difference 
marker in the Calculation panel, as here: 

 

• Selling price/unit This the selling price of each unit in local currency: it is displayed only on the outermost 
sub-branches. It has no default value. 

• Exch rate ($) This the exchange rate that converts local currency into dollars: it is displayed only on the 
outermost sub-branches. It has no default value. 

• Profit On the outermost sub-branches this is calculated by a default formula. An overriding formula, SUM, 
is added to each of the remaining branches and the root to create subtotals and a grand total.  

The default values and calculation field formats, accessed by clicking Settings on the Calculation panel, are: 

 

Using Quick Data 
The Quick Data area is only useful when you select two or more branches. It shows you the results of common 
operations on the calculation field selected in the grid above for the selected branches. 

 Select two or more branches. 

 Select a calculation field in the grid at the top of the Calculation panel. 

 View the results in the Quick Data area. Sum shows the total of the relevant values for the selected 
branches, Avg shows the average of the values, Min shows the minimum value, Max shows the maximum 
value, and Count shows the number of branches selected. 

 

Printing a Mind Map 

 To print your map: 

 Click the MindView Button. 

 Choose Print. 
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 You can also press Ctrl + P. 

This opens the Print Preview dialog, which shows you what your map will look like on paper. 

The preview of the map immediately reflects the changes you make in this dialog, allowing you to experiment 
with the various settings. 

 The preview area always shows the map exactly as it is shown on the workspace. This means that if you 
have restricted the display of the map in some way, for instance by showing only 2 levels of branches, focusing 
on a particular branch or using an advanced filter, only the part of the map shown in the preview area (and the 
workspace) will be printed. 

See "Viewing a Mind Map", "Focusing on a branch" and "Filtering a Mind Map" to learn more about these 
display options. 

Using the Print Preview dialog 
The Print Preview dialog contains the following buttons and options: 

 

Print: Click to print the map as shown in the Preview area. 

Print Setup: Click to choose a different printer and set the usual printing parameters, such as paper size, print 
quality and so on. 

Fit to Page: Click to resize the map so that its entire contents fit on the single page or page spread chosen. 

Actual Size: Click to print the map at its actual size. If your map is large, this may mean that some part of it will 
be outside the print area. 

Orientation : Choose Portrait to print your map vertically or Landscape to print it horizontally. 
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Page spread: These options allow you to spread your map on several pages. This is very useful for large maps. 
If for instance your map is quite wide (as may be the case in Top Down view), you can increase the horizontal 
page spread number to ensure that its entire contents will be printed. 

 

Number of copies: Specify how many copies of your map you would like to print. 

Show document info: Check this box to display the title of the document, the name of the author and the current 
date in the lower right corner of the printed page. If you are using the 'Page spread' option to print the map on 
several pages, this information is shown on the last page in the range. 

You can customize this footer as follows: 

 Click the Edit button. 

 Click the down arrow on the right of the 'Page footer' field to choose the data you want to display in the 
footer. 

 

Each new piece of information is added to the right of the footer string. You can however rearrange the 
parameters as you wish, and even enter your own free text to separate the parameters. Note that most of the 
parameters are taken from the data shown in the File Properties dialog (click the MindView Button and choose 
Prepare | Properties). 
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Moving or resizing the map within the Preview area 
When moving the mouse pointer over the map in the Preview area, a red outline appears around it. You can 
move the map within the page or page spread by dragging the outlined area with the mouse. 

 

You can also resize the map within the page or page spread by moving the mouse pointer to one of its edges until 
it becomes a double arrow (the red outline becomes a blue outline), and dragging the edge in the direction 
required. 
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Further tasks 

Formatting a branch 
MindView lets you perform various operations on the root of your map or any of its branches, such as changing 
their shape, choosing a different fill color, defining a branch boundary, or selecting different text attributes. All 
these formatting options help you add visual interest to your map. 

 Select the root or branch you want to format. 

 To apply the same formatting attributes to all the branches, it is much easier to use the Design tab, whose predefined 
styles and design options apply to the entire map. See "Designing a Mind Map" for more information. 

You can however select several branches to give them the same formatting attributes. See "Selecting several branches" below 
for more information. 

 Click the Format tab that appears at the right of the ribbon. 

This tab contains formatting options applicable to the selected root or branch. 

 

 Browse through the options available in the different panels, checking their effect on your branches as you 
go. 

 A quick way of copying the formatting attributes from one branch to another is to use the Format Painter . Select the 
branch whose formatting you want to copy and choose Home | Clipboard | Format Painter or press Ctrl + Shift + C. The 
cursor changes to a paintbrush icon . Click the branch you want to copy the formatting to. Pressing Ctrl while clicking 
the branch will let you continue copying the format to other branches by clicking each one in turn. To return the icon to its 
normal shape after the copying, click the Format Painter icon again. 

If necessary, you can undo your changes and return the branch to the original map style defined in the Design tab 
by choosing Effects | Reset Style. 

 To return all the branches to the original style, select them all before choosing Effects | Reset Style. 

Selecting several branches 
Selecting several branches at once allows you to apply the same change to all of them simultaneously. 

 Click the first branch, then press and hold down the Ctrl key while clicking the other branches one by one. 

Each of the branches you click becomes highlighted to indicate that it is selected. 

 To deselect one or more branches simply click them again while holding down the Ctrl key. 

You can also select several branches by drawing a frame around them with the mouse. All the branches 
contained within the frame become selected. 
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 Press Ctrl + A to select all branches. 

 When you select several branches in this way, the header of the Format tab changes to Multiple Branches, 
indicating that any changes you make will apply to all the selected branches. If the branches you selected belong 
to different levels (for instance, some main branches as well as some sub-branches), only the options that the 
different levels have in common are shown in the Format tab. 

Branch properties 
As well as the Format tab, you can also use the Properties dialog to make changes to the selected root or branch. 
The Properties dialog always lists all the properties applicable to the element currently selected in the workspace. 

 Select the root or branch you want to format. 

 Choose View | Show/Hide | Properties to open the Properties dialog. 
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See "Using the Properties dialog" for a general description of the Properties dialog. 

See "Root properties: General tab" and "Branch properties: General tab" in the Reference section for a detailed 
description of the general properties applicable to a root or branch. 

See "Root properties: Text tab" and "Branch properties: Text tab" for a description of the properties applicable to 
the branch label. 

Moving a branch 
As your map grows and you start analyzing its various topics, you may realize that some of them don't in fact 
belong to the branch you first allocated them to, but should be moved to a different branch. 

This topic describes how to perform the following operations: 

• Moving a main branch or a sub-branch and inserting it at a different hierarchical level in the Mind Map 

• Cutting, copying and pasting a branch in the same document or in another document 

• Moving a main branch manually to a different position by disabling the Auto-layout mode 

Moving a main branch or a sub-branch and inserting it at a different 
level 
You can move an entire branch, including any sub-branches and objects attached to it, to a different branch of 
your map. As you work on organizing your ideas, you can for instance decide to convert a sub-topic to a main 
topic by moving the corresponding sub-branch to the root, or allocate a sub-topic to a different main topic by 
moving the corresponding sub-branch to a different main branch. 

 Select the branch you want to move to a different location by clicking it with the left mouse button. 

 While keeping the left mouse button down, drag the branch to the required location. 

The mouse pointer changes to a different shape and a line shows you where the branch will be inserted when 
you let go of the mouse button. 

 Release the mouse button to insert the branch at the required location. 
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 If you are viewing your map in the Mind Map or Left/Right views, you can also use the Ctrl + Up and Ctrl + Down 
keyboard shortcuts to move the currently selected branch up or down in the map. Similarly, the Ctrl + Right and Ctrl + Left 
keyboard shortcuts allow you to move a branch right or left in the Top Down view. 

Cutting, copying and pasting a branch 
You can apply the standard Cut, Copy and Paste functions to any branch of your Mind Map. This allows you to 
copy or move an entire branch, including all its sub-branches and attached objects, to a different part of your 
map, at the same hierarchical level or at a higher or lower level, in the same document or in a different 
document. 

You can also apply the Cut, Copy and Paste functions to the root itself. This allows you for instance to copy an 
entire map from one document and add it as a main branch or a sub-branch in a different document. This is a 
very useful feature if you need to consolidate several different documents into a master document, as described 
in "Packing a Mind Map". 

 To cut a root or a branch with all its sub-branches and attached objects to the clipboard (in other words to 
place the root or branch on the clipboard while removing it from your map), you first need to select it. You 
can then either: 

• Choose Home | Clipboard | Cut  in the main menu, or 
• Choose Cut in the local menu of the branch, or 
• Press Ctrl + X. 

 To copy a root or a branch and all its sub-branches and attached objects to the clipboard (in other words to 
place the root or branch on the clipboard while leaving it in place in your map), you first need to select it. 
You can then either: 

• Choose Home | Clipboard | Copy  in the main menu, or 
• Choose Copy in the local menu of the branch, or 
• Press Ctrl + C. 

 To paste a root or a branch and all its sub-branches and attached objects, you first need to select its new 
location, either in the same document or in a different document. You can then either: 

• Choose Home | Clipboard | Paste  in the main menu, or 
• Choose Paste in the local menu of the destination branch, or 
• Press Ctrl + V. 
The clipboard root or branch is added as a sub-branch of the destination branch you selected. 

 If you cut and paste a branch that is the starting point of a branch connection (see "Creating branch 
connections"), the branch connection will be moved with the branch. However if you cut and paste a branch that 
is the end point of a branch connection, the branch connection is not kept. 

Moving a main branch to a different position by disabling Auto-
layout 
By default, MindView automatically arranges the main branches as you insert them to prevent any overlap. You 
can however choose to reposition the main branches yourself after their insertion by disabling Auto-layout mode. 
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 Click the workspace so that no other element is selected. 

 Choose View | Show/Hide | Properties to open the Properties dialog for the view. 

 Click the Branches tab. 

 Uncheck Auto-layout. 

You can now position the main branches of your map as you wish by dragging them with the mouse. 

Note that this only applies to main branches. MindView always arranges sub-branches automatically. 

Important: If you re-enable Auto-layout mode at any point while still working on your map, the main branches 
you repositioned will be placed back in their default position. You can however click Undo  in the Quick 
Access Toolbar (or press Ctrl + Z) to cancel the re-enabling of Auto-layout and revert the display of the main 
branches to your own positioning. 

Focusing on a branch 

    As your map grows, you might find it useful to concentrate on a particular area by viewing only a 
chosen branch or set of branches. This also gives you more workspace to add comments, text notes, icons and 
other objects on the particular branch or set of branches you are viewing. 

 Click the branch that you want to isolate. 

 Choose View | Detail | Apply Branch Focus  in the main menu or Apply Branch Focus in its local 
menu. 

You can also just press F6. 

Now only the branch you selected is shown on the workspace, together with any sub-branches it may have.  

 To focus on one of the sub-branches, just select it and click Apply Branch Focus again. 

 

Note that when restricting the display in that way, any branch connections leading to branches outside the area 
shown are not represented. 

To display the entire map again, you can either: 

• Click the Clear Branch Focus icon  in the main menu, or 

• Select the branch again and choose Clear Branch Focus in its local menu, or 

• Right-click the workspace and choose Clear Branch Focus in its local menu, or 

• Press Ctrl + Shift + F6. 

 You can also collapse the entire Mind Map to just one level of branches, two levels, three levels or four 
levels by using the Detail Level icons  of the View tab. The All Levels icon  expands the Mind Map so 
that it shows all its branches down to the last level. 

 You can also press Ctrl + 1 to display just one level of branches, Ctrl + 2 to show two levels etc. Ctrl + 5 shows all 
levels. 
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Filtering a Mind Map 

 MindView lets you filter your map to only display branches that meet specific criteria. Using a filter, you 
can for instance show only the branches that contain the word "budget", or, if you are working on a timeline, 
events starting at a given date. You can also combine different criteria, so that only the branches that meet all or 
some of these criteria are shown. 

All the filters you define are saved with the MindView document. It is also possible to import and export filters 
for use in other MindView documents. 

Defining a filter 
 Choose View | Filter and click the down arrow at the bottom of the Filter icon. 

 Choose New  in the sub-menu. 

The Filter dialog opens. 

 

 Enter a name for your filter in the 'Filter name' field. 

 Click Add Level to define your first condition. 

 Click the Property field and choose the branch element that you want to use to filter the map. If for instance 
you want to restrict the display to all the branches on which you have placed a Priority 1 icon, select the 
entry "Branch icons" in the list. 

 Click the Condition field and choose the required condition. In our example, you would choose the entry 
"Equal to" or "Contains" (in case some branches contain more than one icon). 

 Click the Value field to define the condition to be applied to the branch. In our example, you would choose 
the Priority 1 icon in the icon gallery that opens when you click the Value field. 

 (optional) Click Add Level again to define a second condition, using the And/Or field to indicate whether 
both conditions must be met for the branch to display, or whether meeting just one of the two conditions is 
enough for the branch to display. 

 (optional) Continue adding conditions as required and click OK. 
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The Mind Map now only shows the branches that meet the criteria you have defined. 

The Filter icon stays highlighted to remind you that you are only viewing part of the map. 

If necessary, you can add further criteria to the filter by editing it (see below) or define new filters. 

Clearing a filter 
 To go back to the full map display, just choose View | Filter | Filter again to clear the filter. 

The Filter icon goes back to its normal state, indicating that the map is no longer filtered. 

Applying a filter 
When you have several filters, you can apply any one of them as follows: 

 Choose View | Filter and click the down arrow at the bottom of the Filter icon. 

 Click the required filter from the list shown at the bottom of the sub-menu. 

Editing a filter 
 Choose View | Filter and click the down arrow at the bottom of the Filter icon. 

 Choose Edit  in the sub-menu, select the filter you want to edit and proceed as described above. 

Deleting a filter 
You can also delete a filter previously defined permanently from the MindView document if you no longer need 
it: 

 Choose View | Filter and click the down arrow at the bottom of the Filter icon. 

 Choose Delete  in the sub-menu and select the required filter. 

Attaching objects 

 One of the strengths of MindView is that it allows you to attach objects to the root or any branch or sub-
branch of your Mind Map. This means that you can enhance your map with a variety of multimedia features, 
such as sounds, video sequences or Flash animations, as well as add all the relevant backing documents to each 
of your branches (e.g. Microsoft Excel spreadsheets, Microsoft Word documents, etc.) 

Not only can you activate these objects from within MindView, but you can also choose to include them when 
exporting your map to a different format, such as a web site or a Microsoft PowerPoint presentation. 

 Although MindView does not apply any restriction on the type of files it is possible to attach to a branch, 
you will only be able to open an attached file from the Mind Map if a program associated with its file type (e.g. 
bmp, doc, xls etc.) is installed on your computer. 

 By default, when you attach a file to a branch in this way, it is added to the Mind Map as a link to the file 
stored on your hard disk. If you intend to distribute your Mind Map to others, you should first use the Pack 
feature to pack all the attached files into the Mind Map, thereby ensuring that your colleagues have access to all 
the files you are using. See "Packing a Mind Map" for more information. If you want to send your Mind Map by 
e-mail, you can use the Send feature to create this packed version automatically. See "Sending a Mind Map" for 
more information. 

MindView also allows you to create a link between a branch and an external element such as a URL. See 
"Creating hyperlinks" for more information on links. 
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Attaching an object to a root or branch 
There are two ways of attaching an object: 

• Select the required root or branch, choose Home | Insert | Attachment in the main menu or Insert | 
Attachment in the local menu, and select the object you want to add. 

• Drag the required file from Windows Explorer and drop it on the root or branch. 

As soon as you add an object to a root or branch, a paperclip icon  appears to the right of its label to indicate 
the presence of the attached object. Moving the mouse pointer over this paperclip icon displays a pop-up list of 
all the objects attached. 

 

The attachment is also added to the Object list of the root or branch, giving you a complete overview of the 
objects you have attached to it. 

 

See "Using the Object list" for more information. 

Activating an object 
Once attached, there are several ways to activate an object: 

• Double-click the object in the Object list, or 

• Select the object in the Object list and choose Execute in its local menu, or 

• Display the object pop-up list by moving the mouse pointer over the paperclip icon  and click the object 
required. 

These actions all activate the object, which opens in the viewer associated with its extension type. For instance, 
if the attached object is a Word document, it will open in Microsoft Word. If it is a video, it will open in the 
video playing software installed on your computer, and so on. 

Deleting an object 
To delete an object, select it in the Object list and do one of the following: 

• Press Delete, or 

• Choose Delete in its local menu. 

 Remember that if you delete an attached object by accident, you can always cancel the deletion by clicking Undo  in 
the Quick Access Toolbar or pressing Ctrl + Z. 

Object properties 
Objects have properties, which you can edit in the Properties dialog. 
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See "Attachment properties: General tab" for a detailed description of the properties applicable to objects and 
"Using the Properties dialog" for a general description of the Properties dialog. 

 If the Properties dialog is not visible, choose View | Show/Hide | Properties to open it. 

Creating hyperlinks 

 The Hyperlink command lets you create a link between a branch and external elements, such as a URL, an 
external file or an email address. Once the hyperlink is inserted, activating it automatically opens the viewer 
associated with the linked element on your computer (such as browser, application or email program).  

Inserting a hyperlink on a root or branch 
 Select the required root or branch and choose Home | Insert | Hyperlink in the main menu or Insert | 

Hyperlink in the local menu. 

The Hyperlink dialog opens. 

 

 Type a name for your hyperlink. If you export your map, this is the text that will make up the hyperlink. 

 Enter the required URL. To enter other elements, click the down arrow at the right of the input field and 
choose the required prefix. 

 You can open this dialog again at any time to change its settings by choosing Edit Link in the hyperlink 
local menu. 

 To insert a web page hyperlink onto a branch, just drag the link from the web page displayed in your Internet browser. 
The Hyperlink dialog is then automatically filled in with the URL of the link. 

As soon as you add a hyperlink to a root or branch, a paperclip icon  appears to the right of its label to 
indicate the presence of the hyperlink. Moving the mouse pointer over this paperclip icon displays a pop-up list 
of all the objects attached. 
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The hyperlink is also added to the Object list of the root or branch, giving you a complete overview of the 
objects you have attached to it. 

 

See "Using the Object list" for more information. 

Activating a hyperlink 
There are several ways of activating a link from within MindView: 

• Double-click the hyperlink in the Object list, or 

• Select the hyperlink in the Object list and choose Execute in its local menu, or 

• Display the object pop-up list by moving the pointer over the paperclip icon  and click the hyperlink. 

These actions all activate the linked element: 

• If your hyperlink contains a URL, the web page opens in your default browser. 

• If your hyperlink contains a path to a file, the application associated with the file type on your computer 
opens and displays the contents of the file. 

• If your hyperlink contains an email address, a message window opens in your default email program, with 
the address supplied already filled in. 

Deleting a hyperlink 
To delete a hyperlink, select it in the Object list and do one of the following: 

• Press Delete, or 

• Choose Delete in its local menu. 

 Remember that if you delete a hyperlink by accident, you can always cancel the deletion by clicking Undo  in the 
Quick Access Toolbar or pressing Ctrl + Z. 

Hyperlink properties 
Hyperlinks have properties, which you can edit in the Properties dialog.  

  

See "Hyperlink properties: General tab" for a detailed description of the properties applicable to hyperlinks and 
"Using the Properties dialog" for a general description of the Properties dialog. 

 If the Properties dialog is not visible, choose View | Show/Hide | Properties to open it. 

Creating branch connections 

 MindView allows you to indicate visually that two or more branches of your map are conceptually related 
by adding branch connections between them. 
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You can create two types of branch connections: 

• Internal branch connections, which connect two branches of the same map, or 

• External branch connections, which connect two branches belonging to two different maps. 

 To create an external branch connection, both maps must be open. You must also make sure that the map 
where you want the connection to end has already been saved at least once. 

Creating a branch connection 
 Choose Insert | Links | Branch Connection.  

The mouse pointer changes to a different shape. 

 Click the branch or sub-branch you want the connection to start from. 

A thin line appears connecting the branch you selected and the mouse pointer. 

 Click the branch where you want the connection to end. 

 If you are creating an external branch connection, you will first need to click the tab of the second map 
in order to display it. 

A line ending with an arrow now connects your start branch with your end branch. 

A paperclip icon  appears to the right of the start branch label to indicate the presence of an attached object. 
Moving the mouse pointer over this paperclip icon displays a pop-up list of all the objects attached. The branch 
connection also appears in the Object list of the start branch. By default, its name is the name of the end branch. 

 

 (optional) Click the Format tab that appears at the right of the ribbon. 

This tab contains formatting options applicable to the branch connection. 

 Browse through the options available in the different panels, checking their effect on the branch connection 
as you go. 

As well as the Format tab, you can also use the Properties dialog to make changes to the branch connection. 

See "Branch connection properties: General tab" in the Reference section for a detailed description of the 
properties applicable to branch connections and "Using the Properties dialog" for a general description of the 
Properties dialog. 

 To create several branch connections quickly, keep the Ctrl key down while connecting the various branches. 

Changing the curve of a branch connection 
You can change the curve of a branch connection as follows: 

 Click the branch connection to select it, either directly on the map or in the Object list of the start branch. 

A handle appears at each end of the connection, made up of a straight line and a square. 
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 Click the square of one of the handles and start dragging it. 

The shape of the branch connection changes as you move the handle. As you extend the handle, the branch 
connection becomes more curved. Conversely, if you reduce the length of the handle, the branch connection 
becomes flatter. 

 Move each handle in turn until you are satisfied with the shape of the branch connection curve.  

Activating a branch connection 
If you are working on a large map, you can quickly go to the end point of a branch connection as follows: 

 Select the start branch, then : 

• Double-click the branch connection in the Object list, or 

• Select the branch connection in the Object list and choose Execute in its local menu. 

If the connection ends in a different map, MindView opens it automatically in a separate tab. 

Making a branch connection start or end on a different branch 
You can easily change the start or end point of a branch connection without having to delete the existing branch 
connection and create a new one. To do this: 

 Click the branch connection to select it, either directly on the map or in the Object list of the start branch. 

• To make the branch connection start from a different branch, drag the dot placed at the start of the 
connection to the new start branch. 

• To make the branch connection end on a different branch, drag the arrow placed at the end of the connection 
to the new end branch. 

Deleting a branch connection 
To delete a branch connection, select it in the Object list and do one of the following: 

• Press Delete, or 

• Choose Delete in its local menu. 

 Remember that if you delete a branch connection by accident, you can always cancel the deletion by clicking Undo  
in the Quick Access Toolbar or pressing Ctrl + Z. 
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Finding and replacing text 

 MindView lets you search for every occurrence of a specific word or phrase and replace these 
automatically with a new word or phrase you specify. 

You can find and replace text in the following elements: 

• Branch names 

• Floating comments 

• Pop-up comments 

• Text notes 

• Object names 

Finding text 
 Choose Review | Editing | Find/Replace or press Ctrl + F. 

 

 Enter the text that you want to search for in the Find what field of the Find dialog. 

 Select the search options required in the Options group. 

 Select the elements that you want MindView to search in the Look in group. 

 Click Find Next.  

MindView goes through your document, looking for the text you specified in the elements you selected. As soon 
as it finds an occurrence of the text, it selects the element containing the text and highlights it. 

You can now: 

• Close the Find dialog and continue your work. 

• Look for the next occurrence of the text by clicking Find Next. 

• Replace the text with another word or phrase you specify in the Find dialog. 

Replacing text 
 Type the replacement text in the Replace with field. 

 Click Replace to replace the current occurrence only or Replace All to replace all occurrences throughout 
the document.  

 To cancel a search in progress, press Esc. 
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Desktop search 
MindView supports Windows Search on Windows XP and above, letting you locate specific data within all the 
Mind Maps stored on your hard disk and identify the relevant files instantly. All the data contained within your 
MindView documents is searched, including branch text, comments and searchable embedded files (such as 
Word documents). 

 To search file contents in Windows Vista, perform an Advanced Search and check the option "Include non-indexed 
files".  

For more information on how to use Windows Search to locate information stored in your documents, please 
refer to your Windows help system. 

Inserting a new root 

 MindView allows you to create several maps in the same view by inserting several roots in it. This can be 
useful if, while working on your map, you have ideas as yet unrelated to your existing topics (i.e. branches). 
Once you have decided how they should be related, you can convert your new maps into branches of your 
existing map, or even move them to new documents altogether, as described below. 

 This procedure is only relevant to the standard Map views, namely Mind Map, Top Down and Left/Right. 

Inserting a new root in the view 
You can do this in two ways: 

• Choose Insert | Branches | New Root in the main menu, or 

• Right-click the workspace and choose Insert | New Root in its local menu. 

 You can also create a new map by detaching a branch of your existing map, either to the same document or 
to a new document. See "Detaching a branch" for more information. 

Attaching a newly created map to an existing map 
If you have created a second map in your document by inserting a new root into it, you can integrate it to your 
original map as follows: 

• To attach it as a main branch, drag its root to the original root. 

• To attach it as a sub-branch, drag its root to the branch or sub-branch you want to attach it to. 
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Moving a newly created map in a separate document 
 Select the root of your new map and choose Cut in its local menu or Home | Clipboard | Cut in the main 

menu (or press Ctrl + X). 

 Create a new document (click the MindView Button and choose New or press Ctrl + N). 

, right-click the workspace and choose Paste in its local menu or Home | 
(or press Ctrl + V). 

 Once the new document tab opens
Clipboard | Paste in the main menu 

 (optional) Delete the default root created automatically in the new document. 

Detaching a branch 
MindView allows you to create several maps in the same view by inserting several roots, as described in 
"Inse , 

xisting 
ranch) does not in fact belong to your map, or if you want to consider a particular branch as the 

rting a new root". You can also create a second map by detaching an existing branch of your Mind Map
either to the same document, or to a new document. This can be useful when you realize that one of your e
topics (i.e. b
source of a new map. 

 This procedure is only relevant to the standard Mind map views, namely Mind Map, Top Down and 
Left/Right. 

nt 
 Select the branch you want to detach and choose Detach | Branch in its local menu. 

ng a branch to a new document 
 and choose Detach | Branch as New Document in its local menu. 

sub-branches, inserted elements and attached objects becomes a new 
Mind Map. 

Detaching a branch to the same docume

Detachi
 Select the branch you want to detach

In both cases, the selected branch and all its 

Setting a password 

 MindView helps you t
Password-protected documents are als

o prevent unwanted access to your documents by protecting them with a password. 
o automatically encrypted. Longer passwords give a stronger level of 

 Click the MindView Button. 

 Choose Set Password. 

The Set Password dialog appears. 

encryption. 

 

 Enter the password in the top field. 

 Click the bottom field and enter exactly the same password. Confirm by clicking OK. 
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Fro

y entering a new password in the dialog. 

ds and save the document. 

m now on, MindView will prompt you to enter the password every time you try to open the document. 

You can change the password b

To remove the password, clear both fiel

  Do not lose your password! It is not possible to open a password-protected MindView document without 
entering the correct password. 

Packing a Mind Map 

 This feature makes it very easy to distribute your Mind Map to other users. 

 create a complete packed version of your Mind Map, ready to be sent via 

x 

ap is packed, you can continue working with it as normal. Any attached file you activate from within 
rnal 
 is 

d to it (floating pictures, branch 

re all packed within the .mvdx file. 

ap, it starts by checking all the attached files that are packed in it. If the 
rsion 

ing a Mind Map 
 map as normal as mentioned above, you also have the possibility of 

 if you want to retrieve the individual files that may have been attached to it, or 
ap file. 

e files attached to the map. 

 master map in MindView. 

 Open each packed map in turn. Each document opens in a separate tab in MindView. 

With a few mouse clicks, you can
email, shared over the network or distributed via DVD or CD-ROM. 

 Click the MindView Button. 

 Choose Prepare | Pack. 

As soon as you click OK in the message dialog that appears, MindView integrates all the external files that are 
attached to the Mind Map document (floating pictures, branch pictures, attachments and so on) within the .mvd
map file. 

Once a m
the map opens in the relevant external application, letting you edit it as you wish. When you close this exte
application, all the changes you have made to the attachment are saved in the version of the attachment that
integrated to the .mvdx map file. 

Notes: 

• Once you have packed a Mind Map, all the files you subsequently ad
pictures, attachments and so on) are automatically packed in the .mvdx map file. 

• If you have used the Additional Folders command to specify a list of folders to include when exporting to 
HTML, all the files contained in these folders are also integrated in the .mvdx file when packing the map. 
See "Additional folders" for more information about that command. 

• If the MindView view contains several maps (i.e. several roots), they a

• When MindView opens a packed m
original version of any of these files has been updated since you packed the map, meaning that the ve
contained in the Mind Map is no longer the most up to date version, it displays a message to that effect, 
giving you the option of updating the Mind Map to the latest version. 

Unpack
Although you can work in a packed
unpacking it. This may be useful
to reduce the size of the .mvdx m

To do this: 

 Click the MindView Button. 

 Choose Prepare | Unpack. 

 Choose a folder in which to place all th

Merging packed Mind Maps in a master map 
You can easily merge into a master map several Mind Maps that have been packed using the Pack feature: 

 Open your
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 Merge each packed map into your master map by copying its root (Ctrl + C) and pasting it onto the relevant 
branch of your master map. See "Moving a branch" for more information about copying and pasting 
branches. 

 While performing this operation, ma
the master map. 

ke sure you do not close any of the packed maps before you have saved 

Sending a Mind Map 

 This feature makes it very easy to send your Mind Map to other users via e-mail. 

A m efore sending it: 

e attached to it. 

ning the Mind Map and a link to a free MindView 
 MindView installed on their computer. All you have to 

do is fill in the name of the recipients and the subject of your mail message before sending it. 

 Click the MindView Button. 

 Choose Send. 

essage appears, asking you if you want the map to be packed into a single file b

• Choose Yes if you want to integrate all the external files that are attached to the Mind Map document 
(floating pictures, branch pictures, attachments and so on) within the .mvdx map file. 

For more information about the packing feature, see "Packing a Mind Map". 

• Choose No if you only want to send the .mvdx map file, without the files that you may hav

A message is created in your default mail program, contai
viewer in case the recipients of your message do not have

Using the Multimedia Catalog 

 The Multimedia Catalog contains a vast collection of high quality clipart pictures organized in many 
different categories or themes. 

arge number of pictures created 
-

 
eral users want 

nect one of your user categories to a folder containing different types of elements, such 
as videos, sounds or Flash files, which you can then drop onto your branches as attached objects. 

 Click the Multimedia Catalog tab on the right of the workspace or choose View | Show/Hide | Multimedia 
Catalog to open it. 

As well as business and web-related pictures, the Multimedia Catalog contains a l
specifically to support both the curriculum-aligned templates included in MindView and your own curriculum
based Mind Maps. 

All the Multimedia Catalog elements are free for you to use in your Mind Maps. 

You can also store your own elements in the Multimedia Catalog. This enables you to re-use them whenever 
needed by dragging them from the Multimedia Catalog into your Mind Maps. 

Finally, you can connect one or more of your User Area categories to one of your hard disk folders or to a shared
network folder in order to view and use their contents. This feature is particularly useful when sev
to make use of the same multimedia elements stored on a shared network folder. 

You can for instance con
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 You can resize the Multimedia Catalog window by placing the mouse pointer on one of its edges until it changes to a 
double arrow and dragging with the mouse.  

Overview of the Multimedia Catalog 
• User Area: This area is reserved for your own use. You can add or drag any element to it, create as many 

sub-categories as needed and even connect one or more of your user categories to an external folder. See 
"Adding elements to the Multimedia Catalog" below for more information. 

• Clipart: Contains more than 1500 high quality illustrations covering many different educational fields, as 
well as business and web-related illustrations. 

• Favorites: Place in this category any element you want to be able to find again quickly.  

• Recent: When you add a Multimedia Catalog element to your document, this element is automatically 
copied to the Recent category. This allows you to quickly find recently used multimedia elements in case 
you want to use them again. 

• Search Results: This category only appears once you have done a search in the Multimedia Catalog. It 
shows all the elements of the catalog that correspond to your search criteria. 

Browsing the Multimedia Catalog 
 To see the contents of a category, select it by clicking it or by pressing the up or down arrow key on the 

keyboard. 

A right-pointing arrow next to a category name indicates that this category contains sub-categories. 

 Click this arrow or press the right arrow key on the keyboard to show the list of sub-categories. 

 

You can collapse a category again by clicking its arrow or by pressing the left arrow key on the keyboard. 

 To examine a particular multimedia element more closely, place the mouse pointer over it. 
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This shows an enlargement of the element as well as relevant information such as its name and size. 

 

 To insert a Multimedia Catalog element in your Mind Map, just drag it from the catalog. 

Using the Favorites category 
If you often use the same elements, placing them in the Favorites category allows you to find them again very 
quickly. You can do this in two ways: 

• Right-click the relevant element and choose Add to Favorites in its local menu. 

• Drag the element from one of the Multimedia Catalog categories to the Favorites category. 

The element is now copied to the Favorites category. If you want to remove it from this category at a later stage, 
right-click it again and choose Remove from Favorites in its local menu. 

Searching the Multimedia Catalog 
If you need a picture related to a particular theme (for instance Europe), you can search the entire catalog for that 
theme: 

 Type a search word in the Search for field. For instance, if you are working on a map describing various 
countries and want to insert their flags on the map, start typing the word "flags". As soon as you enter the 
3rd character (i.e. the letter "a"), pictures of flags appear in the Search Results category. 

 (optional) If you want to restrict the search to a particular category, select this category in the Search in 
field and click the Search icon  to restart the search. 

 Scroll down the Search Results category until you find the flag you require. 

 

 During a search, the Search icon changes to . You can interrupt a search at any time by clicking this icon. 
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Searches in the Multimedia Catalog are keyword-based. Many different keywords have been associated with the 
Multimedia Catalog elements to help you find rapidly what you need. By way of example, here is a small 
selection of the many different keywords you can search for: 

people, men, women, children, buildings, symbols, countries, maps, flags, animals, plants, computing, transport 

When you enter the first few characters of a word or a full word in the 'Search for' field, MindView goes through 
all the keywords that have been associated with the Multimedia Catalog elements. All the elements which have 
one or more keywords containing the characters you entered appear in the Search Results category. 

You can view the keywords associated to a particular element and even add your own as follows: 

 Right-click the element in the Multimedia Catalog display area. 

 Choose Properties in its local menu. 

The Properties dialog appears. 

 

 Type the new keywords you want to associate with this element, separating them with semi-colons. 

 The Properties dialog also lets you edit or remove unwanted keywords or change the description that 
appears when you view an enlargement of the element. 

Adding elements to the Multimedia Catalog 
You can keep your own elements in the Multimedia Catalog for future use, either in an existing category or in 
the User Area. You are also free to create your own categories within the User Area, rename them or delete 
them. 

• Any element you add to one of the existing categories of the Multimedia Catalog is identified by a small 
shortcut icon, indicating that the element is not actually copied to the Multimedia Catalog, but only inserted 
as a link to the actual element. 

 

• Any element you add to one of the User Area categories is identified by a small gray arrow. 

 

There are different ways of adding an element to the Multimedia Catalog. Here is one of them: 

 Select the category to which you want to add the element. 

 Right-click the category and choose Add Element in its local menu. 
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 Choose the required element in the Open dialog. 

You can also add elements by dragging them from the Windows Explorer or the desktop. 

Renaming an element 
You can give relevant names to all the elements you add to the Multimedia Catalog or rename existing elements 
as follows: 

 Right-click the element you wish to rename and choose Properties in its local menu. 

 Enter a new description for the element. 

The new description will appear whenever you view the enlargement of the element. 

Deleting an element 
You can delete any element you have added to the Multimedia Catalog as follows: 

 Right-click it and choose Delete in its local menu or select it and press Delete. 

Creating a category within the User Area 
You can create your own categories within the User Area as follows: 

 Right-click the User Area or the sub-category of the User Area in which you want to create a category. 

 Choose Create Category in the local menu. 

 Type the new category name in the white box that appears. 

 

You can also rename or delete any category in the User Area by right-clicking it and choosing Rename 
Category or Delete Category respectively in its local menu. 

Connecting a category to an external folder within the User Area 
MindView allows you to connect one or more of your user categories to one of your hard disk folders or a shared 
network folder. This feature is particularly useful when several users want to make use of the same multimedia 
elements stored on a shared network folder. 

You could also connect one of your user categories to a folder containing different types of elements, such as 
videos, sounds or Flash files, which you can then drop onto your branches as attached objects. 

 Right-click the main User Area or one of its sub-categories. 

 Choose Connect to Folder in its local menu. 

The Connect Category to Folder dialog appears. 
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 Type the path of the folder you want to connect to or use the Browse button  to locate it. 

 Choose the required filter. If for instance you only want to view the available videos, choose the Video 
filter. 

Note that you can also type your own filter, such as *.bmp; *.jpg (separating the formats with a semi-colon 
as shown here) to see only pictures using these file formats or *.* to view all the files contained in the 
connected folder.  

 (optional) Check the 'Include sub-folders' option if you also want to see the contents of all the sub-folders of 
the connected folder. 

A new category is now created within the User Area, filled with all the contents of the connected folder that 
match the filter you specified. The new category takes the name of the folder that you connected it to. It is 
identified by a special icon to show that it is a connected category. 

 

If the contents of the connected folder are likely to change while you are working with the Multimedia Catalog, 
for instance if the connected folder is a shared network folder to which other users have access, you can refresh 
the connected category to make sure you see the latest contents. 

 Right-click the connected category and choose Refresh in its local menu. 

Note that you can also refresh any of the sub-folders of the connected category. 

 If the connected folder is very large, the Refresh operation may take a long time. You can interrupt it by right-clicking 
the connected category and choosing Stop Refresh in its local menu. 

Finally you can change the filter used to view the contents or even change the connection by connecting to a 
different folder as follows: 

 Right-click the connected category and choose Modify in its local menu. 

 Choose a different path and/or a different filter in the Connect to Category Folder dialog as described above. 

You can disconnect a connected category at any time as follows: 

 Right-click the connected category and choose Disconnect in its local menu. 

 Disconnecting a connected category removes the link between your User Area and the folder you connected 
to, but does not affect the external folder or its contents in any way. 

Resetting the Multimedia Catalog 
You can restore the original contents of the Multimedia Catalog at any time as follows: 

 Click the MindView Button. 

 Click MindView Options in the bottom right. 

 Open the Preferences panel. 
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 Click Reset Multimedia Catalog. 

This will leave your User Area untouched, but removes all the elements you might have added to any other 
category. 

Using the Properties dialog 

 The Properties dialog shows the properties of the MindView element currently selected, for example the 
root, a branch or a floating comment. If nothing is selected the properties of the current view are shown. 

You can use the Properties dialog to make fine-tuning changes to these elements. 

 Rather than applying properties one by one to enhance the visual aspect of your branches, it is normally easier to use 
the Format tab shown at the right of the ribbon when the branch is selected. Using this tab, you can apply branch shapes, 
branch colors and other coordinated attributes in one step. Similarly, the Design tab lets you apply predefined layouts and 
styles to the entire map in one step. 

Notes: 

• If the Properties dialog is not visible, choose View | Show/Hide | Properties to open it. 

• The properties described are not always applicable to all views. The Properties dialog only lists the 
properties applicable to the selected element in the current view. 

 You can resize, dock and undock the Properties dialog according to your needs. See "Using the MindView panels" in the 
topic "Setting up your workspace" for more information. 

The Properties dialog shown below illustrates the general properties applicable to a branch. To see the properties 
applicable to the branch label, you would click its Text tab. 

For a complete description of all the properties available for the various MindView elements, see the Reference 
section. 

  

You can make the same change to several elements at once by selecting all the elements required first. Let's 
suppose for instance that you want to change the branch color of three of your 10 branches. All you have to do is 
to select the three branches before choosing the color with the 'Fill color' property. 
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Editing properties in the Properties dialog 
The way you edit a property depends on its type as follows: 

• Label: Type in the new name or edit the existing name in the input field. 

• Number: Type in the new value in the input field. 

• Check box: Click the box to select it, click it again to deselect it. 

• Path: Type in a new folder and/or file name or edit the existing one, or click the Browse button  on the 
right side of the input field. 

• Color: Click the small rectangle and choose the new color in the Windows Color dialog. The upper left 
corner of the dialog shows all the predefined colors. To define your own color, click the required area of the 
color matrix on the right and use the slider on the extreme right of the dialog to adjust the color attributes. 
You can also enter the RGB values (Red, Green, Blue) or the Hue, Saturation and Luminosity values 
manually. The easiest way to experiment with different colors is to press and hold the mouse button and 
move the mouse pointer around the color matrix. To save a color for future use, click Add to Custom Colors. 

 Once you have made the required change, press Enter to save the edited property. 

 You can also use the Up and Down arrow keys to move between properties and press Enter to start editing.  

Using the Overview panel 

 The Overview panel gives you a miniature view of your entire document. 

 To display the Overview panel, choose View | Show/Hide | Overview. 

 The Overview panel is not available in the Outline view or the Gantt view. 

 You can resize, dock and undock the Overview panel according to your needs. See "Using the MindView panels" in the 
topic "Setting up your workspace" for more information. 

 

If your map is very large, the Overview panel can be a very useful tool to reach its different areas. 

 Move the mouse pointer over the gray rectangle contained in the Overview panel until it takes the shape of a 
hand. 

 Drag it in the direction of the map you want to explore and release the mouse button. 

The main view changes to reflect the new position of the gray rectangle. Note that the positions of the elevators 
in the workspace scroll bars also change accordingly. 

 You can achieve the same effect by using the workspace scroll bars, but the Overview panel has the 
advantage of giving you a complete representation of your map. 
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Using the Object list 

 The Object list gives you a complete overview of the objects placed on the selected branch. It allows you 
to perform various operations on them, such as activating them, deleting them or displaying their properties in 
the Properties dialog. 

 If the Object list is not visible, choose View | Show/Hide | Object List to open it. 

 

 You can resize, dock and undock the Object list according to your needs. See "Using the MindView panels" in the topic 
"Setting up your workspace" for more information. 

Manipulating objects in the Object list 
The Object list allows you to perform the following operations: 

• Select an object by clicking its name. 

The contents of the Properties dialog immediately changes to reflect the properties of the selected object, 
which you can then edit as required. 

• Activate an object by double-clicking its name or choosing Execute in its local menu. 

• Move an object up or down the list by drag and drop. This is only relevant if you intend to export your 
document and want the objects to be exported in a particular order, as it is the order of the objects in the 
Object list that dictates the order in which they are exported. 

• Delete an object by choosing Delete in its local menu. 
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Views 

Using different views 
MindView allows you to view your Mind Map in different ways, depending on your personal preference, the 
nature of your data and the use you want to make of it. 

 

 

The first four views, collectively referred to as "Map Views", are traditional Mind Mapping views: 

•  The Mind Map view represents the map with the root in the center, and all the main branches 
radiating from it in a clockwise direction. See "Using the Mind Map view" for more information. 

•  The Top Down view represents your map as a hierarchical pyramid, with the root at the top, the main 
branches underneath, the sub-branches below the main branches, and so on. See "Using the Top Down 
view" for more information. 

•  The Left view represents your map as a list of topics placed on the left of the root. See "Using the 
Left/Right view" for more information. 

•  The Right view represents your map as a list of topics placed on the right of the root. See "Using the 
Left/Right view" for more information. 

 

The remaining views are specific views adapted to a particular purpose: 

•  The Timeline view lets you display the branches of your map that contain time information in 
chronological order on a horizontal time axis. See "Using the Timeline view" for more information. 

•  The Outline view represents the map as a hierarchical list which you can expand and collapse as 
required. See "Using the Outline view" for more information. 

•  The Gantt view is dedicated to the creation, editing and management of project plans according to 
the rules of project management. See "Using the Gantt view" and all the topics that follow it for more 
information. 
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Once you have created your document, you can display it at any time in another view by choosing that view in 
the Home | View or View | View panels in the main menu or by right-clicking the workspace and choosing View 
Map As in the local menu. 

Going from one view to another only affects the way the document is displayed. The contents of the document 
are not modified, unless you edit them yourself while working in the new view. 

The only exception to this rule is the Gantt view. Going to the Gantt view automatically enables project 
management features, which may have consequences for your data. 
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Mind Mapping views 

Using the Mind Map view 

  This view represents the map with the root in the center, and all the main branches radiating from it in a 
clockwise direction. This is a good view to use when brainstorming all the ideas related to the main subject of 
the map without worrying about evaluating them or structuring them. 

 

To display your Mind Map in this view, you can: 

• Choose View | MapView | Mind Map in the Home or View tabs of the main menu, or 

• Right-click the workspace and choose View Map As Mind Map in the local menu, or 

• Press Ctrl + Shift + 1. 

To find out how to use this view, refer to the "Basic tasks" and "Further tasks" sections of this documentation. 

Using the Top Down view 

  This view represents your map as a hierarchical pyramid, with the root at the top, the main branches 
underneath, the sub-branches below the main branches, and so on. It is a useful representation for structured data 
which needs to be viewed in a hierarchical manner, in other words from the higher level to the lowest levels. 
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To display your Mind Map in this view, you can: 

• Choose View | MapView | Top Down in the Home or View tabs of the main menu, or 

• Right-click the workspace and choose View Map As Top Down in the local menu, or 

• Press Ctrl + Shift + 2. 

To find out how to use this view, refer to the "Basic tasks" and "Further tasks" sections of this documentation. 

  While in that view, you can change the display so that the sub-branches are displayed vertically by 
choosing that display in the Layout gallery of the Design tab. 

 

Using the Left/Right view 

  This view represents your map as a list of topics placed on the right of the root. It is a good choice when 
you need to present structured data in list form (for instance a list of steps) and want to be able to fully explore 
each point in the list before going on to the next point. 
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To display your Mind Map in this view, you can: 

• Choose View | MapView | Left/Right in the Home or View tabs of the main menu, or 

• Right-click the workspace and choose View Map As Left/Right in the local menu, or 

• Press Ctrl + Shift + 3. 

To find out how to use this view, refer to the "Basic tasks" and "Further tasks" sections of this documentation. 

  While in that view, you can change the display from Right to Left by choosing that orientation in the 
Layout gallery of the Design tab. 
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Timeline view 

 The Timeline view displays all the branches of your document that contain time information in 
chronological order along a horizontal time axis. The different timescales available (standard, daily, weekly, 
historic and geological) let you represent a variety of different events, such as the planning of a product launch, 
the life cycle of a bee or the rise and fall of an ancient civilization. 

 The date formats you see in MindView will depend on your computer's settings. 

 

Accessing the Timeline view 
You can access the Timeline view in different ways: 

 To create a new timeline from scratch, click the MindView Button and choose New Timeline. 

To display an existing map in timeline form in the Timeline view, you can either: 

• Choose Home | View | Timeline or View | View | Timeline in the main menu, or 

• Right-click the workspace and choose View Map as Timeline in the local menu, or 

• Press Ctrl + Shift + 4. 

Going to the Timeline view from another view only affects the way the Mind Map is displayed. The contents of 
the Mind Map are not modified, unless you edit them yourself while working in the Timeline view. 

Elements of the Timeline view 
As all the other views, the Timeline view is made up of several components: 

• The Timeline Outline 

This panel, which is displayed by default on the left of the Timeline view, shows all the branches of your 
map as a hierarchical list which you can expand and collapse as required. 

All the branches are listed, including those that do not contain time information. 
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The Timeline Outline works exactly as the main Outline view. 

You can close the Timeline Outline by clicking its Close icon . To re-open it, choose View | Show/Hide | 
Timeline Outline. 

 You can also click the Auto Hide pin  to make the Timeline Outline only appear when you hover its tab on 
the left side of the workspace. 

• The Timeline 

The Timeline area shows all the branches of your map that contain time information, arranged in 
chronological order along a time axis. 

All the branches and sub-branches that contain time information are represented, regardless of the 
hierarchical structure of the map. 

Note that if none of your branches contain time information when you switch to Timeline view, the timeline 
will be empty. 

• The Task/Timeline Info Panel 

This panel is displayed on the right of the workspace. It lets you define the timescale of your document and 
enter time information on its branches. 

Both of these operations are described in detail in the topic "Inserting timeline data". 

As well as using the Task/Timeline Info panel, you can also enter time information for your branches 
directly in the Timeline Outline or in the main Outline view. 

If the Task/Timeline Info panel is not visible, click the Task/Timeline Info tab on the right of the 
workspace or choose View | Show/Hide | Task/Timeline Info Panel. 

Using the Timeline Outline 
The Timeline Outline shows all the branches of your map, including those that do not contain time information. 
The timeline itself however only shows the branches containing time information. 

The branches are listed in the Timeline Outline in their order of creation. This means that if you created them in 
another view such as the Mind Map view, they will be listed in the Timeline Outline in the same order as in the 
Mind Map view (going clockwise from the top right), rather than in chronological order. 
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Selecting a branch in the Timeline Outline automatically selects it on the timeline. If necessary, the timeline is 
scrolled to bring the branch into view. Conversely, selecting a branch on the timeline selects it in the Timeline 
Outline. 

The Timeline Outline looks and works exactly as the main Outline view. When working in the Timeline Outline, 
you can for instance: 

• Add, delete, move, cut, copy and paste branches in exactly the same way as in the main Outline view. 

• Add branch pictures, icons, text notes and pop-up comments to any of your tasks. 

• Attach objects such as text files, video files, sound files, hyperlinks and so on.  

For a description of the Outline view and how to perform these operations, see "Using the Outline view". 

You can enter time information on a branch from the Timeline Outline by double-clicking the relevant Start 
Time or End Time cell (or pressing F12 or Ctrl + F12 respectively) and filling in the time picker as described in 
"Inserting timeline data". 

Any change you make in the Timeline Outline is immediately reflected on the timeline itself. 

Using the Timeline 
By default, the timeline shows all the branches of your map that contain time information arranged in 
chronological order along a time axis. 

 

Choosing a layout and style 
MindView lets you define the visual aspect of your timeline at any time by applying design options to it. 

 Click the Design tab at the right of the ribbon. 

 Browse through the Layouts gallery to choose your preferred layout. 

 Browse through the Styles gallery to choose your preferred style. 

 (optional) To further customize the visual aspect of your timeline, explore the options available in the 
Effects and Properties panels. 

Inserting branches 
As well as using the Timeline Outline, you can enter events (branches) directly on the timeline itself: 

 Double-click the workspace. 

 Fill in the relevant details in the Insert Event dialog and click OK. 
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The branch is now inserted at the correct place in the timeline. 

 Clicking Next instead of OK keeps the dialog open, ready for you to insert more branches. 

Moving branches 
MindView also lets you move branches on the timeline by dragging them to a different start time. Note that if an 
end time had been specified for the branch, this end time is also moved so that the duration remains the same. 

 

 For more precise positioning, double-click the relevant Start Time or End Time cell in the Timeline Outline (or press 
F12 or Ctrl + F12 respectively) to open the time picker. 

Adding objects and elements 
When working in the Timeline view, you can add icons, pictures, text notes, comments and branch connections 
on any of the branches displayed in the timeline, just as in all the other views. You can also attach objects such 
as text files, video files, sound files and hyperlinks. 

 Select the required branch on the timeline. 

 Choose the relevant command, using either the main menu or the local menu of the branch. 

For more information on these procedures, see the topics "Inserting icons", "Inserting pictures", "Inserting text 
notes", "Inserting comments", "Attaching objects", "Creating hyperlinks" and "Creating branch connections". 
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Viewing the Timeline 
Viewing the events 

 You can display the start and end times of the timeline events underneath their label by choosing View | 
Branch Data | Show Branch Data  (or right-click the workspace and choose Show Branch Data on 
Map) and check Start/End time in the sub-menu. 

 You can then hide or show the time information on individual branches with the Show Branch Data icon of the 
Format tab (or the Show Branch Data on Branch option in the branch local menu). 

• If you have entered both a start time and an end time for a particular event, you can show the duration of this 
event as a bar below the time axis by clicking Design | Properties | Show Duration Bars. 

• You can view pop-up comments and attached objects by clicking the comment icon  or paperclip icon  
just as in the other views. 

• The Numbering Scheme icon  of the Home tab lets you apply sequential numbers to the branches of the 
Timeline according to their order in the Timeline Outline. When your timeline has several levels of 
branches, it will help you identify which main branch the different sub-branches belong to. 

• As in the other views, you can also use the Apply Branch Focus icon  of the View tab to restrict the 
display to a particular branch. Click the Clear Branch Focus icon  to view the entire timeline again. 

  If the branch you selected does not have any sub-branches, or if its sub-branches do not contain time 
information, the timeline will be empty. 

For more information about this procedure, see the topic "Focusing on a branch" of the "Further tasks" 
section. 

• Finally the Filter icon  of the View tab lets you hide all the timeline branches that do not meet the filter 
criteria you have defined. 

For more information about this procedure, see the topic "Filtering a Mind Map" of the " Further tasks" 
section. 

Zooming in and out 
You can change the level of magnification of your entire timeline as follows: 

• Click the Zoom In icon  of the Zoom slider shown in the bottom right of the workspace (or press Ctrl + 
"+") to increase the level of magnification of your timeline. 

When you zoom in, everything gets bigger, including the text, the boxes and the pictures included on your 
timeline. 

• Click the Zoom Out icon  (or press Ctrl + "-") to decrease it. 

When you zoom out everything gets smaller. 

• Choose View | Zoom | Fit All  or press F4 to see the entire timeline. 

You can also view your timeline in full screen mode, to give it as much screen space as possible: 

 Choose View | Zoom | Full Screen  or press F9. 

 To return to normal viewing mode, choose Close Full Screen in the floating Full Screen toolbar, press Esc 
or press F9 again. 

See "Zooming in and out" for more information on zooming. 
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Expanding and compressing 
You can also increase or decrease the level of detail on the time axis as follows: 

• To increase the scale on the time axis, click Design | Properties | Expand. 

• To decrease the scale, click Design | Properties | Compress. 

Expanding the scale makes the timeline less crowded as a given period of time occupies more horizontal space. 
As a result, you may start seeing more detail on the time axis. For instance, instead of having ticks every 5 years, 
you might now have a tick for every year. As you continue expanding the scale, you might see months and days 
appear on the time axis. 

Events on the timeline do not change size when you expand the scale: they move apart horizontally, and they 
may also move vertically nearer the time axis as more space becomes available. Contracting the scale has the 
reverse effect. 

Inserting time breaks 
You can also replace empty space on the time axis with one or more break marks by clicking Design | 
Properties | Show Time Breaks. 

This optimizes the use of the horizontal space when events are not evenly distributed along the timeline. 

 

 To remove these time breaks, just click the icon again. 

Exporting the Timeline 
When working in the Timeline view, the only export methods available are: 

• Export to HTML 

This export method works in exactly the same way as when you export the document from one of the 
standard Mind Mapping views. The only difference is that the Home page of your web site contains an 
interactive view of the timeline, allowing you to display each of its pages with a simple click wherever the 
mouse pointer changes to a hand. A Timeline button is inserted in all the pages of the site to let you return 
quickly to this interactive view. 
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For more information about this export method, see "Exporting to HTML". 

• Export to Microsoft Outlook 

For more information about this export method, see "Exporting to Microsoft Outlook". 

• Export to Microsoft Project 

For more information about this export method, see "Exporting to Microsoft Project". 

• Export to XML 

For more information about this export method, see "Exporting to XML". 

• Export to picture 

For more information about this export method, see "Exporting as picture". 

Printing the Timeline 
You can print your timeline in the same way as in the Map views.  

MindView enables you to spread your printout on several pages, which is very useful in the case of timelines. 
Increasing the horizontal page spread number, for instance, will allow you to create a legible printout of your 
entire timeline, spread over several pages. 

For a full description of the printing options, see "Printing a Mind Map". 
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Outline view 

 The Outline view represents the map as a hierarchical list which you can expand and collapse as required. 
It allows easy navigation through the document from top to bottom and gives you another way to brainstorm 
ideas. 

It is particularly useful when building a task list, as you can view all the task properties in one glance and edit 
them quickly by clicking the relevant cell. 

Accessing the Outline view 
You can access the Outline view in different ways: 

 To create a new outline from scratch, click the MindView Button and choose New Outline. 

To display an existing map in outline form in the Outline view, you can either: 

• Choose Home | View | Outline or View | View | Outline in the main menu, or 

• Right-click the workspace and choose View Map as Outline in the local menu, or 

• Press Ctrl + Shift + 5. 

 

Going to the Outline view from another view only affects the way the Mind Map is displayed. The contents of 
the Mind Map are not modified, unless you edit them yourself while working in the Outline view. 

Elements of the Outline view 
The Outline view is made up of several columns: 

• A picture icon  in the first column denotes the presence of a branch picture. Just move the pointer over 
the icon to see a preview of the picture. Double-click the icon to display the picture in the image viewer 
associated with its file extension on your computer. 
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• A yellow comment icon  in the next column indicates that the corresponding branch contains a pop-up 
comment. Just move the pointer over the icon to open the comment window. 

• A paperclip icon  in the third column indicates that the corresponding branch contains attached objects 
(text notes, text files, video files and so on) or that it is linked to another branch via a branch connection. To 
view an attached object, move the pointer over the icon to display the pop-up list of attached objects and 
click the required object to open it in the associated viewer. 

• If you have inserted one or more icons on the corresponding branch, these are shown in the last column 
before the branch name. 

• By default, the columns on the right of the view show the Start and End dates you can associate with the 
branch to describe a task, as well as its Priority, Completion level and Resources. See "Inserting task data" 
for details about these fields. 

• If you are working on a project plan, a Duration column also appears. See "Using the Gantt view" for more 
information about project plans. 

• If you are working on a timeline, the columns on the right of the view show the Start Time and End Time 
associated with each timeline event. See "Inserting timeline data" for details about these fields. 

 You can hide any of these columns by right-clicking the Branch Name header at the top of the Outline view and 
deselecting the unwanted columns in the local menu. 

Using the Outline 
Choosing a color scheme 
MindView lets you apply different color schemes to your outline: 

 To choose a different color scheme, click the Design tab and check the effect produced by the different 
options of the Color Scheme gallery before clicking your preferred option. 

Inserting a branch 
You can add and delete main branches, pre-branches and sub-branches in the Outline view in just the same way 
as in the Map views. 

Moving a branch 
You can move an entire branch, including any sub-branches and objects attached to it, to a different branch of 
your outline. As you work on organizing your ideas, you can for instance decide to convert a sub-topic to a main 
topic by moving the corresponding sub-branch to the root, or allocate a sub-topic to a different main topic by 
moving the corresponding sub-branch to a different main branch. 

 Select the branch you want to move to a different location by clicking it with the left mouse button. 

 While keeping the left mouse button down, drag the branch to the required location. 

The mouse pointer changes to a different shape to show you where the branch will be inserted when you let go of 
the mouse button. 

• A small right arrow  indicates that the branch will become a sub-branch of the branch containing the 
arrow. 

• A small up arrow  indicates that the branch will be inserted above the branch containing the arrow, at the 
same level. 

• A small down arrow  indicates that the branch will be inserted below the branch containing the arrow, at 
the same level. 

 Release the mouse button to insert the branch at the required location. 
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• You can also choose Home | Editing | Indent  (or press the keys Alt + Shift + right arrow) to move the 
selected branch or branches to the next level down in the hierarchy, so that they become sub-branches of the 
preceding branch in the Outline. 

• Conversely, choosing Home | Editing | Outdent  (or pressing the keys Alt + Shift + left arrow) moves 
the selected branch or branches to the next level up in the hierarchy. 

Cutting, copying and pasting branches 
You can apply the standard Cut, Copy and Paste functions to any branch or set of branches of your outline, as 
described in "Moving a branch". You can for instance copy or move an entire branch or set of branches, 
including all their sub-branches and attached objects, to a different part of the outline, at the same hierarchical 
level or at a higher or lower level. 

To perform these operations on a set of branches, you first need to select them: 

• To select a range of branches listed one after the other, select the first branch, press and hold down the Shift 
key and select the last branch in the range. 

• To select several isolated branches, select the first branch, press and hold down the Ctrl key and select the 
other branches one by one. 

Adding objects and elements 
You can add branch pictures, icons, text notes and pop-up comments on a branch in the same way as in the Map 
views. For more information on these procedures, see the topics "Inserting pictures", "Inserting icons", "Inserting 
text notes" and "Inserting comments" in the "Basic tasks" section. 

You can also attach objects such as text files, video files, sound files, hyperlinks and so on just as in the Map 
views. For more information, see "Attaching objects" and "Creating hyperlinks". 

There are however some limitations that apply when you work in the Outline view: 

• You cannot add or view floating pictures. 

• You cannot add or view floating comments. 

• You cannot create branch connections, although existing branch connections are listed in the pop-up list 
identified by the paperclip icon and can be activated from that list. 

Viewing the Outline 
• You can expand or collapse a particular branch or set of branches by clicking the small plus  and minus  

signs on the left of the branch name or by pressing the keys Ctrl + right arrow to expand and Ctrl + left 
arrow to collapse. 

• The Numbering Scheme icon  of the Home tab lets you apply sequential numbers to the branches of the 
outline and choose between various numbering styles. 

• As in all the other views, the Detail Level icons  of the View tab let you collapse the entire outline to just 
one level of branches, two levels, three levels or four levels. To show all the branches down to the last level, 
click the All Levels icon . 

 You can also press Ctrl + 1 to display just one level of branches, Ctrl + 2 to show two levels etc. Ctrl + 5 shows 
all levels. 

• As in the other views, you can use the Apply Branch Focus icon  of the View tab to restrict the display 
to a particular branch. Click the Clear Branch Focus icon  to view the entire outline again. 

For more information about this procedure, see the topic "Focusing on a branch" of the "Further tasks" 
section. 
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• Finally the Filter icon  of the View tab lets you hide all the branches of the outline that do not meet the 
filter criteria you have defined. 

For more information about this procedure, see the topic "Filtering a Mind Map" of the "Further tasks" 
section. 

Printing the Outline 
You can print your outline in the same way as in the Map views.  

For a full description of the printing options available, see "Printing a Mind Map". 
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Gantt view 

 The MindView Gantt view is dedicated to the creation, editing and management of project plans 
according to the rules of project management. 

A project plan is a series of interdependent tasks that need to be performed in a particular order. When moving 
into a new office for instance, you cannot start redesigning the office space before the lease agreement has been 
signed. Project plans have a specific start date, corresponding to the start of the first task (for instance defining 
the requirements for the new office), and a specific end date, corresponding to the end of the last task (for 
instance moving in). 

Any change in the timing of a task affects all the tasks that depend on it. If a task runs ahead of schedule, 
MindView automatically recalculates the dates of all the tasks that depend on it in order to take advantage of the 
time gained. Conversely, if a task is delayed, all the tasks that depend on it are automatically rescheduled, which 
may or may not impact the overall end date of the project.  

In project management, the Gantt chart is the most common and popular way of visualizing a project plan. It 
shows the tasks as horizontal bars, arranged against a background calendar display. MindView's Gantt view 
displays the branches of a Mind Map in this way, each branch or sub-branch representing a project task. 

 The date formats you see in MindView will depend on your computer's settings. In this documentation we 
use the most common international format, putting the day first, for example 1-Sept-2012, or 01/09/12. 

 

By using the Gantt view you can build and manage complete project plans in this standard, well-defined format. 
You can easily add or remove tasks, set or adjust the duration of tasks (length of bars), link tasks (for example to 
make one task follow immediately after another), and add constraints (for example to specify that a task must 
end no later than a given date). 

To help you get started, MindView includes various ready-made project plans for common business activities 
(organizing a tradeshow, producing a publication, launching a product and so on). You can use these for training 
purposes, or as a basis for your own project plans. 

 To access one of these templates, click the MindView Button, choose New from Template, click the 
Templates tab and select the Business category. 

To find out how to set up and build a project plan, see "Setting up a project plan". 

Accessing the Gantt view 
You can access the Gantt view in different ways: 

 To create a new Gantt project plan from scratch, click the MindView Button and choose New Gantt. 

To display an existing document in the Gantt view, you can either: 

• Choose Home | View | Gantt or View | View | Gantt in the main menu, or 

• Right-click the workspace and choose View Map as Gantt in the local menu, or 
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• Press Ctrl + Shift + 6. 

 These commands are not available when you are working on a timeline. For these commands to be 
available, you must choose the document type 'Task management' in the Task/Timeline Info panel. For more 
information on this panel, see "Inserting task data". 

  Going to the Gantt view automatically enables project management features if this is not the case already. 
The main consequences of this are: 

• All parent branches become summary tasks: their start dates, end dates and durations are calculated 
automatically from their sub-tasks and cannot be edited manually any longer. Any existing time information 
associated with parent branches is lost. 

• Tasks are only scheduled during working time, as defined by the project calendar.  

Project plans have other important rules regarding links and constraints that are all described in the following 
topics. 

When you are working on a project plan, these project management rules apply even if you switch temporarily to 
another view than the Gantt view, for instance to brainstorm your plan in one of the Mind Mapping views, or to 
view it as a timeline in the Timeline view. This means that any change you make to the project plan tasks while 
in one of these other views will obey project management rules. 

Elements of the Gantt view 
As all the other views, the Gantt view is made up of several components: 

• The Gantt Outline 

This area, shown on the left of the Gantt view, presents all your project tasks as a hierarchical list which you 
can expand and collapse as required. 

The tasks are listed in creation order, which means that if you created them in a different view such as the 
Mind Map view, they will be listed in the Gantt Outline in the same order as in the Mind Map view (going 
clockwise from the top right), rather than in chronological order. 

• The Gantt Chart 

The Gantt chart, shown on the right of the view, represents each project task graphically as a bar stretching 
from its start date to its end date. Week-ends and other non-working days are denoted by a hash pattern. 
Task relationships are represented by links joining the related tasks. 

• The Task/Timeline Info Panel 

This panel is displayed on the right of the workspace. It gives you an alternative way of specifying task data 
such as duration, priority, completion level or resources.  

The Task/Timeline Info panel is described in detail in the topic "Inserting task data". 

If it is not visible, click the Task/Timeline Info tab on the right of the workspace or choose View | 
Show/Hide | Task/Timeline Info Panel. 

• The Gantt Tools Tab 

 

This toolbar appears as soon as you switch to the Gantt view. Its icons allow you to perform various actions 
on your project tasks, as described in the next few topics. 
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Using the Gantt Outline 
The Gantt Outline is made up of several columns. Some of these only appear if one or more of the project tasks 

e order in which the tasks will be performed. 

contains the corresponding element: 

• The first column is the Entry column. It shows the unique entry number automatically allocated to each 
task. The entry numbers do not necessarily represent th

• A picture icon  in the second column denotes the presence of a branch picture. Just move the pointer
over the icon to see a preview of the picture. Double-click the icon to display t

 
he picture in the image viewer 

associated with its file extension on your computer. 

• A yellow comment icon  in the next column indicates that the corresponding task contains a pop-up 
comment. Just move the pointer over the icon to open the comment window. 

• A paperclip icon  in the fourth column indicates that the corresponding task contains attached objects 
(text notes, text files, video files and so on) or that it is linked to another task vi
view an attached object, move the pointer over the icon to display the pop-up l

a a branch connection. To 
ist of attached objects and 

. 

The Gantt Outline also contains columns that are specific to project management: 

click the required object to open it in the associated viewer. 

• If you have inserted one or more icons on the corresponding branch, these are shown in the next column

• Indicators: If you have applied a constraint to a task, for example to specify that it must end no later than a 
given date, a constraint icon  is displayed in the column immediately before the Task Name colum
Constraints are described in detail in "Using Constraints". 

n. 

• Task Name: The name of each task. Tasks that contain one or more sub-tasks are shown in bold. These 
inary 

ing 

 units are indicated by letters: mins 
d 

ate. By 
default, MindView assigns a duration of one day to new tasks or tasks without specified duration. For more 
info

ation of a summary task. 

tasks (which correspond to parent branches in the Mind Map view) are called "summary tasks". Ord
tasks (corresponding to branches without sub-branches in the Mind Map view) are shown in normal 
typeface and indented according to their level. See the paragraph "Grouping tasks" in "Entering and edit
tasks". 

• Duration: The amount of working time the task will take. Time
(minutes), hrs (hours), days, wks (weeks), mths (months). The letter e before the time unit indicates elapse
time, in which case the task will last exactly the time specified, regardless of what the project calendar 
defines as working and non-working time. A question mark means that the figure is still an estim

rmation about calendars, see "Defining calendar settings". 

The task bar of a summary task is automatically set to extend from the beginning of the earliest of its sub-
tasks to the end of the last of its sub-tasks. You cannot change the dur

 When expressed in days, weeks or months, the number shown in the Duration column (for instance "2 
 

ation about durations, see "Entering a task duration" in the topic "Entering and editing 

• t 
formation dialog (choose Gantt Tools | Project | Project 

tart date of the earliest of its sub-tasks. 

days") is linked to the default number of working hours per day, week of month set in the Project Calendar
Settings dialog (choose Gantt Tools | Project | Project Calendar). 

For more inform
tasks". 

Start: The current start date of the task. By default, MindView schedules new tasks to start on the projec
start date, as defined in the Project In
Information). 

Although you can set start dates explicitly, it is best to let MindView set them automatically according to the 
dependencies between the various tasks. See "Specifying start and end dates" in the topic "Entering and 
editing tasks" for more information. 

The start date of a summary task is automatically set to be the s
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• End: The current end date of the task. MindView calculates the end date for a task from its start date and
duration, paying attention to the working and non-working time specified by the project calendar. Unless
duration is specified as "elapsed", MindV

 its 
 the 

iew only schedules tasks during working time. For more 

u can set end dates explicitly, it is best to let MindView set them automatically according to the 
dependencies between the various tasks. 

information on task dependencies. 

 

information about calendars, see "Defining calendar settings". 

Although yo

The end date of a summary task is automatically set to be the end date of the last of its sub-tasks. 

• Predecessors: If a task is linked to one or more earlier (predecessor) tasks, this column shows the entry 
numbers of those earlier tasks. Task entry numbers are shown in the first column. See "Using links" for 
more 

• Resources: If you have assigned resources to a task, they are listed in this column. See "Assigning
resources". 

 You can hide any of these columns by right-clicking the Task Name header at the top of the Gantt Outline and 
deselecting the unwanted columns in the local menu. 

. When working in the Gantt Outline, you can for 
instance: 

 Add, delete, move, cut, copy and paste tasks in exactly the same way as in the main Outline view. 

umbering Scheme icon 

The Gantt Outline works exactly as the main Outline view

•

• Add branch pictures, icons, text notes and pop-up comments to any of your branches. 

• Attach objects such as text files, video files, sound files, hyperlinks and so on. 

• Use the N  of the Gantt Tools tab or Home tab to apply sequential numbers to the 
tasks and choose between various numbering styles. 

• Use the Detail Level icons  of the View tab to determine how many levels of tasks should be visible. 

• Use the Apply Branch Focus icon  of the View tab to restrict the display to a particular task and click 
the Clea  r Branch Focus icon  to view the entire project plan again. 

• Use the Filter icon  of the View tab to hide all the tasks that do not meet the filter criteria you have 
defined. 

For details on how to perform these operations, see "Using the Outline view". 

Viewing the Gantt Chart 

 Click the Zoom In icon 

You can manipulate the timescale shown at the top of the Gantt chart to view your tasks with more or less detail 
as follows: 

•  of the Gantt Tools tab (or press Ctrl + "+") to view your schedule in more 
bination to a Days/Hours combination. detail, going for instance from a Months/Weeks com

• Click the Zoom Out icon  (or press Ctrl + "-") to show larger increments of time, going for instance 
from a Months/Weeks combination to a Years/Quarters combination. 

• Choose Fit All  or press F4 to let MindView choose the level of detail that allows the entire project plan 

You can also view your chart in full screen mode, to give it as much screen space as possible: 

 Choose View | Zoom | Full Screen

to fit on the chart. 

  or press F9. 

 To return to normal viewing mode, choose Close Full Screen in the floating Full Screen toolbar, press Esc 
or press F9 again. 

You can also choose from a wider variety of combinations of calendar headings as follows: 
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 Double-click the headings (tiers) at the top of the calendar display to open the Gantt Timescale dialog. 

 

 Choose a unit and a label for the top tier (the top heading). 

 

 shown on the Gantt chart, you can reveal that part of the 

 the Go to Selected Task icon 

Choose a unit and a label for the bottom tier (the bottom heading). 

Note that the choices offered for the bottom tier depend on your choice of top tier. 

If the task you want to view falls outside the time range
project plan to view the relevant task bar as follows: 

 Select the task in the Gantt Outline and click  on the Gantt Tools tab. 

ets you define the visual aspect of your overall Gantt, as well as customize the display of individual 

produced 
by the different options of the Color Scheme gallery before clicking your preferred option. 

Customizing the Gantt Chart 
MindView l
task bars. 

Customizing the overall display 
 To choose a different color scheme for the entire chart, click the Design tab and check the effect 

 

The Design tab also lets you apply other global effects to the Gantt chart: 

• To display the task name and/or the resources names after the task bars, check Show/Hide Task Name 

 The Horizontal Grid and Vertical Grid option let you switch the horizontal and vertical grid lines of the 

• To display a vertical line identifying the current date on the Gantt chart, click View | Show Today's Date on 
the 

and/or Show/Hide Resources. 

•
Gantt chart on and off. 

Gantt Tools tab. 

 You can change the color of this line in the Properties dialog. See "View properties

• Finally, you can also change the color used to identify the tasks lying on the critical path (View | Show 
Critical Path in the Gantt Tools tab) in that same Properties dialog. 

: General tab" for more 
information. 
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Customizing the task bars 
The Design tab also lets you modify the shape, fill color, outline color and fill pattern of both summary task 
bars and standard task bars in one operation: 

 Click the Design tab at the right of the ribbon. 

 Browse through the options shown in the Standard Tasks and Summary Tasks panels to choose your 
preferred style. 

If you need to distinguish some tasks from others, you can also customize them individually: 

 Select the task(s) to customize. 

 Click the Format tab and choose the relevant options. 

If necessary, you can undo your changes and return the task bar to the original style defined in the Design 
tab by choosing Reset Style. 

 

If you have chosen to display the task name and/or the resource names after the task bars, you can set different 
colors for these labels by using the Properties dialog. 

For other ways of customizing the representation of your project plan on the Gantt chart, see "Enhancing a 
project plan". 

Setting up a project plan 
These are the typical steps you should follow when setting up, building, managing and revising a project plan. 

 (optional) Start by brainstorming all the tasks that make up your project plan in one of the standard Mind 
Mapping views (Mind Map, Top Down or Left/Right), using the Task/Timeline Info panel to enter 
preliminary task data. 

 Define the project settings, such as its start date, end date and scheduling mode. For more information, see 
"Defining the global project settings". 

 (optional) Define the project calendar. You may be able to bypass this step if you have already set up 
appropriate calendar defaults. See "Defining calendar settings" for more information. 

 (optional) Create the global resources list. Although MindView lets you define the resources as you need 
them, it is usually quicker to start by setting up a global resources list from which you can then select 
resources to assign to the various project tasks. See "Assigning resources" for details. 

 Enter or edit task names and durations. See "Entering and editing tasks". 

 Assign resources to tasks. See "Assigning resources". 

 Create links to specify the dependencies between the project tasks. See "Using links". 

 Set constraints on the tasks as necessary. See "Using constraints". 

 Make final adjustments to the project plan. See "Enhancing a project plan". 

 Once the project has actually started, inspect it at regular intervals to detect potential problems or scheduling 
conflicts and make any corrections required. See "Reviewing a project plan". 

 (optional) If you need to expand your project plan further, you can easily export it to Microsoft Project to 
take advantage of the advanced project management capabilities of this application. 
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For more information, see "Exporting to Microsoft Project". 

 You can also create various HTML reports from your project plan, export it to Microsoft Outlook as a series 
of tasks or export it in XML format. For more information, see "Creating reports" and "Exporting a project 
plan". 

Defining the global project settings 

 Before doing detailed scheduling work on the tasks of your project plan, it is worth considering its global 
settings, such as its start date and scheduling mode. 

 To view these settings, choose Project | Project Information on the Gantt Tools tab. 

 

This dialog contains general project information which is important in determining how the project tasks are 
scheduled. 

Schedule from: Defines the scheduling mode for your project. The most common way of setting up a project is 
to schedule it from its start date. In this mode the default is for tasks to start as soon as possible, which means 
that the whole project finishes at the earliest possible date. When you plan backwards from the project end date, 
tasks are scheduled to start as late as possible so that the whole project finishes on the specified end date. 
Planning from the end date is not recommended as it does not allow any slack time between tasks. Even when 
you have a specific deadline for your project, planning from the start date is the most flexible approach as it 
ensures that each task is completed at the earliest possible date, leaving as much slack time as possible to deal 
with unplanned problems or delays.  

Start date: Specifies the first day of the first task. By default, this field is set to today's date. If your project is 
due to start sometime in the future or if you are planning a project that has in fact already started, indicate the 
start date of the project in this field. 

By default, all the tasks you create will be scheduled to start on the project start date, unless you assign specific 
timings to them or link them to other tasks. 

If you are scheduling from the start date, MindView calculates the project end date automatically, based on the 
duration of the project tasks, their relationships, and the project calendar. 

End date: Specifies the last day of the last task. If you are scheduling from the end date, MindView calculates 
the start date automatically, also by taking into consideration the duration of the project tasks, their relationships, 
and the project calendar. 

Defining calendar settings 

 Calendars and calendar settings provide the basic information about working and non-working time that 
MindView uses to schedule the tasks of a project plan. MindView does not allow work to happen on non-
working days or at non-working times. 
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There are two types of calendar: 

• The default calendar 

The default calendar provides the initial settings for any new MindView file you create. By editing these 
defaults to values reflecting your company's normal working days and times, you can minimize the changes 
needed when you create a new project plan. 

• The project calendar 

Each project plan has its own project calendar. The settings it contains affect the way MindView schedules 
the project tasks. To start with, when you create a new file, the project calendar is identical to the default 
calendar. 

The project calendar is saved with the rest of the project properties whenever you save the file. 

You can edit either calendar together with the relevant settings: 

 To edit the default calendar, click the MindView Button, click MindView Options in the bottom right of 
the dialog and open the Calendar panel. Changes you make here only affect the initial settings for new 
files; they do not affect existing files. 

 To edit the project calendar, choose Project | Project Calendar on the Gantt Tools tab. Changes you 
make here only affect the current file. 

The two dialogs are almost identical: all the options are described below, but only the project calendar dialogs 
are illustrated. 

Defining the settings 

 

Hours per day: Defines the number of working hours in a standard working day, for example 8. You can enter 
the value as a decimal number (e.g. enter 7.5 to specify 7 hours and 30 minutes). MindView uses this value to 
calculate task durations that are specified in days. 

Advanced notes: This setting and the next two settings determine the amount of working time that 
MindView allocates to a task when you specify a duration in days, weeks or months. 

When you enter durations, MindView always converts them to minutes and that is the number it stores 
behind the scenes. MindView uses standard values to convert hours to minutes: one hour equals 60 minutes. 
However when you specify a duration in days, weeks or months (provided you have not specified "e" for 
elapsed) MindView uses the number of working hours per day, week or month defined here to calculate the 
corresponding number of minutes to store. 

From the working days and working times allowed by the project calendar it then works out the number of 
days required for the task and calculate its end date. For this reason, it is a good idea to make sure that the 
values you choose here match the working time allowed by the calendar as closely as possible, as it will 
make the entries in the Duration column of the Gantt Outline match the lengths of the task bars more 
closely. 
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Redefining these settings after having entered tasks does not alter their real durations (since they are stored 
in minutes) or the lengths of the task bars (since the amount of work has not changed), but the numbers for 
days, weeks and months in the Duration column will change. 

For more information about durations, start dates and end dates, see "Entering and editing tasks". 

Hours per week: Defines the number of working hours in a standard working week, for example 40. You can 
enter the value as a decimal number. MindView uses this value to calculate task durations that are specified in 
weeks. 

Days per month: Defines the number of working days in a standard working month, for example 20. Enter a 
whole number value. MindView uses this value to calculate task durations that are specified in months. 

Modifying the calendars 
 Click Project Calendar to access the calendar itself (or Default Calendar if viewing the default calendar 

settings). 

 

Working days are shown in white and non-working days are shown in grey. 

• In the project calendar, a red dot on a particular day indicate that the working hours for that day are different 
from those set in the default calendar.  

• In the default calendar, a red dot indicates that you have made a change to the working hours of that day 
since opening the dialog. These red dots disappear as soon as you save the default calendar. 

Note that the distribution of red dots in your project calendars may change if you edit the default calendar. This 
does not mean that your project plans have changed, only that the differences between the default and project 
calendars have changed. 

 To see the working hours for a particular day, select the day by clicking it. 

The working hours appear in the boxes on the right of the calendar grid. 

Displaying a particular day 
If the day you want to examine is not currently visible on the calendar grid, you can browse to it in several ways 
by using the calendar header: 
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• Click the arrows placed on each side of the header until the correct month and year appear. 

• Click the year on the header and use the up and down arrows to reach the correct year. 

• Click the month name on the header and choose the correct month in the drop-down list. 

Selecting one or more days 
To change the working times defined by the calendar, start by selecting the day or days to be modified: 

• To select one day only, just click it. 

• To select several contiguous days, select the first day and drag the mouse until the last day in the range. You 
can also select the first day, press the Shift key and click the last day in the range. 

• To select several non-contiguous days, select the first day and press the Ctrl key while selecting all the other 
days. 

• To select all Fridays (for example), click F in the column header. This selection applies to the whole 
duration of the project, not just the displayed month. You can select several columns by Shift- or Ctrl-
clicking them. 

Editing one or more days 
 Select one or more days as described above. 

If you select several days with different working hours, the boxes on the right show the working hours of the 
earliest day in the range. 

You can now make changes: 

• To change the working hours, enter new values in the boxes on the right. 

• To make the day(s) non-working, click Clear to delete the time entries from the boxes. 

• To reset the working times to the default calendar values, select "Set selected days as default". 

Saving and restoring defaults 

• To save the current project calendar as the new default calendar, open the Project Calendar dialog and click 
Save as Default. Your existing default calendar will be overwritten. 

• To return all project calendar settings to those of the default calendar, open the Project Calendar dialog and 
click Restore Default. 

You can return the default calendar to the original MindView settings as follows: 

 Open the Default Calendar dialog (click the MindView Button, click MindView Options and open the 
Calendar panel). 

 Click Import Calendar. 

 Browse to: 

C:\Program Files\MatchWare\MindView 3.0 BE\Resources\Gantt 

 Select the file defaultcal.xml. 

Your current default calendar is overwritten with the original MindView default calendar. 

 Click Save from the Default Calendar dialog to save the restored default calendar. 

Importing and exporting calendars 
You can also import calendars from other projects or export your calendars for use by colleagues. 

• To import a previously saved MindView calendar, click Import Calendar. Existing settings will be 
overwritten. 
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 You can also import the calendar of an existing Microsoft Project document by exporting that document to XML 
from Microsoft Project, then choosing the exported XML document in this dialog. 

• To export your current calendar for use on a different project for instance, click Export Calendar.  

 When exported, the MindView calendar is saved the MindView XML format. 

Entering and editing tasks 

 When working in the Gantt view, you can use the Gantt Outline to work on tasks exactly as in the main 
Outline view. You can for instance: 

• Add, delete, move, cut, copy and paste tasks as in the main Outline view. 

• Add branch pictures, icons, text notes and pop-up comments to any of your tasks. 

• Attach objects such as text files, video files, sound files, hyperlinks and so on.  

• Use the Numbering Scheme icon  of the Gantt Tools tab or Home tab to apply sequential numbers to the 
tasks and choose between various numbering styles. 

• Use the Detail Level icons  of the View tab to determine how many levels of tasks should be visible. 

• Use the Apply Branch Focus icon  of the View tab to restrict the display to a particular task and click 
the Clear Branch Focus icon  to view the entire project plan again. 

• Use the Filter icon  of the View tab to hide all the tasks that do not meet the filter criteria you have 
defined. 

For details on how to perform these operations, see "Using the Outline view". 

 You can also create the tasks of your project plan in other ways: 

• By importing a task list from Microsoft Outlook and converting it to a project plan. 

For more information on the import procedure, see "Importing from Microsoft Outlook". 

• By importing a project from Microsoft Project, either directly or via the Microsoft Project XML format. 

For more information, see "Importing from Microsoft Project" and "Importing from XML". 

• By copying a list of tasks from an external application such as Microsoft Excel, Microsoft Word or 
Microsoft Project and pasting it into the Gantt Outline. 

Entering a task duration 
By default, tasks have a duration of one day and are marked with a question mark, to indicate that the duration is 
only an estimate. As soon as you edit the duration, the question mark disappears. You can modify the duration of 
a task in various ways: 

• On the Gantt chart, position the cursor at the end of the task bar until it changes to , and drag the end of 
the bar to the right or left. 

• In the Gantt Outline, type a number of days in the appropriate cell in the Duration column. You can follow 
the number with letter(s) to indicate time units other than days: m (minutes), h (hours), d (days, the default), 
w (weeks), mo (months). You can enter the letter e before the time unit (for instance "3ed") to indicate 
elapsed time, in which case the task will last exactly the time specified, regardless of what the project 
calendar defines as working and non-working time. 

You can indicate that a duration is still an estimate by adding a question mark. 
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• Select the task and choose View | Task Information  on the Gantt Tools tab to open its Task Informatio
ialog. Enter a value in the Duration field as described above. 

n 
d

 You can also open the Task Information dialog by pressing Shift + F2 or by double-clicking the task bar on the 
Gantt chart. 

• Select the task and, in the Task/Timeline Info panel, enter a value in the Duration field as described above.

The duration of the task is now indicated on the Gantt chart by a bar extending from its start date to its end date.

Advanced notes: When you enter durations, for example "4 hours", MindView converts them to minutes and 
that is the number it stores behind the scenes. MindView uses standard values to convert hours to mi
hour equals 60 minutes. However if you specify a duration in days, weeks or months (provided you have not 
specified "e" 

 

 

nutes: one 

for elapsed) MindView uses the number of working hours per day, week or month set in the Project 

 

s, any task bar spanning a week-end is automatically 
evant 

e 
 convert the 

hs. Consequently if you redefine the number of working 
numbers in the Duration column will change, but the 

e length of the bars, will remain the same. 

Calendar Settings dialog (choose Project | Project Calendar on the Gantt Tools tab), to calculate the 
corresponding number of minutes to store. See "Defining calendar settings" for more information about these
settings. 

While durations determine the amount of working time that you allocate to a task, the length of the task bar 
indicates how long the task will actually take. These are not necessarily the same. For example, because 
MindView does not schedule work on non-working day
lengthened to take account of this. Similarly, if your working day is specified as having 8 hours, but the rel
section of the calendar restricts work to only 4 hours a day, a task with a duration of one day (8 hours) will 
actually take two days (4 hours each day) to complete. 

The labels shown in the Duration column, for example "2 days", are calculated from the stored number of 
minutes for each task. For durations initially specified in days, weeks or months MindView uses once more th
number of working hours per day, week or month set in the Project Calendar Settings dialog to
stored number of minutes back to days, weeks or mont
hours in a day, week or month set in that dialog, the 
underlying number of minutes, and consequently th

Specifying start and end dates 

  Although you might be tempted to enter specific start and end dates for your tasks, it is not recomm
unless you understand the implications of doing so. A better practice is to link tasks so that they follow on 
logically from one another, and let MindView calculate the dates automatically. In MindView and similar project 
management applications, entering an explicit start date is equivalent to setting a 'Start No Earlier Than' 
constraint. Similarly, entering a specific end date is equivalent to setting a 'Fini

ended 

sh No Earlier Than' constraint. 
 tasks must indeed obey these constraints, 
 your project plan. For more information 

Info panel, select a date in the Start date field. 

• Sel

Although applying constraints in this way is perfectly legitimate if your
it is best to avoid them wherever possible as they limit the flexibility of
on the different types of constraints and their effects, see "Using Constraints". 

If you must enter a specific start date, you can do so in different ways: 

• Move the cursor to the center of the task bar and drag the bar to the new position. 

• Click the Start entry of the task in the Gantt Outline and type or select a date. 

• Select the task. On the Task/Timeline 

ect the task and choose View | Task Information  on the Gantt Tools tab to open its Task Informati
dialog. Selec

on 
t a date in the Start field. 

 You can also open the Task Information dialog by pressing Shift + F2 or by double-clicking the task bar on the 

 Info panel, select a date in the End date field. 

Gantt chart. 

You can enter an end date in the following ways: 

• Click the End entry of the task in the Gantt Outline and type or select a date. 

• Select the task. On the Task/Timeline
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Select the task and choose View | Task Information  on th  Gantt Tools tab to open its Task Information 
dialog. Select a date in the End field. 

• e

 When you enter a specific start or end date, a constraint icon  appears next to the task name in the Gantt 
int. 

To remove the constraint set by entering an explicit start or end date: 

 Open the Task Information dialog and remove the tick from the Constraint date field. 

Outline. Hovering this icon with the mouse displays a tooltip with details about the constra

 

Grouping tasks 
You can group tasks together by creating sub-tasks under a parent task, called a summary task. This allows you 
to divide your project into logical units, each with its own collection of tasks. The start dates, end dates and 
durations of summary tasks are calculated automatically from their sub-tasks. 

A summary task is indicated on the Gantt chart by a solid bar extending from the beginning of the first sub-task 
to the end of the last one. 

 

If you add sub-tasks to a task that already has a duration assigned to it, this assigned duration is automatically 
replaced by the new duration obtained from the sub-tasks. Once a task becomes a summary task, it is no longer 

rdless 
of whether work is actually happening on any given day. The figure is calculated from the available working 

dar settings". 

onverted automatically to a summary task when you add its first sub-task. 

s in the 

 the left mouse button pressed, drag the task to the required location. 

 of 
the mouse button. 

l right arrow 

possible to specify its start date, end date or duration manually. If you change the timing of a sub-task, the 
summary task duration is automatically adjusted to reflect the change. 

The duration of a summary task is the number of available working days between its start and its end, rega

hours between the two dates, as specified on the project calendar, and the 'Hours per day' figure set in the Project 
Calendar Settings dialog. For more information about calendar settings, see "Defining calen

Sub-tasks are sub-branches, and you create them in the Gantt view in the same way as in any other view. The 
parent task is c

You can convert an existing task to a sub-task or move it to a different level in the task hierarchy just a
Outline view: 

 Select the task you want to move to a different location by clicking it with the left mouse button. 

 While keeping

The mouse pointer changes to a different shape to show you where the task will be inserted when you let go

• A smal  indicates that the task will become a sub-task of the task containing the arrow. 

• A small up arrow  indicates that the task will be inserted above the task containing the arrow, at the sam
level. 

e 

• A small down arrow  indicates that the task will be inserted below the task containing the arrow, at the 
same level. 

 Release the mouse button to insert the task at the required location. 

• You can also click the Indent icon  of the Gantt Tools tab to move the selected task or tasks to the 
level down

next 
 in the hierarchy, so that they become sub-tasks of the preceding task in the Gantt Outline. 

• Conversely, clicking the Outdent icon  moves the selected task or tasks to the next level up in the 
hierarchy. 
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The root of the Mind Map, the first task in the Gantt Outline, is a summary task extending across the whole of 
the project plan. The end of this summary task bar indicates the current end date of the project. 

You can expand and collapse summary ta
details. Collapsing summary tasks is a us

sks just as in the main Outline view. See "Using the Outline view" for 
eful way of making large project plans easier to view. 

Assigning resources 

 MindView allows you to assign resources to your task lists and project plans. Resources can be people, 
ll 

h task. Note that in MindView, assigning resources to a task 
ether you are working on a simple task list or a project plan. 

y time afterwards, even if you have not 
u assign to a task by typing its name is automatically added to the 

hat you don't have to type it next time. 

rces field, separating them with 
semi-colons. To remove a resource, simply delete it from the field. 

: 

• Click the Resources button 

materials, equipment, budget amounts, or anything else. Typically, you might enter the names of people who wi
work on the tasks as resources. 

You can add as many resources as you want to eac
has no effect on the task duration, regardless of wh

Assigning resources to tasks 
You can assign resources to tasks when you create the task or at an
created a global resources list. Any resource yo
global resources list so t

You can assign resources to a task as follows: 

 Select the task. 

 In the Task/Timeline Info panel, type the resource names in the Resou

You can also assign resources to a task from its Task Information dialog

 to the right of the Resources field, or 

• Press Shift + F2. 

 

 Click an empty row in the Resources dialog and enter the resource by typing it or by selecting it from the 
list. 
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 To de-assign a resource, select it and click Remove. Note that this only de-assign the resource from the task, 
it does not remove the resource name from the global resources list. 

 Where possible, it is better to select rather than type resource names. That way you don't run the risk of adding wrongly 
spelled entries to the global resources list. 

If you are working on a project plan in the Gantt view, you can also enter resources in other ways: 

n Resources • Select the task and choose Tasks | Assig  on the Gantt Tools tab. 

• Select the task and choose View | Task Information  on the Gantt Tools tab. Click the Resources tab i
the Task Information dialog that opens. 

n 

 You can also open the Task Information dialog by pressing Shift + F2 or by double-clicking the task bar on
Gantt chart. 

 the 

f the Gantt Outline. Type the resource name(s), 

rces to assign to the various tasks. 

s saved whenever you save the file. Each task 

ask Information dialog of a task and click the Project Resources button. 

The Project Resources dialog lists all the resources that are currently assigned to tasks, as well as any that you 
import or type in directly. 

• Click the Resources cell of the task at the far right o
separating them with semi-colons. 

Setting up a global resources list 
Although MindView lets you define the resources as you need them, it is usually quicker to start by setting up a 
global resources list from which you can then select resou

The global resources list associated with a task list or project plan i
list or project plan can have its own global resources list. 

You can access the global list of available resources in two ways: 

• Open the T

• If you are working on a project plan in the Gantt view, choose Project | Project Resources on the Gantt 
Tools tab. 

  

This dialog lets you perform different operations: 

 To type in a new resource, click the first empty field and enter the resource name. 

 To delete one or more resources, select them and click Delete. 
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 Use the Shift key to select contiguous resources and the Ctrl key to select non-contiguous resources. 

 To import one or more resources from your Microsoft Outlook Address Book, click Address Book, select 
the contact names you want to add as resources in the Outlook dialog, click the Add button and click OK. 

 To import one or more resources from the Windows Active Directory database, click Active Directory. 
the dialog box that opens, click the Advanced button, then the Find Now button. Select the user(s) yo
to add as resources in the bottom

In 
u want 

 part of the dialog, and click OK. The Active Directory is a centralized 

 To export the global resources list for use in other documents or for sharing with colleagues, click Export, 
and

database maintained by Windows to store information relating to an organization's network (such as 
resources, services and users). 

 choose a folder and file name for your exported list. 

 When exported, the global resources list is saved in the MindView XML format. 

 To import a previously exported global resources list, click Import and select the required list. 

 You can also import the resources list of an existing Microsoft Project document by exporting that document to 
 Project, then choosing the exported XML document in this dialog. XML from Microsoft

Using links 

  Project plans normally require tasks to be performed in a specific order. For instance, a publication 
must be written and proofread before it can be printed. To achieve this, MindView lets you link tasks so that they
depend on each other. B

 
y default, tasks are linked in a 'Finish to Start' relationship (dependency), which means 

This is represented on the Gantt chart by lines with arrowheads joining each task to its successor. The arrowhead 
indicates the direction of the link: it goes from the predecessor to the successor. 

that the first task you select (the predecessor task) must end before the next task you select (the successor task) 
can start, and so on. 

 

A task can have more than one predecessor. In this case its start date is determined by the predecessor link that 
gives it the latest start date. As dates and times change during the course of the project, the predecessor link that 
determines the start date of the task may also change. 

 

Similarly a task can have several successors. In this case the task determines the start date of all its successor 
tasks. 

 

When you are scheduling a project plan from its start date (see "Defining the global project settings"), 

werful: 
tion of one or more tasks, add a task or remove a task from a chain of linked tasks, and 
ated automatically so as to maintain the task dependencies you have defined. 

MindView calculates the end date of the project automatically, on the basis of the task durations, the task 
dependencies and the project calendar. 

The possibility of linking tasks in this way is what makes project management software particularly po
you can change the dura
all the dates are recalcul
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Linking tasks 
You can link tasks in the following ways: 

• Sel rder you want them to be linked, by Shift-clicking them (for contiguous ect the tasks to be linked, in the o
tasks) or Ctrl-clicking them (for non-contiguous tasks), then click the Link icon  on the Gantt Tools tab. 

 You can also just press Ctrl + F2. 

• Place the pointer on the bar of the predecessor task. When it changes to an icon with four arrows, drag the 
pointer downwards (or upwards) until a line emerges from the task bar and a link icon appears under the 
pointer. Continue dragging until the line reaches the bar of the successor task and release the mouse button. 

 

• Select the task to be linked to. Click its Predecessors cell in the Gantt Outline and type the entry number(s) 
of the predecessor task(s). Separate multiple numbers by semi-colons. 

• Select the task to be linked to and choose Task Information  on the Gantt Tools tab to open its Task 
Information dialog. Click the Predecessors tab and select the predecessor task(s). 

 You can also open the Task In
Gantt chart. 

formation dialog by pressing Shift + F2 or by double-clicking the task bar on the 

 All these methods create the default task relationship, namely 'Finish to Start'. See below to find out how to 
create other types of relationships. 

In the example below, the proofreading task (successor) has been linked to the writing task (predecessor). The 
proofreading task cannot start before the writing ends. If the writing task is delayed or takes longer than planned, 
the start date of the proofreading task is recalculated automatically so that the task relationship is always 
maintained. 

 

You can link summary tasks in the same way as other tasks, but not to one of their own sub-tasks. Linking a 
summary task to another summary task has the same effect as linking its last sub-task to all of the sub-tasks in 
the other summary task. To make your project plan easy to read, it is usually best to link summary tasks only to 
summary tasks and sub-tasks to sub-tasks (within the same summary task), like this: 

 

Alternatively you may prefer to restrict linking to regular tasks. Links from summary tasks to regular tasks tend 
to confuse the display. 

 A summary task can only be linked to its predecessors with a 'Finish to Start' or 'Start to Start' relationship. 

You can

• Select the tasks by Shift- or Ctrl-clicking them, then click the Unlink icon 

Unlinking tasks 
 unlink tasks in the following ways: 

 on the Gantt Tools tab. 
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 You can also just press Ctrl + Shift + F2. 

• On the Gantt chart, right-click the link you want to remove and choose Edit Link in its local menu. This 
opens the Task Information dialog. Select the predecessor task you want to remove and click Delete. 

• Select the task whose predecessors you want to remove. Click its Predecessors cell in the Gantt Outline 
delete the number(s) of the predecessor(s) you want to remove. 

• Select the task whose predecessors

and 

 you want to remove and choose Task Information  on the Gantt 
 dialog. Click the Predecessors tab, select each predecessor task you 

lier 
art' link, this either introduces an overlap (lead time), 

he 

e to make the 
nked, 

choose Task Information 

Tools tab to open its Task Information
want to remove and click Delete. 

Defining lead or lag time 
By adding a lead or lag time you can extend a link backwards or forwards so that the successor task starts ear
or later than it otherwise would. For a default 'Finish to St
so that the successor task starts before its predecessor ends, or it introduces a delay (lag time) that makes t
successor task start some time after its predecessor ends. 

When planning the production of a marketing brochure for instance, you could use lead tim
creation of artwork start a few days before the writing phase is over. The two tasks are however still li
which means that a delay of the writing phase will also delay the creation of the artwork. 

 Select the successor task and  to open its Task Information dialog. 

e (a 
negative value indicates a lead time (an overlap). You can follow the number with letter(s), for 

 

In the following example, we start with three linked tasks (to save space, the Start and End columns are not 
shown): 

 Click the Predecessors tab. 

 In the Lag column for the task, enter the appropriate lead or lag time. A positive value indicates a lag tim
delay); a 
example w for weeks, as described in the paragraph "Entering a task duration" in "Entering and editing 
tasks". 

You can also enter percentage values, for example if you enter "-25%" the task will start 75% of the way
through the predecessor task. Note that percentages relate to the duration of the predecessor task. 

 

Notice that the Predecessors column shows the number of each task's predecessor. Experience shows that we can 
actually start applying undercoat when surface preparation is three quarters complete, in other words when only 
25% remains to be done. To give the desired overlap (lead time) we enter a lag of -25%, as described above: 

 

Because surface preparation has currently been allocated 4 working days, the undercoat task starts after the third 

Now we want to allow a 1-day gap after the undercoat task to ensure that the undercoat is fully dry before the top 
coat is applied. To give the desired delay we enter a lag of 1 day, as described above: 

working day. As usual, no work is scheduled during non-working days. Notice that the Predecessors column 
now includes the type of link (FS, or 'Finish to Start'), and the amount of lead time (-25%). 
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If we now have to change the duration of the surface preparation task to 8 days, everything moves out. However, 
the 25% overlap (which now represents 2 working days) and the 1-day delay are preserved: 

 

Although the example above shows tasks linked by the default 'Finish to Start' relationship, you can apply lead 
or lag time to any type of task relationship. 

  Moving linked bars by dragging does not set lead or lag times, but instead sets constraints which override 
the linking. See "Using constraints" for more information. 

Using other task relationships 
MindView supports four different relationships (dependencies) between tasks: 

• Finish to Start (FS) - the default: The task cannot start before its predecessor ends, although it may start 
later. This is the most common type of relationship and the only link you can create by clicking the Link 
icon , as described above. Typically the successor starts as soon as the predecessor is complete. You can 
introduce an overlap or delay by using lead and lag times, but still, if the end date of the predecessor task 
moves, so will the start date of the successor. 

• Start to Start (SS): The task cannot start until the predecessor starts, although it may start later. This can be 
useful if you have a task whose start date depends on the start date of another task.  

• Finish to Finish (FF): The task cannot end before the predecessor ends, although it may end later.  

• Start to Finish (SF): The task cannot end before the predecessor starts, although it may end later. This task 
relationship is rarely used. 

To change the relationship between two tasks: 

 Select the successor task and choose Task Information  to open its Task Information dialog. 

 You can also just double-click the link between the predecessor and the successor task on the Gantt chart. 

 Select the predecessor on the Predecessors tab. 

 In the Type column, select the new relationship type. 
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Example 
The following project plan for the preparation of a publication illustrates all these kinds of relationships. 

 

In this example: 

• The writing task follows on directly from the planning task. If the end date of planning changes, so will the 
start of writing. This is the normal Finish to Start relationship. 

• The editing task starts some way through the writing task. The writers and the editors work together as a 
team until the text is complete. Their tasks effectively end at the same time. If the end date of writing 
changes, so will the end date of editing. This is a Finish to Finish relationship. 

• The creation of artwork depends on the start of writing. In this case a lag has been introduced so that it 
doesn't start exactly when writing starts. Even so, if the start of writing changes, so will the start of artwork 
creation. This is a Start to Start relationship. 

• The final changes task depends on the end of artwork creation, but an overlap is included so that it actually 
begins two working days before the end date of artwork creation. If artwork creation is delayed, so will be 
the start of final changes. This is the normal Finish to Start relationship. 

• Printing starts after final changes are complete. This is also a Finish to Start relationship.  

• The transferring of paper from the warehouse to the printers must be complete in order for printing to start, 
but is not related to any of the preceding tasks. The printers have limited storage capacity and do not want 
the paper to arrive until it is needed, so the start of printing drives the delivery of paper. If the start of 
printing changes for some reason, so will the end date for getting paper to the printers. This is a Start to 
Finish relationship. 

Here each task has a single predecessor, the simplest arrangement. However, a task can have several 
predecessors. In such situations you will need to think carefully about possible undesirable consequences. For 
example, if you added another predecessor to the "Paper to printers" task above, it would be possible for that 
predecessor to push out "Paper to printers" so that its end date was later than the start of printing. 

Using constraints 
Constraints define the degree of flexibility available to MindView when scheduling or rescheduling a task by 
imposing restrictions on its start or end date. 

MindView supports 8 types of task constraints, offering different degrees of flexibility. 

Constraint types 
Two "constraints" are actually so flexible that they are not generally regarded as constraints at all: 

• As Soon As Possible (ASAP): This is the default constraint when you schedule your project from its start 
date, as is normally the case (see "Defining the global project settings"). You should try to keep this default 
whenever possible as it gives MindView the most scheduling flexibility. If you apply this constraint to an 
unlinked task, the task will be scheduled to start at the project start date. If you apply it to a linked task, it 
will start as soon as the dependencies with its predecessor tasks will allow. 
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• As Late As Possible (ALAP): This is the default constraint when you schedule your project from its end 
date. If you apply this constraint to an unlinked task, the task will be scheduled so that its end date coincides 
with the end date of the overall project. If you apply it to a task linked to a successor task, the task will be 
scheduled to end when the successor needs to start. On the whole, you should avoid this constraint as it does 
not leave any slack time to deal with possible problems. Any delay on the task is likely to impact the overall 
end date. 

The following constraints all restrict MindView's flexibility when scheduling tasks. Although you might be 
tempted to use them if you are new to project management, you need to make sure you understand the 
implications. Keeping their use to a minimum (especially the last two) will allow you to take full advantage of 
MindView's automatic scheduling possibilities. 

• Start No Earlier Than (SNET)  : This means that the task, whether linked or not, may not start before 
the given date. However, MindView still has the flexibility to start the task later than the given date. 

  If you change a task's start date, for instance by typing a new date in the Gantt Outline or by moving its 
task bar on the Gantt chart, this constraint is automatically applied. 

  If you drag a linked task backwards, a SNET constraint is set for the start date corresponding to the 
new position of the task bar, but the bar immediately moves back to its original position. This is because the 
start date determined by the link comes later than the SNET date. The SNET date is therefore applied, but 
does not change the original scheduling of the task. 
 

• Start No Later Than (SNLT)  : This means that the task, whether linked or not, may not start later than 
the given date. However, MindView still has the flexibility to start the task earlier than the given date. 

  When you are scheduling your project from its end date, changing a task's start date automatically 
applies this constraint. 
 

• Finish No Earlier Than (FNET)  : This means that the task, whether linked or not, may not end before 
the given date. However, MindView still has the flexibility to end the task later than the given date. 

  If you change a task's end date, this constraint is automatically applied. 
 

• Finish No Later Than (FNLT)  : This means that the task, whether linked or not, may not end later than 
the given date. However, MindView still has the flexibility to end the task earlier than the given date. 

  When you are scheduling your project from its end date, changing a task's end date or moving its task 
bar on the Gantt chart automatically applies this constraint. 
 

• Must Start On (MSO)  : This rigid constraint means that the task, whether linked or not, must start on 
the given date. Even if the preceding task is completed earlier, MindView cannot pull in the constrained task 
to take advantage of the time gained. 
 

• Must Finish On (MFO)  : This rigid constraint means that the task, whether linked or not, must end on 
the given date. As above, even if the preceding task is completed earlier, MindView cannot pull in the 
constrained task to take advantage of the time gained. 

 

When you apply one of these constraints to a task, a constraint icon appears next to its name in the Gantt Outline. 
Hovering this icon with the mouse displays a tooltip with details about the constraint. 
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 If you decide to apply one of these constraints to a task, it is good practice to attach a note or a comment to the task to 
explain why you did so. If the constraint causes scheduling conflicts later on as your project evolves, you will be able to refer 
to the note to decide whether to keep the constraint, change it or remove it altogether. Such notes also allow you to 
distinguish easily between the tasks you have constrained yourself deliberately and the tasks you may have constrained 
inadvertently by moving their task bar or editing their start or end date manually. 

You can sometimes avoid using constraints by setting deadlines instead (see "Setting deadlines" in the topic 
"Enhancing a project plan"). If you have an important date to meet, it is usually better to set a deadline on the 
task rather than a constraint such as 'Must Finish On'. Not only this type of constraint restricts MindView's 
scheduling flexibility, but it may in fact increase the likelihood of missing the deadline, as the example below 
shows.  

  The effect of a constraint is not always obvious when you schedule your project plan from its end date, so 
take care to check that it does give the result you want. 

Example 
The following example shows some tasks in the preparation of a brochure for a mail shot. The mail shot is 
scheduled for September 10th. The tasks are linked, but we have set a 'Must Finish On' constraint on the printing 
task for September 7th, the latest date that will allow the mailing to go ahead on the following Monday, 
September 10th. The constraint, as usual, overrides the link. By setting a 'Must Finish On' constraint for 
September 7th, we have effectively moved the task out so that it ends exactly on September 7th, regardless of 
whether it could have been completed earlier or not. 

 

The problem with this is that if the printing task takes longer than expected, the mailing date will be missed. It 
would be much better to take advantage of the unused time after the end of the corrections task to get started 
with printing. However, we still need to keep an eye on the September 7th deadline. To do this, we remove the 
constraint from the printing task, so that the link will determine its start date, and add a deadline marker instead. 

 

Now there is a useful three day gap between the end of printing and the deadline, and the deadline is clearly 
indicated. The printing task is now much less likely to appear on the critical path, and the deadline indicator will 
warn us if the task moves past its deadline. 

Interaction between task dependency links and constraints 
Constraints combine with task dependency links to affect the timing of tasks. In some cases, applying a 
constraint to a task in addition to a task relationship may create a scheduling conflict. When such a conflict 
arises, the constraint always takes precedence over the task dependency.  
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Let us consider the example below. Here the "Print" task is linked to the "Final changes" task with the default 
'Finish to Start' relationship. The "Final changes" task ends on Oct 1st. In normal circumstances, this would 
mean that the "Print" task cannot start before Oct 2nd. However, because you imperatively need the printed 
materials on Sept 28th for a training session, you have set a 'Must Finish On' constraint on the "Print" task for 
Sept 28th, as evidenced by the constraint indicator. Since the constraint set on a task always overrides any 
relationship it may have with other tasks, the start date of the "Print" task has been rescheduled automatically to 
end on Sept 28th. 

 

In this case the constraint has led to an illogical relationship with the predecessor task: printing is now scheduled 
to start before final changes are complete. Note that MindView conveniently flags this as a possible problem 
using the  icon, which shows that a link has been overridden by a constraint. 

If you later decide to remove the constraint, for instance because the training session has been postponed, the 
task dependency link is enforced again, as shown here: 

 

For more information about how to detect and solve potential scheduling conflicts, see "Reviewing a project 
plan". 

Setting a constraint 
You can apply a constraint to a task as follows: 

 Select the task and choose Task Information  to open its Task Information dialog. 

 Select the constraint type. For constraints other than 'As Soon as Possible' or 'As Late As Possible', you also 
need to set the constraint date required. 

 

As mentioned above, changing a task's start date by editing it in the Gantt Outline or moving its task bar on the 
Gantt chart applies a 'Start No Earlier Than' constraint automatically (assuming you are scheduling from the 
project start date). Changing a task's end date applies a 'Finish No Earlier Than' constraint. 

When scheduling from the end, changing a task's start date applies a 'Start No Later Than' constraint. Changing a 
task's end date applies a 'Finish No Later Than' constraint. 

 To remove a rigid constraint, select 'As Soon as Possible' in the Task Information dialog (or 'As Late As 
Possible' if you are scheduling from the end). 

Enhancing a project plan 
There are various things you can do to make your project plan easier to use. For example: 

• You can add explanatory notes to tasks. This is especially useful for tasks that have constraints. Constraints 
override links and can lead to illogicalities or schedule conflicts in the plan, so you will need to keep an eye 
on them. 

• You can highlight the critical path in order to see at a glance the tasks that are currently directly affecting 
your project end date. 

• You can set milestones or deadlines to mark key dates. 

• You can give tasks priorities. 
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• You can show a percentage completion for any task, visible on the task bar. 

• You can customize the display of the project plan on the Gantt chart. 

Adding notes 
You can add notes and comments to any task, just as in all the other MindView views. See "Inserting text notes" 
and "Inserting comments". 

Viewing the critical path 
In a project plan, the critical path corresponds to the tasks or chain of linked tasks that cannot be delayed without 
delaying the entire project. A task lies on the critical path if a change to its start date or duration affects the end 
date of the project (or the start date if you are scheduling from the end of the project). 

Keeping a close eye on the status of your critical tasks at any time is therefore key to good project management. 
If the overall project duration is too long, the only way to make it shorter and bring in its end date is to shorten 
the critical path.  

 To toggle the critical path on or off, click Show Critical Path  on the Gantt Tools tab. Tasks on the 
critical path are highlighted in red. 

 You can change the color used to highlight the critical tasks from the Properties dialog. See "View properties: General 
tab" for more information. 

 

Setting milestones 
A milestone is a task with zero duration. It appears on the Gantt chart as a solid diamond. Milestones are 
generally used to indicate important dates on the project plan, often key events or goals. For example, you might 
use milestones to mark desired completion dates, or project review meetings. 

 

As with any task, a milestone can be linked to other tasks. However, milestones are generally used as fixed 
markers and are therefore not normally linked. 

To enter a milestone: 

 Create a task and give it a duration of 0. 

To convert a task to a milestone: 

• Select the task and give it a duration of zero, or 

• Select the task and choose Task Information  on the Gantt Tools tab to open its Task Information 
dialog. Check the option 'Set task as milestone'. 

To convert a milestone to a task: 

 Select the milestone and give it a non-zero duration. 

Setting deadlines 
You can add a deadline marker to any task. This does not affect any of MindView's Gantt calculations, but 
places a visible marker on the Gantt chart as a reminder. 
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If the task end date moves past the deadline, a missed deadline icon appears in the Indicators column of the Gantt 
Outline. 

 

To add a deadline to a task: 

 Select the task and choose Task Information  to open its Task Information dialog. In the Deadline field, 
select the deadline date.  

To remove a deadline from a task, you open the Task Information dialog again and remove the check mark from 
the Deadline field. 

Assigning priorities 
You can assign a priority to a task in the following ways: 

• Select the task and choose Task Information  to open its Task Information dialog. Enter a priority 
number in the Priority field. 

• Select the task. On the Task/Timeline Info panel, enter a priority number in the Priority field. 

Although priorities can range from 0 to 1000, you can use any convenient scale, for example 1 (highest priority) 
to 10 (lowest priority). 

Setting completion values 
You can indicate the progress that has been made towards completing a task by entering a % completion value. 
A thick line on the task bar indicates progress. 

 

You can enter or modify a % completion value for a task in the following ways: 

• Move the cursor to the left of the task bar (or to the right end of the completion line if the task already has a 

completion value) until it changes to  and drag rightwards or leftwards until the appropriate completion 
position is reached. 

• Select the task and choose Task Information  to open its Task Information dialog. Select a value in the 
Completion (%) field. 

• Select the task. On the Task/Timeline Info panel, select a value in the Completion (%) field. 

Customizing the Gantt chart display 
For more information about this, refer to the paragraph "Customizing the Gantt chart" in the topic "Using the 
Gantt view". 

Reviewing a project plan 
It's a good idea to review your project plan regularly in order to locate conflicts or other problems. You can then 
make appropriate changes to remove them. 

Checking deadlines 
Have any tasks overshot their deadline? If so, you will see red warning markers in the Indicators column: 

 

To overcome the problem you may need to reschedule tasks. Alternatively, if the overshoot is acceptable, you 
can change the deadline by opening the Task Information dialog (double-click the task bar) and assigning a new 
date. To remove the deadline altogether, remove the check mark from the Deadline field. 
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Checking the project end date 
Is the project on course? Check that the end date of your project looks reasonable. 

When you are scheduling a project plan from its start date (see "Defining the global project settings"), 
MindView calculates the end date of the project automatically, on the basis of the task durations, the task 
dependencies and the project calendar. 

You can check the project end date in several ways: 

• View the end date of the first task in the project plan, either in the Gantt Outline or in the Gantt chart. This is 
the root summary task that covers the whole project. 

 

• View the end date of the last task in the project plan, either in the Gantt Outline or in the Gantt chart. 

 If the task bar of the last task is not visible in the Gantt chart, select the task in the Gantt Outline and click Go to 
Selected Task  on the Gantt Tools tab. 

• Choose Project | Project Information on the Gantt Tools tab to view the start and end date of the overall 
project. 

If the end date is too late, and the suggestions described in the following paragraphs cannot help, you may need 
to apply more resources to one or more tasks. For example, if you assign two people rather than one to a task, 
you should be able to halve its duration. 

Checking the project start date 
If unconstrained tasks start later than you expect them to, check the project start date (choose Project | Project 
Information on the Gantt Tools tab). 

In the following example, Task1 and Task2 actually start on the project start date, as they should. However, 
Task3 has a 'Must Start On' constraint that is earlier than the project start date. This effectively extends the 
project backwards before its official start date. This also happens when a task is given a lead time that pushes its 
start date before the project start date. 

The project start date is nevertheless maintained, and any new task you add is scheduled to start on the official 
start date. 

 

Checking the dependencies 
Are all the links between tasks necessary? By unlinking tasks that don't actually depend on each other, you will 
make use of all the slack time available, thereby shortening your schedule and maximizing its flexibility. 

Alternatively, consider whether some tasks could overlap each other to reduce the overall duration of the project. 
If so, assign appropriate lead times (see "Defining lead or lag time" in the topic "Using links"). Another 
possibility is to redefine some of your 'Finish to Start' relationships to either 'Finish to Finish' or 'Start to Start' if 
the logic of your schedule allows it. 
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Checking the constraints 
Are the constraints working as you expect? Look in the Indicators column of the Gantt Outline for tasks that 
have constraint markers  . If you have been adding an explanatory note to every constraint you set, read the 
notes to check that your intentions are still being met. And look for tasks that have a constraint but no note: these 
may have been created inadvertently and be causing trouble. 

Do the tasks that have constraints fall where you expect them to? Do they fit logically with the other tasks 
around them? Check that their start and end dates are neither too early nor too late. 

Look for unexpected overlaps or gaps (see below) between linked tasks: often this is caused by a rigid constraint 
on one or other of the tasks, in which case you should see a constraint marker in the Indicators column. 
However, remember that overlaps and gaps can also be caused by intentional lead or lag times. Displaying the 
Predecessors column in the Gantt Outline will allow you to check for the presence of lead or lag time. 

Because constraints override links, they can introduce schedule conflicts, identified by the icon  in the 
Indicators column. For example, in the following case, final changes are taking longer than expected, but the 
'Must Finish On' constraint set on the printing task prevents it from moving out. The result is that printing is now 
scheduled to begin well before the final changes are complete. 

 

To resolve this problem, assuming that you want to maintain the end date of Sept 28th for printing: 

 Double-click the task bar for the printing task to open its Task Information dialog. 

 Remove the rigid constraint by unchecking the Constraint date checkbox and revert to the default 'As Soon 
As Possible' constraint. The link from "Final changes" will now determine the start of printing. 

 In the Deadline field, select 28/09/07 to put a deadline marker on the printing task so that you are reminded 
of the required completion date. The deadline marker is simply a marker: it does not apply a constraint of 
any sort. Click OK to close the dialog. 

 Shorten the time allowed for final changes (or one of its predecessor tasks), for example by assigning more 
people to the task, so that printing finishes on or before the deadline. 

 

Looking for gaps 
Are there any gaps where work could be allocated but has not been? Gaps can occur when a rigid constraint has 
been applied to a task. The task's predecessor finishes early, leaving a gap (slack time). Because of the 
constraint, the task cannot move backwards to take advantage of the slack. 

 

To overcome problems like this, and make use of the slack time, consider removing the rigid constraint and 
replacing it by the default 'As Soon As Possible'. 
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Checking the critical path 
Are there tasks on the critical path that should not be there? A task is on the critical path if it directly contributes 
to the duration of the project. Removing a task from the critical path will shorten the overall project. 

 Choose Show Critical Path  to highlight in red the tasks that are on the critical path. 

 

In this example, the "Paper to printers" task is on the critical path, but actually it could be done in parallel with 
the other tasks. The printing task is overshooting its deadline (green arrow), hence the red exclamation mark 
indicator. Taking the "Paper to printers" task off the critical path reduces the overall duration of the project and 
meets the deadline for completion of printing: 

 

Redefining a 'Finish to Start' relationship to either a 'Finish to Finish' or a 'Start to Start' relationship is also a 
useful way of taking a task off the critical path. 

Creating reports 

 When working in the Gantt view, you can create a number of HTML reports from your project plan, such 
as Project Summary, Top Level Tasks, Critical Tasks, Tasks in Progress and so on. 

 Click the Gantt Tools tab. 

 Choose Project Reports. 

 Choose a folder for the reports. MindView creates a sub-folder named 'GanttHtmlExport' in the folder you 
specify. 

 Click the link of the report you want to view. 

Exporting a project plan 
All the export methods are available when working on a project plan. The export methods that are particularly 
relevant to project plans are the following: 

Creating reports: Choosing this option in the Gantt Tools tab lets you create a number of different HTML 
reports, such as Top Level Tasks, Critical Tasks, Tasks in Progress and so on. See "Creating reports" for more 
information. 
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Export to HTML: This export method is only available when you are viewing your project plan in a view other 
than the Gantt view. It lets you export your project plan as a standard web site. See "Exporting to HTML" for 
more information. 

Export to Microsoft Outlook: This allows you to export your project plan as a series of tasks in the Outlook 
folder of your choice. For more information, see "Exporting to Microsoft Outlook". 

Export to Microsoft Project: This allows you to take advantage of Microsoft Project's advanced project 
management capabilities to develop your project plan further. See "Exporting to Microsoft Project" for more 
information. 

Export to XML: This method lets you export your project plan in two different XML formats, namely 
MindView XML and Microsoft Project XML. For more information, see "Exporting to XML". 

Printing a project plan 

 You can print your project plan in the same way as in the Map views. 

MindView enables you to spread your printout on several pages, which is very useful in the case of project plans. 
Increasing both horizontal and vertical page spread values, for instance, will allow you to create a legible 
printout of your entire plan, spread over several pages. 

For a full description of the printing options, see "Printing a Mind Map". 
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Spellchecking 

Using the spellchecker 

 MindView allows you to find and correct spelling errors in your entire document as well as in the 
currently selected element. The MindView spellchecker is able to detect misspelled words and automatically 
correct common misspellings in the following elements: 

• Branch names 

• Floating comments 

• Pop-up comments 

• Text notes 

• Object names 

In addition to looking up words in its own dictionaries, the spellchecker also references custom dictionaries to 
determine whether a particular word is correctly spelt or not. You can customize these dictionaries by adding, 
replacing or deleting words. 

The spellchecker also uses an AutoCorrect list to correct common mistakes automatically. Again, you can 
customize this list by adding, replacing or deleting word pairs. 

Finally the spellchecker allows you to spellcheck your documents in several languages, including American and 
British English, French, German, Italian, Spanish, Dutch and Danish. 

Spellchecking as you type 
By default, MindView checks for spelling errors as you type, underlining in red any mistakes found. 

You have the option of correcting the mistake straight away by right-clicking the misspelled word. 

This opens the local menu, in which you can choose any of the following commands: 

• Corrections 

This lets you choose one of the suggestions listed, which then replaces the misspelled word. 

• Ignore All 

Choose this command to ignore the currently highlighted occurrence of the word and all other such 
occurrences in the document and any other document opened during this MindView session. 

• Add to Dictionary 

Choose this command to add the underlined word to your default custom dictionary, thereby making it a 
valid word which the spellchecker will no longer report as a mistake. See the topic "Spellchecking options" 
for more information on custom dictionaries. 

• AutoCorrect 

This lets you choose one of the suggestions listed. In addition, the misspelled word and its corrected 
equivalent will be added to the AutoCorrect list. This means that whenever you type this misspelled word in 
the future, it will be automatically replaced by its corrected equivalent. See the topic "Spellchecking 
options" for more information on the AutoCorrect list. 

• Spelling 

This opens the Spelling dialog, which allows you to spellcheck the entire selected element. 

 152



Spellchecking the document 
 Choose Review | Proofing | Spellcheck Document or press F7. 

 MindView goes through your document, examining branch names, floating comments, pop-up comments, 
text notes and object names for spelling mistakes. As soon as it detects a spelling mistake in one of these 
elements, MindView selects the element containing the mistake and opens the Spelling dialog. 

 

The top field shows the phrase containing the misspelling, with the first misspelled word highlighted. The 
bottom field shows a list of suggestions from which you can choose an alternative spelling for the highlighted 
word.  

You can choose one of the following options: 

• Ignore Once 

This will ignore the currently highlighted occurrence of the word. 

• Ignore All 

This will ignore the currently highlighted occurrence of the word as well as any other such occurrences 
during the entire MindView session. 

• Add to Dictionary 

This will add the misspelled word to your default custom dictionary. 

• Change 

If you have edited the misspelled word in the top field, this replaces it with the edited word. Otherwise the 
misspelled word is replaced by the alternative spelling chosen in the Suggestions field. Only this occurrence 
of the misspelled word is corrected. If you also want all following occurrences of the word replaced, click 
Change All. 

• Change All 

If you have edited the misspelled word in the top field, this replaces it with the edited word. Otherwise the 
misspelled word is replaced by the alternative spelling chosen in the Suggestions field. This replaces all the 
occurrences of the misspelled word in the entire document. 
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• AutoCorrect 

This replaces the misspelled word by the alternative spelling chosen in the Suggestions field. In addition, the 
misspelled word and its corrected equivalent are added to the AutoCorrect list. 

• Dictionary language 

This lets you choose a different language for the spellchecker to use to check your document. 

• Options 

This opens the Spellchecking Options dialog, which lets you set various options to control the way the 
spellchecking is done. See the topic "Spellchecking options" for a full description of this dialog. 

Spellchecking the currently selected element 
 Choose Review | Proofing | Spellcheck Selection or press Ctrl + F7. 

 MindView goes through the currently selected element, looking for spelling mistakes. As soon as it 
detects a spelling mistake, MindView selects the phrase containing the spelling error, highlights the error and 
opens the Spelling dialog described above. 

Choosing a different dictionary 
 Choose Review | Proofing | Set Language and select the language dictionary you would like to use to 

spellcheck your document. 

 

Spellchecking options 

 This dialog contains various options which you can set to determine the type of errors reported by the 
spellchecker. 

You can access it in several ways: 

• By choosing Review | Proofing | Spelling Options. 

• By clicking Options in the Spelling dialog. 

• By clicking the MindView Button, then MindView Options and Proofing. 
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Check spelling as you type: If you disable this option, the misspelled words will not be automatically 
underlined in red as you type them. You will need to use the Spellcheck commands to spellcheck your Mind 
Map at a later stage. 

Ignore words in uppercase: When enabled, this option causes any word written entirely in upper case to be 
ignored by the spellchecker and skipped. It is useful to keep this option enabled if your document contains many 
acronyms. 

Ignore words with numbers: When enabled, this option causes any word containing numbers to be ignored by 
the spellchecker and skipped. It is useful to keep this option enabled if your document contains many words or 
symbols including numbers, such as Q4.  

Ignore Internet and file addresses: When enabled, this option causes any words that appear to make up an 
Internet domain name, a URL or an email address to be ignored and skipped. 

Phonetic suggestions (English only): When enabled, this option causes suggestions to be made on the basis of 
their phonetic similarity to the misspelled word. This option tends to improve suggestions for badly misspelled 
words. 

Typographical suggestions: This is the default option. It causes suggestions to be made on the basis of the 
similarity of their spelling to that of the misspelled word. Note that the spellchecker does not offer suggestions if 
you disable both this option and the 'Phonetic suggestions' option. 

Case sensitive: When enabled, this option causes the spellchecker to distinguish between capitalized and non-
capitalized letters. The word "europe" for instance would be considered as a mistake. If you disable this option, 
"europe" and "Europe" would be considered identical and both regarded as correct. 

AutoCorrect: If you disable this option, even if a misspelled word is included together with its correct 
equivalent in the AutoCorrect list, the misspelled word will not be automatically replaced by its equivalent. 

Correct two initial capitals: If you type the first two letters of a word in upper case, this option causes the 2nd 
letter to be automatically converted from upper case to lower case. The word "EUrope" for instance would be 
automatically replaced by "Europe".  

Capitalize first letter of sentences: Automatically converts the 1st letter of a sentence to upper case. 

You can also click AutoCorrect List or Custom Dictionaries to open the corresponding dialogs. Both dialogs 
are described below. 
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Default language: This lets you choose the default language which you want the spellchecker to use to check 
your documents. 

Using the AutoCorrect list 
This list contains all the misspelled words which you have corrected by using the AutoCorrect feature described 
above. Each line is made up of the originally misspelled word in the 'Replace' column on the left, together with 
the suggestion you chose to replace it with in the 'With' column on the right. 

 

If you work with different languages, the spellchecker maintains one such AutoCorrect list per language. 

You can customize the AutoCorrect list in various ways: 

• You can add new AutoCorrect pairs by typing a commonly misspelled word in the 'Replace' field followed 
by its correct equivalent in the 'With' field and clicking Add. 

• You can replace the correct equivalent of a misspelled word by selecting this misspelled word in the 
'Replace' list, typing the new equivalent in the 'With' field and clicking Replace. 

• You can delete an AutoCorrect pair by selecting the corresponding row in the list and clicking Delete. 

Using the custom dictionaries 
This dialog contains a list of all your custom dictionaries as well as several buttons allowing you to customize 
them. 
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Custom dictionaries contain all the words reported as misspelled by the spellchecker that you decided to accept 
as valid by clicking Add to Dictionary during spellchecking. This means that a word included in any of the 
custom dictionaries is no longer reported as a misspelling by the spellchecker. 

The Custom Dictionaries dialog allows you to: 

• Modify one of the custom dictionaries by clicking it, then selecting Modify. You can then add new words to 
the dictionary or remove existing words. 

• Set one of the custom dictionaries as default by selecting it and clicking Default. Any new word you now 
accept as valid by clicking Add to Dictionary while spellchecking will be automatically added to this 
dictionary. 

• Create a new custom dictionary by clicking New. 

• Add an existing custom dictionary by clicking Add. 

• Remove an existing custom dictionary by selecting it and clicking Remove. 
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Exporting 

Introduction 

 MindView lets you export your document to other applications, including Microsoft® Word, Microsoft® 
PowerPoint, Microsoft® Excel, MatchWare Mediator, Microsoft® Outlook and Microsoft® Project. You can 
also export it to HTML or XML. 

These export possibilities mean that you can use MindView to brainstorm your ideas, organize them visually and 
collect all the associated material, and then convert the map into the format you require. In this way, you 
immediately obtain a professional-looking document, which you can process further if necessary using tools 
such as FrontPage® (for HTML export), Microsoft® Word, Microsoft® PowerPoint, Microsoft® Project, 
MatchWare Mediator and so on. 

Once you have exported your document and worked on it in one of these applications (for instance Word, 
PowerPoint, Excel, Mediator, Outlook or Project), you can re-import it back into MindView if necessary, while 
preserving much of the work done in the external application. The branch structure, layout and contents of the 
original Mind Map is also preserved as far as possible. For more information about importing a document into 
MindView, see the "Importing" section of this documentation. 

The export options offered by MindView are all described in detail in the next topics. 

Additional folders 

 When you export your document to one of the export formats available, MindView automatically includes 
and references all the files you have used in the document. 

If however you have created a particular folder structure for the external files used by your document, you can 
ensure that MindView preserves this structure when exporting to HTML by specifying the list of folders that 
need to be included in the export folder as follows: 

 Click the MindView Button. 

 Choose Prepare | Additional Folders to open the following dialog: 
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 Click the Add button and select the first folder you wish to include in the export. 

 Repeat for all the folders you would like to include. 

Note that you can enlarge the dialog by dragging one of its corners if the folder paths are not fully visible. 

In the exported version of your document, all references to external files are automatically modified to point to 
the correct output folder. 

Exporting to Microsoft Word 

 This export method lets you export your Mind Map as a Microsoft® Word document. If for instance you 
have created a Mind Map to brainstorm the structure of a report, this export mode provides you with a ready-
made outline of your map as a Word document, which you can then turn into a fully blown report by working 
directly in Word. 

If after working for some time on your Word document, you realize you need to review the structure of your map 
in MindView before doing any further work in Word, you can re-import it back into MindView without losing 
any new text or formatting you might have added in Word. See "Importing from Microsoft Word" for more 
information. 

 You do not need to have Microsoft Word installed on your computer in order to use this export mode. To 
open the document however, you need Word 2007 and above. You can also open the document in an earlier 
version of Word if you have installed the Microsoft Office Compatibility pack, available free from the Microsoft 
web site. 

Each branch is exported as a paragraph heading at the relevant level, in other words Heading 1 for main 
branches, Heading 2 for sub-branches, Heading 3 for sub-sub-branches and so on, using hierarchical numbering 
(unless you disable it in Advanced Export). Attached objects and inserted elements are listed below the heading. 

 As Microsoft Word only supports 9 heading levels, any MindView branch deeper than 9 levels is exported 
as Heading 9. 

By default, MindView automatically includes an overall picture of your map on the first page of the document, 
followed by a Table of Contents. 

 159



 If you add new headings to the document when working directly in Microsoft Word, you can easily update this Table of 
Contents by right-clicking it and choosing Update Field in the Word local menu. If you don't need the Table of Contents, you 
can delete it by selecting it and pressing Delete. 

The branches of the map are exported to Word in the order in which they are displayed in the Mind Map view, 
starting from the top right in a clockwise direction. 

You can however exclude entire branches and sub-branches from the export by disabling their 'Include in export' 
property in the Properties dialog. 

 

  Only the branches displayed on the workspace when you start the export procedure are exported. This 
means that if you are focusing on a particular branch or set of branches (see "Focusing on a branch") or if you 
are filtering the map to display only branches that meet specific criteria (see "Filtering a Mind Map"), only the 
branches visible on the workspace will be exported. To export the entire map, you need to go back to the full 
display by clearing the branch focus or filter applied. 

Export modes 
There are two export modes available: 

• Quick Export 

 The Quick Export mode allows you to export your map quickly using the MindView defaults or the 
last Advanced Export settings you chose if you have already used that mode. 

• Advanced Export 

 The Advanced Export mode allows you to choose a template for your Word document. You can also 
specify the elements of your map to be exported and how they should be treated. 

The export settings you choose in Advanced Export are saved with the MindView document and re-used 
next time you export your map using Quick Export or Advanced Export. This means you do not have to 
redefine them every time you make a small alteration to your map and want to export it again to Word. 

  When exporting a Mind Map to Word, MindView inserts bookmarks in the Word document to keep track 
of how the various elements should be re-imported back into MindView if you choose to do so. You should take 
care not to delete these bookmarks, which are hidden by default. To make them visible while you work, check 
'Show bookmarks' in the Advanced panel of the Word Options dialog. 

Relationship between MindView and Word elements and objects 
The following table indicates how MindView treats the various inserted elements and attached objects contained 
in your map when exporting it to Microsoft Word. 

MindView element Exported to Word as 

Branch name Heading at relevant level with hierarchical numbering 

(3 levels by default) 

Hierarchical numbering can be disabled in Advanced Export. 

Text note Text inserted under the branch heading 

Branch picture Picture inserted under the branch heading 

Floating picture • If connected to a branch, inserted under the branch heading 

• If not connected to a branch, not exported  

Floating comment As for Floating picture 
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Pop-up comment Word comment on the branch heading 

Branch connection Cross-reference prefixed by "See" under the start branch heading, 
pointing to the end branch heading 

MindView object Exported to Word as 

Text file Hyperlink 

Picture file Picture inserted in the Word document 

In Advanced Export, you can choose instead to insert the file as a 
hyperlink. 

Video file Hyperlink 

Sound file Hyperlink 

Hyperlink Hyperlink 

Flash file Hyperlink 

Using Quick Export 
 Click the MindView Button. 

 Choose Export | Microsoft Word | Quick Word Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click OK. 

 Specify a folder and a file name for the new Word document in the Save As dialog. 

MindView starts exporting your Mind Map to Microsoft Word and displays a message informing you that export 
is complete. 

 Click OK in that dialog to open the document in Word. 

Word then displays the following message, indicating that it needs to update the Table of Contents. 

 

 Click OK to update the Table of Contents. 

You are now ready to work in your Word document. 

Using Advanced Export 
 Click the MindView Button. 

 Choose Export | Microsoft Word | Advanced Word Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click OK. 

 Choose your preferred template in the Templates tab of the Advanced Microsoft Word Export dialog or 
browse for one of the templates supplied with Microsoft Word or one of your own templates. 
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The APA and MLA templates supplied with MindView are designed to help you format your documents 
according to the APA (American Psychological Association) and MLA (Modern Language Association) 
standards, commonly used in the United States. The MLA template contains further styles which you can 
use when finalizing your document, such as "block quotes" and "works cited". 

 You can easily define your own Word template to be used when exporting from MindView. All you 
need to do is to define the Title style as well as styles for Headings 1 to 9 and save the document as a Word 
template (.dotx or .docx). You must also make sure the template does not contain any text. 

 In the General tab, choose the required general export settings and specify which elements of your map you 
want to export. 

 

 If you exclude some elements from the export by deselecting them here, none of the elements of this 
type will be exported, regardless of the value of their individual 'Include in export' property in the Properties 
dialog. Let's suppose for instance your map contains a floating picture whose 'Include in export' property is 
enabled. If you choose to exclude floating pictures from the export here, your floating picture will not be 
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exported. Conversely, if you specify here that floating pictures should be exported, only the floating pictures 
whose 'Include in export' property is enabled will be exported. 

 

 Choose the required export settings for any attached object in the Attached Objects tab. 

 

 Click Export. 

 Specify a folder and a file name for the new Word document in the Save As dialog. 

As for Quick Export, MindView starts exporting your Mind Map to Microsoft Word as a new document and 
displays the same messages once the export is complete. 

Exporting to Microsoft PowerPoint 

 This export method lets you export your Mind Map as a Microsoft® PowerPoint presentation. If for 
instance you have created a Mind Map to brainstorm the structure of a business presentation, this export mode 
allows you to transfer it to PowerPoint in order to refine it further before delivering it to your audience. 

If after working for some time on your PowerPoint presentation, you realize you need to review the structure of 
your map in MindView before doing any further work in PowerPoint, you can re-import it back into MindView 
without losing the layout work done in PowerPoint. See "Importing from Microsoft PowerPoint" for more 
information. 

 You must have Microsoft PowerPoint installed on your computer in order to use this export mode. 
MindView supports all Microsoft PowerPoint versions from 2000 onwards. 

The root makes up the first slide, with the root label as the slide heading, followed by a list of the main branches. 

Each branch is then exported as a slide, with any sub-branches listed below the slide heading. Inserted elements 
and hyperlinks are placed on the right side or at the bottom of the slide. 

The branches of the map are exported to PowerPoint in the order in which they are displayed in the Mind Map 
view, starting from the top right in a clockwise direction. 

You can however exclude entire branches and sub-branches from the export by disabling their 'Include in export' 
property in the Properties dialog. 
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  Only the branches displayed on the workspace when you start the export procedure are exported. This 
means that if you are focusing on a particular branch or set of branches (see "Focusing on a branch") or if you 
are filtering the map to display only branches that meet specific criteria (see "Filtering a Mind Map"), only the 
branches visible on the workspace will be exported. To export the entire map, you need to go back to the full 
display by clearing the branch focus or filter applied. 

Export modes 
There are two export modes available: 

• Quick Export 

 The Quick Export mode allows you to export your map quickly using the MindView defaults or the 
last Advanced Export settings you chose if you have already used that mode. 

• Advanced Export 

 The Advanced Export mode lets you choose a PowerPoint template for your presentation. It also 
allows you to specify the elements of your map to be exported and how they should be treated. 

The export settings you choose in Advanced Export are saved with the MindView document and re-used 
next time you export your map using Quick Export or Advanced Export. This means that you do not have to 
redefine them every time you make a small amendment to your map and want to export it again to 
PowerPoint. 

Relationship between MindView and PowerPoint elements and 
objects 
The following table indicates how MindView treats the various inserted elements and attached objects contained 
in your map when exporting it to PowerPoint. 

MindView element Exported to PowerPoint as 

Branch name Slide heading 

Text note Text object 

Due to PowerPoint limitations, if the text note contains tables or 
bulleted lists, these elements will be exported as regular text. Similarly, 
if the text note contains a hyperlink, the formatting of the hyperlink will 
be preserved, but not the link itself. 

Branch picture Picture on the right of the slide 

In Advanced Export, you can choose instead to insert the branch picture 
as a hyperlink. 

Floating picture • If connected to a branch, inserted as a picture on the right or at the 
bottom of the slide 

• If not connected to a branch, not exported 

Floating comment • If connected to a branch, inserted on the slide as a PowerPoint 
comment 

• If not connected to a branch, not exported 

Pop-up comment PowerPoint note in the bottom Notes pane 

Branch connection Hyperlink in a text object 

 164



MindView object Exported to PowerPoint as 

Text file Hyperlink in a text object 

Picture file Picture on the right or at the bottom of the slide 

In Advanced Export, you can choose instead to insert the file as a 
hyperlink in a text object 

Video file Hyperlink in a text object 

In Advanced Export, you can choose instead to embed the video directly 
on the slide 

Sound file Hyperlink in a text object 

Hyperlink Hyperlink in a text object 

Flash file Hyperlink in a text object 

Using Quick Export 
 Click the MindView Button. 

 Choose Export | Microsoft PowerPoint | Quick PowerPoint Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click OK. 

MindView starts exporting your Mind Map to Microsoft PowerPoint as a new presentation, and displays a 
message once the export is complete. You can then start working directly in PowerPoint on your new 
presentation and save it with the name of your choice. 

Using Advanced Export 
 Click the MindView Button. 

 Choose Export | Microsoft PowerPoint | Advanced PowerPoint Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click OK. 

 Choose your preferred template in the Templates tab of the Advanced Microsoft PowerPoint Export dialog 
or browse for one of the templates supplied with Microsoft PowerPoint. 
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 In the General tab, choose the required general export settings and specify which elements of your map you 
want to export. 

 

 If you exclude some elements from the export by deselecting them here, none of the elements of this 
type will be exported, regardless of the value of their individual 'Include in export' property in the Properties 
dialog. Let's suppose for instance your map contains a floating picture whose 'Include in export' property is 
enabled. If you choose to exclude floating pictures from the export here, your floating picture will not be 
exported. Conversely, if you specify here that floating pictures should be exported, only the floating pictures 
whose 'Include in export' property is enabled will be exported. 

 

 Choose the required export settings for any attached object in the Attached Objects tab. 

 

 Click Export. 

As for Quick Export, MindView starts exporting your Mind Map to PowerPoint as a new presentation, and 
displays a message once the export is complete. 
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Exporting to Microsoft Excel 

 This export method lets you export your Mind Map as a Microsoft® Excel spreadsheet document. 

If for instance you have created a Mind Map to track worldwide sales, this export mode provides you with a 
ready-made version of your map as an Excel spreadsheet, which you can then turn into a fully blown report by 
working directly in Excel. 

After working in Excel you can of course re-import the spreadsheet back into MindView: the re-imported Mind 
Map will reflect the changes you made in Excel. See "Importing from Microsoft Excel" for more information. 

 You must have Microsoft Excel 2003 or above installed on your computer in order to use this export mode. 

Branch text, pop-up comments and calculation values are exported (see "Inserting calculation values" for 
information about calculation values). If you use the Advanced Export option, you can also export any or all of 
the standard task data fields: Start, End, Duration, Completion, Priority and Resources (see "Inserting task data" 
for more information on this topic). 

The following are not exported: pictures, text notes, floating comments, attached objects, and dates before 1900 
(which are not supported by Excel). 

  If you are focusing on a particular branch or set of branches (see "Focusing on a branch") or if you are 
filtering the map to display only branches that meet specific criteria (see "Filtering a Mind Map"), only the 
branches visible on the workspace will be visible in the Excel spreadsheet created. The same applies if you 
deselect the 'Include in Export' property in the Properties dialog for one or more branches. The branches that are 
not visible on the workspace are exported (because they may contain data needed by calculations on the visible 
branches), but the rows containing them are hidden. You can display these rows using the standard Excel 
procedures, for example in Excel 2007 select the rows above and below the hidden one(s) then, in the Home tab, 
choose Format and Hide & Unhide | Unhide Rows. 

Export modes 
There are two export modes available: 

• Quick Export 

 The Quick Export mode allows you to export your map quickly using the MindView defaults or the 
last Advanced Export settings you chose if you have already used that mode. 

• Advanced Export 

 The Advanced Export mode allows you to choose a template for your Excel spreadsheet document. 
You can also specify the elements of your map to be exported and a layout for the output. 

The export settings you choose in Advanced Export are saved with the MindView document and re-used 
next time you export your map using Quick Export or Advanced Export. This means you do not have to 
redefine them every time you make a small alteration to your map and want to export it again to Excel. 

Using Quick Export 
 Click the MindView Button. 

 Choose Export | Microsoft Excel | Quick Excel Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click OK. 

 Specify a folder and a file name for the new Excel document in the Save As dialog. 

MindView starts exporting your Mind Map to Microsoft Excel and displays a message informing you that export 
is complete. 
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 Click OK in that dialog to open the document in Excel. 

Using Advanced Export 
 Click the MindView Button. 

 Choose Export | Microsoft Excel | Advanced Excel Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click OK. 

 Choose your preferred template in the Templates tab of the Advanced Microsoft Excel Export dialog. 

 

 In the General tab, choose a layout for the Excel spreadsheet: 

• In the Structured layout, branch text is put into different columns according to the hierarchy of the 
branches in the Mind Map. 

• In the Numbered layout, numbers in the leftmost column indicate the Mind Map hierarchy. 
You can also specify the branch data and calculation values you want to export. 

 

 168



 Click Export. 

 Specify a folder and a file name for the new Excel document in the Save As dialog. 

MindView starts exporting your Mind Map to Microsoft Excel and displays a message informing you that export 
is complete. 

 Click OK in that dialog to open the document in Excel. 

Exporting to Microsoft Outlook 

 MindView lets you export your document to Microsoft® Outlook as tasks in an Outlook task folder. If, 
for instance, you have brainstormed a task list in the Mind Map view or the Outline view, you can then export it 
to Microsoft Outlook if you prefer to track tasks from there. 

You can export your document to Microsoft Outlook even if the branches do not contain dates or other task 
information. This lets you brainstorm the task names in MindView and only add the rest of the task information 
once the document is transferred to Outlook. 

  Only the branches displayed on the workspace when you start the export procedure are exported. This 
means that if you are focusing on a particular branch or set of branches (see "Focusing on a branch") or if you 
are filtering the map to display only branches that meet specific criteria (see "Filtering a Mind Map"), only the 
branches visible on the workspace will be exported. To export the entire map, you need to go back to the full 
display by clearing the branch focus or filter applied. 

MindView also lets you import task lists from Microsoft Outlook. For more information, see "Importing from 
Microsoft Outlook". 

 You must have Microsoft Outlook 2000 or above installed on your computer in order to use this export 
mode. 

Procedure 
 Click the MindView Button. 

 Choose Export | Microsoft Outlook | Export as new tasks. 

 If you have already exported the MindView document to Outlook previously, or if you have created the 
MindView document by importing an Outlook task list, you will be given the option of synchronizing the 
MindView document with the Outlook folder you specified at that time rather than creating new tasks. See 
below for more information on this procedure. 

 In the Outlook dialog that opens, select the Outlook task folder or sub-folder where you want to export the 
tasks. 

 In the next dialog, specify whether you want to export all the tasks (i.e. branches) of your MindView 
document, or only those that contain dates. 

MindView exports your document to Microsoft Outlook as a series of tasks in the task folder you specified, and 
displays a message once the export is complete. 

 You can exclude any branch from the export by disabling its 'Include in export' property in the Properties 
dialog. 

 

Limitations 
When a MindView branch contains sub-branches, only the sub-branches are exported. Parent branches are not 
exported.  

 169



Only the elements of the MindView document that are supported in Microsoft Outlook are exported: 

• Task names (i.e. branch names), dates, durations, priority and completion values are exported in the Outlook 
task list. 

• Pop-up comments are exported as Outlook task notes. 

• Text notes are not exported. 

• Other elements of the MindView document that are not supported by Microsoft Outlook (such as branch 
pictures, icons, attached objects and so on) are not exported. 

Synchronizing between MindView and Microsoft Outlook 
Once you have exported a MindView task list to Microsoft Outlook, or conversely once you have imported an 
Outlook task list into MindView, you can continue making changes to the tasks in MindView or in Outlook. You 
can even continue working on the task list in both applications independently. If at some point you want to re-
align the two versions to make sure they contain identical data, you can use MindView's synchronization feature. 

 Click the MindView Button. 

 Choose Export | Microsoft Outlook | Synchronize. 

The Microsoft Outlook Synchronization dialog opens. 

 

In the top part of the dialog, you specify what should happen when the same task exists in both the Outlook task 
folder and your MindView document in two different forms. You have two choices: 

• Copy the task from the MindView document to the Outlook folder (thereby overwriting any other task 
information associated with the task in the Outlook folder with the MindView version) 

• Copy the task from the Outlook folder to the MindView document (thereby overwriting any other task 
information associated with the task in the MindView document with the Outlook version) 

The middle part of the dialog lets you specify what should happen if a task existing in the Outlook folder cannot 
be found in the MindView document. You have three choices: 

• Copy the task from the Outlook folder to the MindView document 

• Delete the task from the Outlook folder, so that it does not exist any longer in either version 

 170



• Leave things as they are 

Finally the bottom part of the dialog lets you deal with the opposite situation, i.e. when a task exists only in the 
MindView document. 

You can exclude the branches of your MindView document that do not contain dates from the synchronization 
by checking the relevant option at the bottom of the dialog. 

Exporting to Project 

 MindView lets you export your document as a Microsoft® Project plan. This may be useful when, for 
instance, having built and fine-tuned a project plan in the MindView Gantt view, you now want to take 
advantage of Microsoft Project's advanced project management capabilities. 

All the task and scheduling information contained in the MindView project plan is exported to Microsoft Project. 

 This export method is only available when you are working on a project plan. See "Inserting task data" and 
"Using the Gantt view" for more information about project plans. 

MindView also lets you import documents from Microsoft Project. For more information, see "Importing from 
Microsoft Project". 

 MindView does not support versions of Microsoft Project prior to 2003. You need to have Microsoft Project 
installed on your computer in order to use this export method. 

 You can also export a MindView project plan to the Microsoft Project XML format. The advantage of this method is that 
you do not need to have Microsoft Project installed on your machine. See "Exporting to XML" for more information. 

Procedure 
 Click the MindView Button. 

 Choose Export | Microsoft Project. 

 Choose a file name and a destination for the exported file and click OK. 

MindView starts exporting your document to Microsoft Project as a new project plan, and displays a message 
once the export is complete. 

Limitations 
Only the elements of the MindView project plan that are supported by Microsoft Project are exported: 

• Branch pictures, icons, attached objects and so on are not exported. 

• Pop-up comments are exported as Microsoft Project task notes. 

• MindView text notes are not exported. 

 The property 'Include in export' of the Properties dialog is ignored when exporting to Microsoft Project. 

Exporting to HTML: Overview 

 This export method lets you export your Mind Map as a set of web pages in HTML format. It allows you 
to obtain a professional-looking web site very quickly, without having to worry about web design techniques. 

 Although you do not need to have a web browser installed on your machine in order to use this export 
method, you obviously need one to view the web site created. Among the web browsers supported by the 
MindView HTML export are Internet Explorer version 6.0 or above and Firefox 3.0 and above.  

The exported HTML pages are placed in a sub-folder named 'MVHtmlExport' in the folder of your choice. 

 171



All the pictures you have included in your document are placed in a sub-folder of 'MVHtmlExport' named 'img', 
whereas the picture files used by the MindView export template are placed in a sub-folder named 'mvfiles'. All 
other external files used in your document are placed directly in 'MVHtmlExport'. As it creates the HTML pages, 
MindView automatically modifies all the references to external files contained in your document so that they 
point to the correct output folder. 

Each branch, including the root, is exported as a HTML page of the same name as the branch, and each page 
contains a menu of all its sub-branches and optionally, a menu of the main branches. 

By default, a Home button taking you back to the root page is included on each HTML page. A Site Map button 
containing a link to an interactive picture of your entire map and a 'You are here' locator showing you the 
complete path from the root are also included on each HTML page. 

Unless you define a different arrangement in the Export Wizard, all the objects attached to a branch are exported 
below each other and left aligned on the page. 

The branches of the map are exported to HTML in the order in which they are displayed in the Mind Map view, 
starting from the top right in a clockwise direction. 

You can however exclude entire branches and sub-branches from the export by disabling their 'Include in export' 
property in the Properties dialog. 

 

  If you are filtering the map to display only branches that meet specific criteria (see "Filtering a Mind 
Map"), only the branches visible on the workspace will be exported. To export the entire map, you need to go 
back to the full display by clearing the filter applied. 

 If you want a specific description to appear when the user hovers a picture from your map in the browser, 
you can enter this description in the Name property of the relevant picture (root picture, branch picture, floating 
picture or attached picture file). This description is then converted by MindView to an HTML Alt tag during the 
export. 

Export modes 
There are two export modes available: 

• Quick Export 

 The Quick Export mode allows you to export your map quickly using the MindView defaults or the 
last export settings you chose. 

• Export Wizard 

 The HTML Export Wizard lets you choose from a number of professional ready-made templates with 
various navigation layouts which you can customize to your liking. You can also specify the elements of 
your map to be exported and how they should be treated. Moreover, if you have created a particular folder 
structure for the external files used by your document, you can ensure that MindView preserves this 
structure when exporting to HTML by specifying the list of folders that need to be included in the export 
folder. 

The export settings you choose are saved with the MindView document and re-used next time you export 
your map to HTML. This means that you do not have to redefine them every time you make a small 
alteration to your map. 
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Relationship between MindView and HTML elements and objects 
The following table indicates how the various MindView elements and objects are exported on the HTML page. 

MindView element Exported to HTML as 

Branch name Page title 

Text note Inserted as text 

Branch picture Inserted as picture 

Floating picture • If connected to a branch, inserted as a picture 

• If not connected to a branch, not exported 

Floating comment • If connected to a branch, inserted as text 

• If not connected to a branch, not exported 

Pop-up comment Inserted as text 

Branch connection Depending on your choice in the export dialog, inserted as a button link 
or as a hyperlink 

MindView object Exported to HTML as 

Text file Depending on your choice in the export dialog, inserted as a button link 
or as a hyperlink 

Picture file Inserted as a picture 

Video file Inserted as a Media Player object 

Sound file Depending on your choice in the export dialog, inserted as a button link 
or as a hyperlink 

Hyperlink Inserted as a hyperlink 

Flash file Inserted as a Flash file (embedded) 

 

Exporting to HTML: Quick Export 
 Click the MindView Button. 

 Choose Export | HTML | Quick HTML Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click OK. 

The HTML Quick Export dialog appears. 
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 Choose a path for your new web site. 

MindView will create a sub-folder named 'MVHtmlExport' in the folder you specify, and place all the files 
making up your web site in this sub-folder. 

 Choose whether to use: 

• The template you last used in the Export Wizard if you have already used that export mode for your 
map. 

• The MatchWare predefined export template (with top and side navigation menu) 
 (optional) Click Options to define further export options: 

The Select Objects tab allows you to specify the elements of the map to include in the export. 
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 If you exclude some elements from the export by deselecting them here, none of the elements of this 
type will be exported, regardless of the value of their individual 'Include in export' property in the Properties 
dialog. Let's suppose for instance your map contains a floating picture whose 'Include in export' property is 
enabled. If you choose to exclude floating pictures from the export here, your floating picture will not be 
exported. Conversely, if you specify here that floating pictures should be exported, only the floating pictures 
whose 'Include in export' property is enabled will be exported. 

 

The Select Link Types tab only appears if your map contains branch connections and/or attached sound 
files or text files. It lets you choose whether these elements should be placed on HTML hyperlinks or 
buttons. 

 

 Click Export. 

Once the export is completed, MindView displays a dialog giving you the choice of immediately viewing your 
web site in your default browser or uploading it to Internet using the MatchWare FTP Upload Manager. For 
more information on this tool, see "FTP Upload Manager". 

 To open your exported web site from within Windows Explorer at a later date, double-click the file 
index.htm in the sub-folder 'MVHtmlExport'. 

Exporting to HTML: Export Wizard 
 Click the MindView Button. 

 Choose Export | HTML | Advanced HTML Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click Next. 

The Export Wizard now displays a series of dialogs, the first of which is the Select Template dialog. 
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Selecting a template 
This dialog allows you to select a navigation layout for the pages of your web site. 

 

• Predefined Templates: This lets you choose one of the professional MindView export templates with 
ready-made top and side navigation. 

These templates are available in the following navigation styles : 

Tree List: With this design, the list of side links is shown as a tree whose levels you can expand and 
collapse as in Windows Explorer. All the pages of the web site are available from the Tree List. 

 

Level List: With this type of navigation, you only see a maximum of three levels of links on the side: the 
current page, any pages at the level just above it, and any pages at the level just below it. 
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Buttons: In this design, the side bar contains a list of links, where each link represents a sub-branch of the 
branch corresponding to the current page. 

 

To see a larger preview of the templates shown on the right of the window, just place the mouse pointer over 
the relevant thumbnail. Note that you will be able to go back to this step of the wizard at any time to choose 
a different template if you are not satisfied with your original choice. 

• User Templates: This lets you choose one of your own previously saved export templates. See further 
down for information on how to save your own export template. 

 Select a template on the right and click Next. 

Preview 
The Export Wizard opens the Preview dialog, which lets you customize the various areas of the navigation 
layout chosen in the first step. 
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You can customize each area in turn by clicking the Customize buttons, namely: 

• General 

• Top Bar 

• Side Bar 

• Content Area 

Feel free to experiment with the various customization options. At any time, you can obtain a full size preview of 
your design reflecting any changes made by clicking the Preview button. Note however that this Preview does 
not allow you to navigate the site. 

Customizing the General properties (optional) 
 Click General in the Preview dialog. 
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This dialog gives you the following options: 

Include 'Home' button: This inserts a Home hyperlink or button on each of your web pages, allowing you to 
return to the page corresponding to the root of your map in just one click. 

This option is not available if you have chosen a Tree List design, as this design always allows you to return to 
the root of your map in one click. A 'Home' button is therefore superfluous in this case. 

Include 'Site Map' button: This inserts a Site Map hyperlink or button on each of your web pages. Clicking it 
will display an interactive picture of the entire web site. 

Include 'Timeline' button: This option is only available if you are exporting a document from the Timeline 
view. It inserts a Timeline button on each of your web pages. Clicking it will display an interactive 
representation of the timeline as shown in the Timeline view. For more information about working with 
timelines, see "Using the Timeline view". 

Include 'You are here' locator: This inserts a dynamic link on each page of the web site to show the complete 
path from the root web page to that particular page. 

You can also enter meta-tags for your web site as follows: 

Description: Any text entered here will be inserted in the <description> tag of each of the HTML pages created. 

Keywords: Similarly, any keywords entered here (separated by commas) will be inserted in the <keywords> tag 
of each of the HTML pages created. 

Customizing the Top Bar (optional) 
 Click the Top Bar button or double-click the top bar area in the Preview dialog. 

The Top Bar Properties dialog opens on its Title tab. 
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By default, the title displayed on each web page is the branch name. Here you can change the font, attributes and 
color for this title or even enter your own title, which will be displayed on all the pages of the web site. 

 Click the Background tab. 

 

This tab lets you select a plain color or a different background picture for the top bar. 

If you want to change the background picture, the best approach is to make a copy of the existing picture and 
edit its design to suit your requirements, making sure that the picture size stays unchanged so that it still fits the 
template. 

 Click the Links tab. 
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 The Links tab is only available if the top bar of the template chosen contains buttons or hyperlinks. 

This tab lets you select different colors for the top bar links depending on their state, i.e. "Normal", "Pressed" 
(the link is clicked) or "Hovered" (the mouse pointer is placed on the link). 

You can also choose to make all the links the same width, or have their width vary according to the length of 
their label. 

Customizing the Side Bar (optional) 
 Click the Side Bar button or double-click the side bar area in the Preview dialog. 

The Side Bar Properties dialog opens on its Background tab. 

 

This tab lets you select a plain color or a different background picture for the side bar. 

As for the top bar, the best approach if you want to change the background picture is to make a copy of the 
existing picture and edit its design to suit your requirements. 
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The second tab of the Side Bar Properties dialog varies depending on the type of navigation template you chose 
in the first screen of the Export Wizard. The three possibilities are: 

• Tree list 

• Level list 

• Links 

We will now look at each of these possibilities in turn. 

Tree List 

 

This is the tab displayed if you have chosen a Tree List design in the first step of the Export Wizard. 

With this design, the list of side page links is shown as a tree whose levels you can expand and collapse as in 
Windows Explorer. All the pages of the web site are available from the Tree List. 

This tab lets you modify the default font, attributes, size and color of the links. 
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Level List 

 

This tab is displayed if you have chosen a Level List design. 

With this type of navigation, you only see a maximum of three levels of links on the side: the current page, any 
pages at the level just above it, and any pages at the level just below it.  

The Level list tab lets you choose how many levels the list should show. You can also define the font and color 
of the links. 

Links 

 

This tab is displayed if you have chosen a Buttons design in the first screen of the Export Wizard. 

With this design, the side bar contains a list of links, where each link represents a sub-branch of the branch 
corresponding to the current page. The Links tab lets you select different colors for the side bar links depending 
on their state, i.e. "Normal", "Pressed" (the link is clicked) or "Hovered" (the mouse pointer is placed on the 
link). 
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Customizing the Content Area (optional) 
 Click the Content Area button or double-click the middle area in the Preview dialog. 

The Content Area properties dialog opens on its Background tab. 

 

This tab lets you select a plain color or a different background picture for the body of the page. Feel free to 
experiment with the image placement options by checking the effect in the Full Size Preview. 

 Click the Link Type tab. 

 

If your map contains branch connections, sound files or attached text documents, this tab lets you decide whether 
you want to place these objects on hyperlinks or on buttons. 

 Click the Link Style tab. 
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This tab lets you choose styles for any buttons or hyperlinks created on your web pages. 

 Define the hyperlink style required by selecting a font, attribute and size. You can also define different 
colors depending on the state of the hyperlink, i.e. "Normal", "Pressed" (the link is clicked) or "Hovered" 
(the mouse pointer is placed on the link). 

 Scroll through the various buttons available to choose the type you like best. 

Previewing the customized template (optional) 
 Click the Preview button in the Preview dialog to obtain a 800x600 real-time preview of your design 

reflecting any changes made so far. 

 Check how your web site will look in different browser resolutions by resizing the window. 

Reducing the window size might for instance cause the top buttons or hyperlinks to spread onto two rows. 
Conversely enlarging the window might cause them to arrange themselves on one row only.  

Saving the customized template (optional) 
 You can save your customized export template for later use by clicking the Save Template button of the 

Preview dialog. The Save User Template dialog that opens contains a list of the export templates you have 
already saved. Enter the name of your new export template and click Save. 

 Once you are satisfied with the design of all the page components, click Next. 

Selecting the objects to export 
The Export Wizard now opens the Select Objects to Export dialog. 
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 Select the MindView objects which you want to export to HTML. 

 If you exclude some elements from the export by deselecting them here, none of the elements of this 
type will be exported, regardless of the value of their individual 'Include in export' property in the Properties 
dialog. Let's suppose for instance your map contains a floating picture whose 'Include in export' property is 
enabled. If you choose to exclude floating pictures from the export here, your floating picture will not be 
exported. Conversely, if you specify here that floating pictures should be exported, only the floating pictures 
whose 'Include in export' property is enabled will be exported. 

 

If you have created a particular folder structure for the external files used by your document, you can ensure that 
MindView preserves this structure when exporting to HTML by specifying the list of folders that need to be 
included in the export folder as follows: 

 Click the Select Folders button to open the following dialog: 
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 Click the Add button and select the first folder you wish to include in the export. 

 Repeat for all the folders you would like to include. 

Note that you can enlarge the dialog by dragging one of its corners if the folder paths are not fully visible. 

As it creates the HTML pages, MindView automatically modifies all the references to external files contained in 
your document so that they point to the correct output folder. 

 Click Next. 

Placing the objects on the page 
The Export Wizard now opens the Select Placement dialog, which allows you to define where the various 
objects attached to each branch should be placed on the corresponding HTML page. 
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You can either: 

• Choose a default placement of Left, Center or Right and click Next. In that case, the objects will be placed 
one after the other on each page according to their order in the Object list, either on the left, the center or the 
right of the page. 

• Choose a default placement, and then click the Place Objects button to arrange the objects manually on the 
page as you wish. 

 If you have already exported your map to HTML, you can check 'Only show updated pages'. In that 
case, the Export Wizard only shows you the pages which you have edited since the last export. If your map 
contains a large number of branches, this saves time as you do not have to review the object positioning on 
all the unchanged pages. 

Positioning the objects manually (optional) 
If you have chosen to place the objects manually by clicking 'Place Objects' in the previous dialog, the Export 
Wizard now shows the Object Positioning window. 
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This is based on a default grid containing 5 columns, each representing 20% of the width of the HTML page, and 
divided in a number of cells. 

All the objects associated with the first branch of your map are identified on the grid by a small icon bearing 
their name, in the default position chosen in the previous dialog. You can now reposition these objects or resize 
them by manipulating the grid cells as follows: 

• To move an object on the page, drag it from one cell to the other. 

• To resize a column on the grid, drag its edge until it reaches the required size. 

• To merge two or more cells so that the object is stretched across them, select the cells by dragging the 
mouse pointer across them and click the Merge Cells button (or right-click and choose Merge Cells in its 
local menu). 

• To split a cell made up of merged cells, select it and click Split Cells (or right-click it and choose Split Cells 
in the local menu). 

• To align objects horizontally or vertically within a cell, select the relevant cells by dragging the mouse 
pointer across them, right-click and choose Alignment in the local menu. Then select an Alignment option 
by clicking a square in the menu (these represent top left alignment, top center alignment, top right 
alignment and so on). Note that you can also perform this operation on empty cells before moving objects 
into them. 

• To add an empty row, right-click the row above which you want to insert a row and choose Add Row in its 
local menu. 

• To delete a row, right-click it and choose Delete Row in its local menu. 

• To increase or decrease the space between each cell, click the up or down arrows of the 'Cell spacing' 
option. 

All the objects that are excluded from the export, either because you have disabled their 'Include in export' 
property or because you have chosen to exclude them in the 'Select Objects to Export' dialog described above, 
are listed in the 'Exclude from export' area in the bottom left of the grid. You are free to drag any of these objects 
back onto the HTML page. 
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You can also exclude particular objects from the export by dragging them to the 'Exclude from export' area, and 

ht double arrow button to 
anch list shown on the left of the dialog. 

 Repeat the operation until you have reviewed all the pages that needed revisiting. 

e reviewed all the pages, click Finish. 

your new web site. 

tically optimize 

 to .jpg to reduce their file size. 
 or .jpg picture used on your map that is larger than the dimensions allocated to it on the 

HTML page is scaled down to these dimensions. 
 Click Finish. 

drag them back to the HTML page later if you change your mind. 

 Click Preview to visualize the effect of your changes on the actual page. 

 When you are satisfied with the positioning of the objects on the page, click the rig
go to the next page, or choose another page in the Br

 Once you hav

Exporting 
You are now ready to export your map to HTML. 

 Choose a destination folder for 

 (optional) You can optimize your pictures for web export by checking the option Automa
pictures. This has two effects: 

• All .bmp pictures used on your map are converted
• Any .bmp

 

Once the export is completed, MindView displays a dialog giving you the choice of immediately viewing your 
web   site in your default browser or uploading it to Internet using the MatchWare FTP Upload Manager. For
more information on this tool, see "FTP Upload Manager". 

 To open your exported web site from within Windows Explorer at a later date, double-click the file 
index.htm in the sub-folder 'MVHtmlExport'. 

 190



FTP Upload Manager 
To help you get your HTML site on the web as quickly and effortlessly as possible, MindView comes with a 
built-in FTP program, the MatchWare FTP Upload Manager. 

Starting the FTP Upload Manager 
Before you can use the FTP Upload Manager you must export your MindView document to HTML (see 
"Exporting to HTML: Quick Export" or "Exporting to HTML: Export Wizard"). At the end of the export the 
following dialog appears:  

 

 To open the FTP Upload Manager click Upload with FTP.  

The FTP Upload Manager dialog appears: 

  

 In the FTP server address field, enter the FTP upload address that you have received from your Internet 
Service Provider (ISP). 

 Enter your User name and Password in their respective fields. 

 If you do not have an FTP address, user name or password or have lost them, contact your ISP. 

 Clicking the Browse button next to Destination folder will connect you to the Internet. Once online, search 
for the remote folder you wish to upload your web site to.  
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 Select the folder required and click OK to return to the Upload Manager dialog. 

If you would like to upload the web site to a new folder, click New Folder to create a new remote folder on 
the server. Click OK to return to the Upload Manager dialog. 

  

 To quickly create a new remote folder enter a forward slash and the name of the new folder in the Destination folder 
field. 

 

If your Internet connection goes down often, you are advised to check the option 'Attempt to reconnect' in the 
Upload Manager dialog to guarantee a successful upload. 

  

You can also set the number of reconnection attempts you want the Upload Manager to perform for a given file. 
If upload is still unsuccessful after this number of attempts, it is cancelled. 

Uploading your web site 
 If you are uploading your web site for the first time, click Upload entire project to connect to the FTP 

server and upload all the files. 

You can follow the progress of the upload in the Upload dialog. 
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If upload is completed successfully, the following dialog appears: 

 

 Click Close to return to MindView. 

The FTP Upload Manager remembers your FTP address, Username, Password and Destination. If you make 
changes to your web site and would like to upload it again, click Update existing project to upload only the 
files that have changed since your last upload. 

Exporting to Mediator: Overview 

 This export method lets you export your Mind Map as a Mediator document. 

Combining MindView and Mediator is a powerful way to create web sites and multimedia presentations. Once 
you have finished brainstorming and organizing your ideas in MindView, you can export your map to Mediator 
and turn it into an interactive CD presentation or a set of dynamic Flash or HTML pages by adding Mediator 
events and actions to it. 

If after working for some time on your Mediator presentation, you realize you need to review the structure of 
your map in MindView before doing any further work in Mediator, you can re-import it back into MindView 
without losing the work already done in Mediator. See "Importing from Mediator" for more information. 
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 You do not need to have Mediator installed on your computer to use this export mode. However, you will 
need Mediator 9 or above to open the exported Mediator document. 

The exported Mediator document is placed in the folder of your choice, and all relevant external files are placed 
in a sub-folder named MD8 within that folder. 

Each branch, including the root, is exported as a Mediator page of the same name as the branch. The sub-
branches belonging to a particular branch are exported as sub-pages of the corresponding Mediator page. 

By default, a Home button, taking you back to the root page, and a Back button, taking you back to the previous 
page, are included in all the pages of your Mediator document. 

All the objects attached to a particular branch are listed in the Mediator Object list of the corresponding Mediator 
page and tiled on the page on top of each other. 

The branches of the map are exported to Mediator in the order in which they are displayed in the Mind Map 
view, starting from the top right in a clockwise direction. 

You can however exclude entire branches and sub-branches from the export by disabling their 'Include in export' 
property in the Properties dialog. 

 

  If you are filtering the map to display only branches that meet specific criteria (see "Filtering a Mind 
Map"), only the branches visible on the workspace will be exported. To export the entire map, you need to go 
back to the full display by clearing the filter applied. 

 If your MindView document was created by importing a Mediator presentation, a dialog might appear at the 
end of the export procedure, listing all the branches corresponding to pages created directly in Mediator. Because 
you might not want to change the appearance of these pages in the new Mediator presentation, you can deselect 
them in this dialog to indicate that the export template should not be applied to them. 

  When exporting the Mind Map to Mediator, MindView places special tags formatted with # signs in the 
Notes tab of the Properties dialog of particular elements of the new Mediator presentation, including the pages 
themselves. These tags contain information required by MindView to re-import the Mediator presentation, 
should you decide to do so at a later stage. You should take care not to delete these tags if you want to preserve 
the structure and layout of the original Mind Map. 

Export modes 
There are two export modes available: 

• Quick Export 

 The Quick Export mode allows you to export your map quickly using the MindView defaults or the 
last export settings you chose. 

• Export Wizard 

 The Mediator Export Wizard lets you choose from a number of professional ready-made templates 
with various navigation layouts which you can customize as you wish. You can also specify the elements of 
your map to be exported and how they should be treated. 

The export settings you choose are saved with the MindView document and re-used next time you export your 
map to Mediator. This means that you do not have to redefine them every time you make a small alteration to 
your map. 
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Relationship between MindView and Mediator elements and objects 
The following table indicates how the various MindView elements and objects are exported on the Mediator 
page. 

MindView element Exported to Mediator as 

Branch name Page description. If the branch name is unique, the branch name is also 
the page name. Otherwise, page names are numbered sequentially, i.e. 
Idea, Idea01, Idea02 and so on. 

Text note Mediator text object 

Note that if the MindView text note contains one or more hyperlinks, 
these hyperlinks retain their color and underline attributes in the 
Mediator text object, but are not converted to Mediator hypertext 
objects. This means that they do not retain their link information. 

Branch picture Mediator picture object 

Floating picture • If connected to a branch, inserted as a Mediator picture object on 
the page 

• If not connected to a branch, not exported 

Floating comment • If connected to a branch, inserted as a Mediator text object on the 
page 

• If not connected to a branch, not exported 

Pop-up comment Text note in the Notes tab of the Properties dialog for the page 

Branch connection Mediator button, looking either like a standard button or a hypertext 
link, depending on your choice in the export dialog 

MindView object Exported to Mediator as 

Text file Mediator button, looking either like a standard button or a hypertext 
link, depending on your choice in the export dialog 

Picture file Mediator picture object 

Video file Mediator Media Player object 

Sound file Mediator button, looking either like a standard button or a hypertext 
link, depending on your choice in the export dialog 

Hyperlink Mediator button looking like a hypertext link 

Flash file Mediator Flash object 

 

Exporting to Mediator: Quick Export 
 Click the MindView Button. 

 Choose Export | MatchWare Mediator | Quick Mediator Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click OK. 

The MatchWare Mediator Quick Export dialog appears. 
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 Choose a path and file name for your new Mediator document. 

 Choose the window size that corresponds to your screen resolution or the screen resolution of the intended 
users of your Mediator document. 

 Choose whether to use: 

• The template you last used in the Export Wizard if you have already used that export mode for your 
map. If you choose this option, the window size options become inactive as the window size is already 
defined. 

• The MatchWare predefined export template (with top and side menu) 
• Blank pages (without any menu structure or graphic design elements) 

 (optional) Click Options to define further export options: 

The Select Objects tab allows you to specify the elements of the map to include in the export. You can also 
disable 'Insert Home button' and/or 'Insert Back button' if you do not want these buttons on the pages of your 
Mediator document. 
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 If you exclude some elements from the export by deselecting them here, none of the elements of this 
type will be exported, regardless of the value of their individual 'Include in export' property in the Properties 
dialog. Let's suppose for instance your map contains a floating picture whose 'Include in export' property is 
enabled. If you choose to exclude floating pictures from the export here, your floating picture will not be 
exported. Conversely, if you specify here that floating pictures should be exported, only the floating pictures 
whose 'Include in export' property is enabled will be exported. 

 

 

The Select Link Types tab only appears if your map contains branch connections and/or attached sound 
files or text files. It lets you choose whether these elements should be placed on Mediator hypertext or 
button objects. 
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 Click Export. 

 If your MindView document was created by importing a Mediator presentation, a dialog might appear at this 
point, listing all the branches corresponding to pages created directly in Mediator. Because you might not want 
to change the appearance of these pages in the new Mediator presentation, you can deselect them in this dialog to 
indicate that the export template should not be applied to them.  

Once the export is completed, MindView lets you either view your presentation straight away in Mediator or 
continue working in MindView. 

  When exporting the Mind Map to Mediator, MindView places special tags formatted with # signs in the 
Notes tab of the Properties dialog of particular elements of the new Mediator presentation, including the pages 
themselves. These tags contain information required by MindView to re-import the Mediator presentation, 
should you decide to do so at a later stage. You should take care not to delete these tags if you want to preserve 
the structure and layout of the original Mind Map. 

Exporting to Mediator: Export Wizard 
 Click the MindView Button. 

 Choose Export | MatchWare Mediator | Advanced Mediator Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click Next. 

The Export Wizard now displays a series of dialogs, the first of which is the Select Window Size dialog. 
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Selecting the window size 

 

 Choose the window size corresponding to your screen resolution or the screen resolution of the intended 
users of your Mediator document and click Next. 

Selecting a template 
This dialog allows you to select a navigation layout for the pages of your Mediator document. 
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• Predefined Templates: This lets you choose one of the professional MindView export templates with 
ready-made top and side navigation. 

These templates are available in the following navigation styles: 

Level List: With this type of navigation, you only see a maximum of three levels of links on the side: the 
current page, any pages at the level just above it, and any pages at the level just below it. 

 

Buttons: In this design, the side bar contains a list of links, where each link represents a sub-branch of the 
branch corresponding to the current page. 
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To see a larger preview of the templates shown on the right of the window, just place the mouse pointer over 
the relevant thumbnail. Note that you will be able to go back to this step of the wizard at any time to choose 
a different template if you are not satisfied with your original choice. 

• User Templates: This lets you choose one of your own previously saved export templates. See further 
down for information on how to save your own export template. 

 Select a template on the right and click Next. 

Preview 
The Export Wizard opens the Preview dialog, which lets you customize the various areas of the navigation 
layout chosen in the first step. 
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You can customize each area in turn by clicking the Customize buttons, namely: 

• General 

• Top Bar 

• Side Bar 

• Content Area 

Feel free to experiment with the various customization options. At any time, you can obtain a full size preview of 
your design reflecting any changes made by clicking the Preview button. Note however that this Preview does 
not allow you to navigate the document. 

Customizing the General properties (optional) 
 Click General in the Preview dialog. 

 

This dialog gives you the following options: 

Include 'Home' button: This inserts a Home hyperlink or button on each of your Mediator pages, allowing you 
to return to the page corresponding to the root of your map in just one click. 

Include 'Back' button: This inserts a Back hyperlink or button on each of your Mediator pages, enabling you to 
go back to the last page visited. 

You can also enter meta-tags for your Mediator document as follows: 

Description: Any text entered here will be inserted in the Description tag of the Mediator document (visible by 
clicking the HTML tab of the Document Properties dialog in Mediator). 

Keywords: Similarly, any keywords entered here (separated by commas) will be inserted in the Keywords tag of 
the Mediator document (also visible by clicking the HTML tab of the Document Properties dialog in Mediator). 

Customizing the Top Bar (optional) 
 Click the Top Bar button or double-click the top bar area in the Preview dialog. 

The Top Bar Properties dialog opens on its Title tab. 
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By default, the title displayed on each Mediator page is the branch name. Here you can change the font, 
attributes and color for this title or even enter your own title, which will be displayed on all the pages of the 
document. 

 Click the Background tab. 

 

This tab lets you select a plain color or a different background picture for the top bar. 

If you want to change the background picture, the best approach is to make a copy of the existing picture and 
edit its design to suit your requirements, making sure that the picture size stays unchanged so that it still fits the 
template. 

 Click the Links tab. 
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 The Links tab is only available if the top bar of the template chosen contains buttons or hyperlinks. 

This tab lets you select different colors for the top bar links depending on their state, i.e. "Normal", "Pressed" 
(the link is clicked) or "Hovered" (the mouse pointer is placed on the link). 

You can also choose to make all the links the same width, or have their width vary according to the length of 
their label. 

Customizing the Side Bar (optional) 
 Click the Side Bar button or double-click the side bar area in the Preview dialog. 

The Side Bar Properties dialog opens on its Background tab. 

 

This tab lets you select a plain color or a different background picture for the side bar. 

As for the top bar, the best approach if you want to change the background picture is to make a copy of the 
existing picture and edit its design to suit your requirements. 
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The second tab of the Side Bar Properties dialog varies depending on the type of navigation template you chose 
in the first screen of the Export Wizard. The possibilities are: 

• Level list 

• Links 

We will now look at each of these possibilities in turn. 

Level List 

 

This tab is displayed if you have chosen a Level List design. 

With this type of navigation, you only see a maximum of three levels of links on the side: the current page, any 
pages at the level just above it, and any pages at the level just below it.  

The Level list tab lets you choose how many levels the list should show. You can also define the font and color 
of the links. 
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Links 

 

This tab is displayed if you have chosen a Buttons design in the first screen of the Export Wizard. 

With this design, the side bar contains a list of links, where each link represents a sub-branch of the branch 
corresponding to the current page. The Links tab lets you select different colors for the side bar links depending 
on their state, i.e. "Normal", "Pressed" (the link is clicked) or "Hovered" (the mouse pointer is placed on the 
link). 

Customizing the Content Area (optional) 
 Click the Content Area button or double-click the middle area in the Preview dialog. 

The Content Area properties dialog opens on its Background tab. 

 

This tab lets you select a plain color or a different background picture for the body of the page. Feel free to 
experiment with the image placement options by checking the effect in the Full Size Preview. 

 Click the Link Type tab. 
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If your map contains branch connections, sound files or attached text documents, this tab lets you decide whether 
you want to place these objects on Mediator hypertext or button objects. 

 Click the Link Style tab. 

 

This tab lets you choose styles for any buttons or hyperlinks created on your Mediator pages. 

 Define the hypertext style required by selecting a font, attribute and size. You can also define different 
colors depending on the state of the hyperlink, i.e. "Normal", "Pressed" (the link is clicked) or "Hovered" 
(the mouse pointer is placed on the link). 

 Scroll through the various buttons available to choose the type you like best. 

Previewing the customized template (optional) 
 Click the Preview button in the Preview dialog to obtain a real-time preview of your design reflecting any 

changes made so far. 
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Saving the customized template (optional) 
 You can save your customized export template for later use by clicking the Save Template button of the 

Preview dialog. The Save User Template dialog that opens contains a list of the export templates you have 
already saved. Enter the name of your new export template and click Save. 

 Once you are satisfied with the design of all the page components, click Next. 

Selecting the objects to export 
The Export Wizard now opens the Select Objects to Export dialog. 

 

 Select the MindView objects which you want to export to Mediator. 

 If you exclude some elements from the export by deselecting them here, none of the elements of this 
type will be exported, regardless of the value of their individual 'Include in export' property in the Properties 
dialog. Let's suppose for instance your map contains a floating picture whose 'Include in export' property is 
enabled. If you choose to exclude floating pictures from the export here, your floating picture will not be 
exported. Conversely, if you specify here that floating pictures should be exported, only the floating pictures 
whose 'Include in export' property is enabled will be exported. 

 

 Click Next. 

Exporting 
You are now ready to export your map to Mediator. 
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 Choose a path and file name for your new Mediator presentation. 

 If you want MindView to place a copy of all the external files used in your map (such as text files, sound 
files, video files and so on) in the export folder, check the option Copy linked files to export folder. Such 
files will then be placed in the sub-folder named MD8 of your export folder. This will allow you to 
distribute or transfer your Mediator presentation easily by copying the actual Mediator file as well as the 
entire MD8 sub-folder. 

 Click Finish. 

 If your MindView document was created by importing a Mediator presentation, a dialog might appear at this 
point, listing all the branches corresponding to pages created directly in Mediator. Because you might not want 
to change the appearance of these pages in the new Mediator presentation, you can deselect them in this dialog to 
indicate that the export template should not be applied to them.  

Once the export is completed, MindView lets you either view your presentation straight away in Mediator or 
continue working in MindView. 

  When exporting the Mind Map to Mediator, MindView places special tags formatted with # signs in the 
Notes tab of the Properties dialog of particular elements of the new Mediator presentation, including the pages 
themselves. These tags contain information required by MindView to re-import the Mediator presentation, 
should you decide to do so at a later stage. You should take care not to delete these tags if you want to preserve 
the structure and layout of the original Mind Map. 

Exporting to RTF 

 This export method lets you export your Mind Map in RTF format. This may be useful if you want to 
process your document further in a word processor, but do not have Microsoft Word installed on your computer.  

Each branch is exported as a paragraph heading at the relevant level, in other words Heading 1 for main 
branches, Heading 2 for sub-branches, Heading 3 for sub-sub-branches and so on, using hierarchical numbering 
(unless you disable it in Advanced Export). Attached objects and inserted elements are listed below the heading. 
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By default, MindView automatically includes an overall picture of your map on the first page of the document. 

The branches of the map are exported to RTF in the order in which they are displayed in the Mind Map view, 
starting from the top right in a clockwise direction. 

You can however exclude entire branches and sub-branches from the export by disabling their 'Include in export' 
property in the Properties dialog. 

 

  Only the branches displayed on the workspace when you start the export procedure are exported. This 
means that if you are focusing on a particular branch or set of branches (see "Focusing on a branch") or if you 
are filtering the map to display only branches that meet specific criteria (see "Filtering a Mind Map"), only the 
branches visible on the workspace will be exported. To export the entire map, you need to go back to the full 
display by clearing the branch focus or filter applied. 

Export modes 
There are two export modes available: 

• Quick Export 

 The Quick Export mode allows you to export your map quickly using the MindView defaults or the 
last Advanced Export settings you chose if you have already used that mode. 

• Advanced Export 

 The Advanced Export mode allows you to specify the elements of your map to be exported and how 
they should be treated. 

The export settings you choose in Advanced Export are saved with the MindView document and re-used 
next time you export your map using Quick Export or Advanced Export. This means that you do not have to 
redefine them every time you make a small amendment to your map and want to export it again to RTF. 

Relationship between MindView and RTF elements and objects 
The following table indicates how MindView treats the various inserted elements and attached objects contained 
in your map when exporting it to RTF. 

MindView element Exported to RTF as 

Branch name Heading at relevant level with hierarchical numbering 

(3 levels by default) 

Hierarchical numbering can be disabled in Advanced Export. 

Text note Text inserted under the branch heading 

Branch picture Picture inserted under the branch heading 

Floating picture • If connected to a branch, inserted under the branch heading 

• If not connected to a branch, not exported  

Floating comment As for Floating picture 

Pop-up comment Text under the branch heading 

Branch connection Cross-reference prefixed by "See section" under the start branch 
heading, pointing to the end branch heading 
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MindView object Exported to RTF as 

Text file Object name followed by hyperlink to file 

Picture file Picture embedded in the RTF document 

In Advanced Export, you can choose instead to insert the file as an 
object name followed by a hyperlink to the file. 

Video file Object name followed by hyperlink to file 

Sound file Object name followed by hyperlink to file 

Hyperlink Object name followed by hyperlink to file 

Flash file Object name followed by hyperlink to file 

Using Quick Export 
 Click the MindView Button. 

 Choose Export | RTF | Quick RTF Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click OK. 

 Specify a folder and a file name for the new RTF document in the Save As dialog. 

Once the export is complete, MindView lets you view the document in the viewer associated with the .RTF 
extension on your computer. 

Using Advanced Export 
 Click the MindView Button. 

 Choose Export | RTF | Advanced RTF Export. 

 If your MindView view contains several maps (i.e. several roots), choose the map you want to export in the 
'Select Map to Export' dialog and click OK. 

 In the General tab, choose the required general export settings and specify the elements of the map to 
export. 
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 If you exclude some elements from the export by deselecting them here, none of the elements of this 
type will be exported, regardless of the value of their individual 'Include in export' property in the Properties 
dialog. Let's suppose for instance your map contains a floating picture whose 'Include in export' property is 
enabled. If you choose to exclude floating pictures from the export here, your floating picture will not be 
exported. Conversely, if you specify here that floating pictures should be exported, only the floating pictures 
whose 'Include in export' property is enabled will be exported. 

 

 Choose the required export settings for any attached object in the Attached Objects tab. 
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 Click Export. 

As for Quick Export, MindView starts exporting your Mind Map to RTF as a new document. Once the export is 
complete, MindView lets you view the document in the viewer associated with the .RTF extension on your 
computer. 

Exporting to XML 
This export method lets you export your document in XML format. 

MindView supports two XML export file types: 

• MindView XML: This file type allows MindView documents to be converted to other application formats 
after implementation of a transformation file. 

• Microsoft Project XML: This file type allows you to create a version of your MindView document that can 
be opened in Microsoft® Project with the standard File | Open command of that application. You can use 
the Microsoft Project XML export method even if you do not have Microsoft Project on your computer. It is 
therefore a useful alternative to exporting directly from MindView to Microsoft Project in the .mpp format, 
for which you do need to have Microsoft Project installed on your computer. 

Only the elements of the MindView project plan that are supported by Microsoft Project are exported. This 
means that branch pictures, icons, attached objects and so on are not exported. Pop-up comments are 
exported as Microsoft Project task notes. MindView text notes are not exported. 

Procedure 
 Click the MindView Button. 

 Choose Export | XML. 

 Choose a file name and a destination for the exported file. 
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 Choose the required export file type in the Type field. 

 Click OK. 

 The property 'Include in export' of the Properties dialog is ignored when exporting to XML. 

Exporting as picture 

 This export method lets you save your Mind Map as a picture file. The picture file formats supported are 
.bmp, .jpg, .png and .emf. 

 Click the MindView Button. 

 Choose Export | Picture. 

The following dialog appears to let you choose the required export settings. 

 

 Enter the path and file name for the picture in the 'Save as' field or click the Browse button to choose an 
existing path. 

 If you do not want to display branch connections, floating pictures and floating comments in the picture, 
clear the corresponding check mark. 

 Since this export method creates a picture of your entire map, all elements chosen above are displayed 
on the picture, regardless of the value of their individual 'Include in export' property in the Properties dialog. 
Similarly, all branches will be visible, regardless of the value of their individual 'Include in export' property. 

 If you want to display the object indicator  and/or the comment indicator  next to each branch 
containing attached objects and/or comments, click the relevant check box. 

 Choose the required picture format. 

If you choose the .jpg format, you can use the 'JPG quality' slider to define the level of quality needed. Note 
that decreasing the level of quality increases the level of compression, and therefore reduces the file size. 

 (optional) Preview the effect of your settings on the picture by clicking Preview. 

 Click Export. 
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Note that icons and branch pictures are always displayed and that it is not possible to display text notes. 

The export settings you choose are saved with the MindView document. This means that you will not have to 
specify these settings again if you make changes to the map and want to re-export it as a picture. 
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Importing 

Introduction 

 MindView lets you import documents from other applications, including Microsoft® Word, Microsoft® 
PowerPoint, Microsoft® Excel, MatchWare Mediator, Microsoft® Outlook and Microsoft® Project. You can 
also create MindView documents by importing XML files. 

The import options offered by MindView are all described in detail in the next topics. 

Importing from Microsoft Word 

 MindView lets you import Microsoft® Word documents. 

This is particularly useful when: 

• You have a Word document which you would like to restructure using the brainstorming capabilities and 
features of MindView before exporting it again to Word. 

• You have exported a MindView Mind Map to Word, developed some of the topics in Word, but then 
realized you need to review the structure of your map in MindView before doing any further work in Word. 

In both cases, MindView allows you to import the Word document into a new Mind Map, preserving the text 
added in Word together with its formatting as far as possible. Pictures, comments and hyperlinks added in Word 
are also preserved wherever possible. 

If the Word document was created by exporting a MindView Mind Map to Word, the new Mind Map will have 
the same branch structure and layout as the original Mind Map. 

If you then re-export the new Mind Map to Word after having made the required changes in MindView, any 
elements added in MindView are exported to the new document. 

For more information about the elements that MindView is not able to preserve, see "Limitations" below. 

 You do not need to have Microsoft Word installed on your computer in order to import a Word document 
into MindView. MindView can import documents created with Microsoft Word 2007 and above in the .docx 
format. If you are using an earlier version of Word, you can use the free Microsoft Office Compatibility pack to 
convert the document from its .doc format to the newer .docx format prior to importing. 

Although MindView can import any Word document, a useful branch structure can only be created if the 
document is organized in paragraphs containing headings defined with the Microsoft Word heading styles 
"Heading 1" through to "Heading 9". 

MindView imports each paragraph of the Word document as a branch at the relevant level. In other words 
paragraphs with a Heading 1 title become main branches, paragraphs with a Heading 2 title become sub-
branches, paragraphs with a Heading 3 title become sub-sub-branches and so on. 

If the Word document starts with a main heading with the style "Title", then this heading is used as the root 
name. Otherwise the name of the Word document is used as the root name. 

Procedure 
 Click the MindView Button. 

 Choose Import | Microsoft Word. 

 Select the Word document you want to import. 

 Specify a destination folder and filename for the MindView document to be created. 
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 Click Import. 

There may be elements of the Word document that MindView is not able to import. If this is the case, MindView 
displays a Warning dialog listing these elements. See "Limitations" below for more information. 

 

  When exporting a Mind Map to Word, MindView inserts bookmarks in the Word document to keep track 
of how the various elements should be re-imported back into MindView if you choose to do so. You should take 
care not to delete these bookmarks, which are hidden by default. To make them visible while you work, check 
'Show bookmarks' in the Advanced panel of the Word Options dialog. 

Relationship between Word and MindView elements and objects 
The following table indicates how MindView converts the various elements of your Word document to 
MindView elements and objects. 

Word element Imported in MindView as 

Title 

(with Title style) 

Root of the Mind Map 

• If the Word document does not contain a Title heading at its very 
top, the name of the Word document is used as root name.  

• If the Word document contains more than one Title heading, each 
such heading is imported as a text note of the corresponding higher 
level branch. 

Heading 1 

(with Heading 1 style) 

Main branch 

Heading 2 

(with Heading 2 style) 

Sub-branch of the corresponding higher level branch 

and so on until…  

Heading 9 

(with Heading 9 style) 

Sub-branch of the corresponding higher level branch 
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Regular text • If the document was created in Word, imported as a text note of the 
corresponding branch 

• If the document was created by exporting an original MindView 
Mind Map, imported as text note or floating comment of the 
corresponding branch as in the original document 

Picture embedded in 
paragraph heading 

Floating picture of the corresponding branch 

Picture embedded in 
body text 

• If the document was created in Word, imported as a picture 
embedded in a text note of the corresponding branch 

• If the document was created by exporting an original MindView 
Mind Map, imported as branch picture, floating picture or attached 
picture file of the corresponding branch as in the original document 

Comment Pop-up comment for the corresponding branch 

Intra-document cross 
reference to heading with 
style Title or Heading 1 
to 9 

Branch connection between the relevant branches 

Hyperlink Hyperlink in text note of the corresponding branch 

Limitations 
The following limitations apply when importing a Word document into MindView: 

• Indexes, tables of contents, tables of authorities, tables of figures, headers and footers are not imported. 

Note that you can choose to have the Table of Contents regenerated automatically when re-exporting the 
Mind Map to Word. 

• Sounds and videos that are embedded in the Word document are not imported in MindView. To import such 
elements in the MindView Mind Map, make sure they are inserted in the Word document as hyperlinks. 

• Editable Word shapes such as AutoShapes, Text Effects (WordArt) and diagrams are imported in the 
MindView document as pictures. This means that when re-exported to Word, they become standard pictures 
and do not keep their original editable properties. 

• Mathematical symbols are not imported. 

In addition, if you are importing a document created from an original MindView Mind Map, the following 
limitations apply: 

• Pop-up comments will not retain their original size and position. 

• Pictures embedded in the Word document as a result of the export from MindView do not retain their file 
name information. When re-importing the document, MindView creates new files for these pictures. 

• If you chose to include a picture of the whole Mind Map in the Word document when exporting from 
MindView, this picture is not re-imported back into MindView. 

Importing from Microsoft PowerPoint 

 MindView lets you import Microsoft® PowerPoint presentations. 

This is particularly useful when: 

• You have a PowerPoint presentation which you would like to expand using the brainstorming capabilities 
and features of MindView before exporting it again to PowerPoint. 
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• You have exported a MindView Mind Map to PowerPoint, worked on the layout in PowerPoint, but then 
realized you need to review the structure of your map in MindView before doing any further work in 
PowerPoint. 

In both cases, MindView allows you to import the PowerPoint presentation into a new Mind Map, preserving as 
much of the layout and contents of the PowerPoint presentation as possible. 

If the PowerPoint presentation was created by exporting a MindView Mind Map to PowerPoint, the new Mind 
Map will have the same branch structure and layout as the original Mind Map. 

If you then re-export the new Mind Map to PowerPoint after having made the required changes in MindView, 
any elements added in MindView are exported to the new presentation. 

For more information about the elements that MindView is not able to preserve, see "Limitations" below. 

 You must have Microsoft PowerPoint installed on your computer in order to import a PowerPoint 
presentation into MindView. MindView supports all Microsoft PowerPoint versions from 2000 onwards. 

Procedure 
 Click the MindView Button. 

 Choose Import | Microsoft PowerPoint. 

 Select the PowerPoint presentation you want to import. 

 Select the destination folder, i.e. the folder for the MindView document created from the PowerPoint 
presentation. 

 (optional) If you want to import the bullet lists that may be included on the PowerPoint slides as sub-
branches of the corresponding branches, check Import bullets as branches. If you leave this box 
unchecked, the bullet lists that may be included on the PowerPoint slides are inserted as text notes on the 
corresponding MindView branches. 

 

 Click Import. 

MindView creates a sub-folder named 'MVPPImport' within the destination folder and places in it the new 
MindView document as well as any pictures or other objects such as sounds or videos embedded in the 
PowerPoint presentation. 

There may be elements of the PowerPoint presentation that MindView is not able to import. If this is the case, 
MindView displays a 'PowerPoint Import Warnings' dialog listing these elements. See "Limitations" below for 
more information. 
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Import modes 
The Import operation has two modes depending on how the PowerPoint presentation was created: 

• The PowerPoint presentation was originally created in PowerPoint 

In this mode, the title of the first slide becomes the root name of the new MindView document. If you have 
checked the 'Import bullets as branches' option, each bullet list item of that first slide becomes a new main 
branch. If not, the entire bullet list is imported as a text note for the root. 

All the other slides are imported as further main branches. If you have checked the 'Import bullets as 
branches' option and some of those slides contain bullet lists, each bullet list item becomes a sub-branch of 
the corresponding MindView branch. If not, the entire bullet list is imported as a text note for the branch. 

• The PowerPoint presentation was created by exporting a MindView document 

In this mode, the original branch structure of the MindView document is preserved, provided that you have 
not removed any slide. If you have added new slides, they are imported as main branches. 

Relationship between PowerPoint and MindView elements and 
objects 
The following table indicates how MindView converts the various elements of your PowerPoint presentation to 
MindView elements and objects. 

PowerPoint element Imported in MindView as 

Slide Branch 

Slide title Branch title 

Slide sub-title Text note 

Slide body text Text note 

Slide bullet list • If the presentation was created in PowerPoint and you checked 
'Import bullets as branches' in the Import dialog, each bullet is 
imported as a sub-branch. If you didn't check 'Import bullets as 
branches', the entire bullet list is imported as a text note for the 
branch. 

• If the presentation was created by exporting an original MindView 
document, the branch structure of the Mind Map is recreated from 
the slide titles, not from the bullet list. The text of the bullet list is 
therefore ignored. 

Slide comment Floating comment 

Slide notes Pop-up comment 

Embedded picture • If the presentation was created in PowerPoint, imported as an 
attached picture object stored in the 'MVPPImport' folder 

• If the presentation was created by exporting an original MindView 
document, imported as a branch picture or floating picture as in the 
original document 
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Autoshape Attached picture object stored in the 'MVPPImport' folder 

Linked picture Attached picture object pointing to the original path 

Embedded video Attached video object pointing to the original path 

Embedded sound Attached sound object stored in the 'MVPPImport' folder 

Link to slide Branch connection 

Limitations 
The following limitations apply when importing a PowerPoint presentation into MindView: 

• The formatting of the slide title and of any slide notes included is not preserved. 

• If the layout of the PowerPoint slide contains more than one bullet list, only the first bullet list is taken into 
account by the import. 

• When importing bullets as branches, indented bullets within the main bullet list are imported as branches of 
the same level as the main bullets, not as sub-branches. 

• PowerPoint master slides are not taken into account by MindView. Their contents are therefore not imported 
into the MindView document. 

• Although hyperlinks contained in PowerPoint text objects are imported into the corresponding MindView 
text note, only their formatting is preserved. The links themselves are not preserved. 

• The following PowerPoint objects are imported as pictures in the MindView document and listed in the 
'PowerPoint Import Warnings' dialog: 

• AutoShapes 
• OLE controls, embedded OLE objects and linked OLE objects 
• Diagrams 
• Tables 
• Text Effects (WordArt) 
All other unknown shapes also cause the display of the 'PowerPoint Import Warnings' dialog, but are 
otherwise ignored. 

• If you are using PowerPoint 2003 and above, the picture files that are created in the 'MVPPImport' folder 
have the .PNG extension. This means they can be stretched with antialiasing, resulting in higher quality. 
With PowerPoint 2000, the picture file format used is .GIF. This file format cannot be stretched with 
antialiasing. 

In addition, if you are importing a presentation created by exporting a MindView document, the following 
limitations apply: 

• If you delete one or more slides while working in PowerPoint, MindView is not able to recreate the branch 
structure exactly as in the original Mind Map: 

• If you delete the slide corresponding to the root branch, all the slides are imported as main branches, as 
if you had created the presentation from scratch in PowerPoint. 

• If you delete slides corresponding to branches with sub-branches, MindView cannot recreate the 
structure of these sub-branches. 

• Similarly, if you rearrange the slides in a different order in PowerPoint, MindView does not take the new 
order into account. 

• Since MindView uses the PowerPoint slide titles to recreate the branch structure, any changes you make to 
the bullet list text in PowerPoint will not be preserved in MindView. 

• Pop-up comments will not retain their original size and position. 
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• Pictures embedded in the PowerPoint presentation as a result of the export from MindView do not retain 
their original file name or path information. When re-importing the presentation, MindView creates new 
files for these pictures in the 'MVPPImport' folder. 

• If you chose to include a picture of the whole Mind Map in the PowerPoint presentation when exporting 
from MindView, the slide containing this picture is not re-imported back into MindView. 

Importing from Microsoft Excel 

 MindView lets you import Microsoft® Excel spreadsheets. The spreadsheet might be one that was 
previously exported from MindView, or one that you are bringing into MindView for the first time. 

 You must have Microsoft Excel 2003 or above installed on your computer in order to use this import mode. 

To ensure a successful import, your spreadsheet should have one of the following layouts: 

 

If your spreadsheet does not follow one of these layouts, Mind View will nevertheless attempt to import it, 
following information you supply on the Import dialog (see below). 

The diagrams above show how the contents of the spreadsheet will be imported to a Mind Map. For example, the 
contents of the cell labeled 'Root' provides the label for the root of the imported Mind Map. Whatever is in the 
cells labeled 'Main' in the diagram will be imported as main branches, and whatever is in the cells labeled 'Sub' 
will be imported as sub-branches. The contents of the cells labeled 'Data' will be imported as branch data, with 
the contents of the cells labeled 'Heading 1', 'Heading 2' and so on providing the labels for the data or calculation 
fields. If the headings are standard MindView task data headings (Start, End, Duration, Completion, Priority or 
Resources) the data will be imported to the appropriate locations in MindView. If the headings are not standard 
MindView ones the data will be imported as calculation values. See "Inserting task data" and "Inserting 
calculation values" for more information on these topics). 

• In the Structured layout you use the columns on the left to contain the text that will become root and 
branch labels, and also indicate the hierarchy. The first column contains the root, the second column the 
main branches, the third column first level sub-branches, and so on. 

• In the Numbered layout you use the second column to contain the text that will become branch labels, 
while the numbers in the first column (which must also be formatted as text) indicate the hierarchy. The 
numbers take the form number.number.number…, the dots marking a change of level in the hierarchy. The 
following diagram shows how cells in an Excel document (left) import to a Mind Map (right): 
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The root is not included in the numbering scheme. 

• In the Flat layout, the leftmost column contains the text that will become branch labels. After the root, each 
entry is imported as a main branch. No sub-branches are created. 

If your spreadsheet does not have one of these layouts, you may nevertheless be able to import it by indicating 
manually on the import dialog which areas of the spreadsheet represent branch text, which represent data fields 
and so on (see below).  

Procedure 
 Click the MindView Button. 

 Choose Import | Microsoft Excel. 

You will see a dialog box reminding you of the preferred layouts, described above. 

 Select the Excel document you want to import and click OK. 
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 If necessary, adjust the colored areas that indicate how the spreadsheet contents will be mapped to the Mind 
Map. To do this, select an area and click the appropriate color button. You can resize the dialog if you need 
to. 

• The contents of the orange cell in the top left becomes the title of the Mind Map. 
• The contents of the cells in the light blue area become the root and branch labels. By adjusting this area 

you can choose to import all branches or a subset of branches, but the area must not contain any blank 
rows. If the leftmost column in the area contains just one filled cell, the content of that cell becomes the 
root label. If the leftmost column in the area contains more than one filled cell, the contents of those 
cells become first level branches under a root whose label is taken from the title cell. 

• The contents of the cells in the yellow area become data values or calculation values, depending on the 
column headings (see below). By adjusting the yellow area you can specify which data columns are to 
be imported. 

• The contents of the dark blue area are headings for the data columns. If the headings are standard 
MindView task data headings (Start, End, Duration, Completion, Priority or Resources) the data will be 
imported to the appropriate locations in MindView. If the headings are not standard MindView ones the 
data will be imported as calculation values. See "Inserting task data" and "Inserting calculation values" 
for more information on these topics). 

If you select an area that MindView cannot interpret, you will see a message "Invalid branch layout". 
Common reasons for this message are: 

• You have data in cells that should be empty.  
• You have empty cells, for example blank rows, where data is expected. 
• In a structured layout, you have skipped one or more levels. 

 224



• In a numbered layout, the first column does not contain text in the form of number(s) separated by dots. 
Every number in this column must be in text format, not in number format. 

• In a numbered layout, the cell to the left of the root label is not blank. 
To overcome the problem adjust one or more of the colored areas, or click Cancel, adjust the layout of the 
source spreadsheet, and try importing again. 

To reset the areas to their state when you opened the dialog, click Reset. 

 Click OK. 

The imported spreadsheet opens in the Mind Map view. 

Importing from Microsoft Outlook 

 MindView lets you import Microsoft® Outlook task lists. This is particularly useful when for instance: 

• You have started a task list in Microsoft Outlook which you would like to expand using the brainstorming 
capabilities and features of MindView. 

• You have exported a MindView task list to Microsoft Outlook, starting adding tasks or editing existing ones, 
but then realized you need to review the structure of your task list in MindView before doing any further 
work in Microsoft Outlook. 

In both cases, MindView allows you to import the Microsoft Outlook task list as a new document in the Mind 
Map view. 

Once you have made the required changes in MindView, you can either re-export the task list to Outlook as a 
new series of tasks, or synchronize the edited MindView version with the original Outlook version. For more 
information on exporting and synchronizing, see "Exporting to Microsoft Outlook". 

 You must have Microsoft Outlook 2000 or above installed on your computer in order to use this import 
method. 

Procedure 
 Click the MindView Button. 

 Choose Import | Microsoft Outlook. 

 Select the Outlook task folder whose tasks you want to import. 

 If the Outlook folder contains tasks that you have already imported to a MindView document or 
exported from a MindView document previously, you might prefer to find the MindView document in 
question and synchronize the task folder with it rather than creating a new MindView document. 

The imported task list opens in the Mind Map view. 

Limitations 
Only the elements of the Microsoft Outlook task list that have an equivalent in MindView are imported and 
shown in the Task/Timeline Info panel: 

• Task names, dates, durations, priorities and completion levels are all imported. 

• Outlook task notes are imported as pop-up comments. 

• Other information corresponding to features that are not supported in MindView, such as status, reminders, 
categories and so on, as well as any user-defined field, is not imported. 
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Importing from Microsoft Project 

 MindView lets you import Microsoft® Project plans. This is particularly useful when for instance: 

• You have started a project plan in Microsoft Project which you would like to expand using the 
brainstorming capabilities and features of MindView. 

• You have exported a MindView project plan to Microsoft Project, starting adding tasks or editing existing 
ones, but then realized you need to review the structure of your plan in MindView before doing any further 
work in Microsoft Project. 

In both cases, MindView allows you to import the Microsoft Project plan as a new project plan in the Gantt 
view. 

 MindView does not support versions of Microsoft Project prior to 2003. You need to have Microsoft Project 
installed on your computer in order to use this export method. 

 You can also import Microsoft Project plans via XML. The advantage of this method is that you do not need to have 
Microsoft Project installed on your machine. See "Importing from XML" for more information. 

Procedure 
 Click the MindView Button. 

 Choose Import | Microsoft Project. 

 Select the Microsoft Project plan you want to import. 

The imported project plan opens in the Gantt view. 

Limitations 
The MindView Gantt view does not support all the project management features offered by Microsoft Project. 
This means that only the elements of the Microsoft Project that have an equivalent in MindView will be 
imported: 

• Task names, dates, durations, lead and lag times, resources, priorities, completion levels, links, constraints 
and so on are all imported. 

• Milestone tasks are imported, but their duration is set to zero. 

• The project calendar is imported. 

• Task notes are imported as pop-up comments. 

• Other Microsoft Project information corresponding to features that are not supported in MindView, such as 
task types, baselines, resource calendars, task calendars, detailed resource allocation information (work 
units, contours, cost etc.) is not imported. Information derived from tracking and leveling operations in 
Microsoft Project is not imported. 

In most cases, the tasks dates and scheduling information will be identical in MindView and in Microsoft 
Project. They may differ if advanced operations not supported by MindView (such as leveling or tracking) have 
been performed on the project in Microsoft Project. 

Importing from Mediator 

 MindView lets you import Mediator presentations. 

This is particularly useful when: 

• You have a Mediator presentation which you would like to expand using the brainstorming capabilities and 
features of MindView before exporting it again to Mediator. 
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• You have exported a MindView Mind Map to Mediator, added interactivity to it in Mediator using events 
and actions, but then realized you need to review the structure of your map in MindView before doing any 
further work in Mediator. 

In both cases, MindView allows you to import the Mediator presentation into a new Mind Map, preserving as 
much of the structure and contents of the Mediator presentation as possible. 

If the Mediator presentation was created by exporting a MindView Mind Map to Mediator, the new Mind Map 
will have the same branch structure and layout as the original Mind Map. 

If you re-export the new Mind Map to Mediator after having made the required changes in MindView, any 
elements added in MindView are exported to the new presentation. Note that although MindView creates a new 
Mediator presentation when re-exporting, the original Mediator document must remain accessible. If it is no 
longer accessible, MindView cannot preserve the elements of the original presentation that are specific to 
Mediator (such as events and actions or Mediator objects that have no equivalent in MindView). 

For more information about the elements that MindView is not able to preserve, see "Limitations" below. 

 You must have Mediator 8 with Service Pack 3 or above installed on your computer in order to import a 
Mediator presentation into MindView. 

This free Mediator 8 update is available on the MatchWare web site at:  

http://www.matchware.com/en/support/servicepacks/mediator8.htm 

If the Mediator presentation was created by exporting a MindView 3 Mind Map to Mediator, you will need to 
have Mediator 9 or above installed in order to re-import it into MindView. 

MindView imports the first Mediator page as the root of the new MindView document, and all the other 
Mediator pages of the same level as further main branches. Mediator sub-pages become sub-branches of the 
corresponding MindView branch and so on. 

Procedure 
 Make sure the Mediator presentation to be imported is not already open in Mediator. 

 Click the MindView Button. 

 Choose Import | MatchWare Mediator. 

 Select the Mediator presentation and click Open. 

MindView creates a new document and import the Mediator presentation into it. 

Relationship between Mediator and MindView elements and objects 
The following table indicates how MindView converts the various elements of your Mediator presentation to 
MindView elements and objects. 
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Limitations 
The following limitations apply when importing a Mediator presentation into MindView: 

• If the first page in the Mediator presentation contains sub-pages, these sub-pages are not imported. 

• When importing a Mediator hypertext object into MindView, the hypertext object is converted to a text note. 
This means that any events and actions that may be associated with it in the original Mediator presentation 
are not preserved when re-exporting the MindView document to Mediator. 

• Once the presentation is imported into MindView, if you change the name of a branch and re-export the 
presentation, the Description field of the corresponding Mediator page will be changed to the new name, but 
the Page name will remain unchanged. 

In addition, if you are importing a Mediator presentation created by exporting an original MindView Mind Map 
to Mediator, the following limitations apply: 

• When exporting a Mind Map to Mediator, MindView places special tags formatted with # signs in the Notes 
tab of the Properties dialog of particular elements of the new Mediator presentation, including the pages 
themselves. These tags contain information required by MindView to re-import the Mediator presentation. If 
you delete one or more of these tags by accident, MindView will not be able to recreate the corresponding 
element(s) exactly as in the original Mind Map. 

Mediator element Imported in MindView as 

Page Branch 

Note that the Mediator page description is used as the branch name. If 
the Description field is empty, then the page name is used. 

Page note 
(Notes tab of the 
Properties dialog) 

Pop-up comment 

Picture object • If the presentation was created in Mediator, imported as an attached 
picture object 

• If the presentation was created by exporting an original MindView 
document, imported as a branch picture, floating picture or attached 
picture object as in the original document 

Text object • If the presentation was created in Mediator, imported as a text note 
for the branch 

• If the presentation was created by exporting an original MindView 
document, imported as a text note or as a floating comment as in 
the original document 

Hypertext object Text note 

Button object • If the presentation was created in Mediator, not imported 

• If the presentation was created by exporting an original MindView 
document, imported as a branch connection, an attached text object 
or an attached sound object as in the original document 

Flash object Attached Flash object 

Media Player object Attached video object 

All other Mediator 
objects and elements 

These are not imported. They are however preserved if you re-export 
the MindView document to Mediator, provided that the original 
Mediator document is still accessible. 
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• When exporting a Mind Map to Mediator, MindView hyperlinks, branch connections, attached text files and 
attached sound files are converted to Mediator buttons containing the relevant events and actions. An 
attached sound object in the MindView document for instance becomes a button with a Mouse Click event 
and a Sound action in the Mediator presentation. If you delete or move these events and actions while 
working in Mediator, although MindView will be able to recreate the original object, the link path will be 
lost. 

Importing from XML 
This import method lets you create MindView documents by importing files in various XML formats into 
MindView. 

MindView supports the following XML import file types: 

• MindView XML: This file type allows you to open MindView documents previously exported in the 
MindView XML format. 

• Microsoft Project XML: This file type allows you to create a MindView project plan by importing a 
Microsoft® Project plan exported from Microsoft Project in the XML format. You can use the Microsoft 
Project XML import method even if you do not have Microsoft Project on your computer. It is therefore a 
useful alternative to importing a Microsoft Project plan in the .mpp format, for which you do need to have 
Microsoft Project installed on your computer. 

The same limitations apply when importing a Microsoft Project XML file as when importing a Microsoft 
Project .mpp file. For more information, see "Importing from Microsoft Project". 

 MindView does not support versions of Microsoft Project XML prior to 2003. 

• MindManager XML: This file type allows you to create a MindView document by importing a 
MindManager® document exported from MindManager in the XML format. You can use the MindManager 
XML import method even if you do not have MindManager on your computer. 

Note that elements of the MindManager file that do not have an equivalent in MindView are not imported. 
MindView supports MindManager XML files from versions X5 and 6. 

• MindManager MMAP: This file type allows you to create a MindView document by importing a 
MindManager® document in the .mmap format. You can use the MindManager MMAP import method 
even if you do not have MindManager on your computer. 

Note that elements of the MindManager file that do not have an equivalent in MindView are not imported. 
MindView supports MindManager .mmap files from versions X5 and 6. 

Procedure 
 Click the MindView Button. 

 Choose Import | XML. 

 Choose the required import file type in the Type field. 

 The Autodetect XML file type presented by default lets MindView detect automatically the type of the XML file 
you specify, provided that it is one of the supported XML file types. 

 Click OK. 

The imported file opens in the Mind Map view. 
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Working in Pen Mode 

 MindView 3 supports pen input as well as standard keyboard/mouse input, letting you insert digital ink 
data such as handwritten text and hand-drawn pictures on your branches. Although MindView's pen input 
features let you treat your computer mouse as a pen, they are designed for use with dedicated pen input devices 
such as tablet PC's, external digitizers, touch screens and interactive whiteboards. The only requirement is that 
the operating system on which MindView is installed must also support pen input (e.g. Windows XP Tablet PC 
Edition, all editions of Windows Vista with the exception of the Home Basic and Starter editions, Windows 7). 

Once attached to a branch, the ink data is treated just as any other branch element. 

 You can use pen input only in the standard Mind Map views, namely Mind Map, Top Down and Left/Right. 

Enabling pen input 
Before you can use your mouse or pen as input device, you must enable pen input. 

If your computer supports pen input, the MindView Options dialog contains an extra panel for the pen input 
options. 

To access this tab: 

 Click the MindView Button. 

 Click MindView Options in the bottom right. 

 Click the panel Pen Input. 

 

Enable pen input: Check this box to enable pen input. When pen input is enabled, a Pen Mode button appears 
in the bottom right corner of the MindView status bar, allowing you to set Pen Mode on and off.  

 

Enable gestures: When this option is enabled, you can perform the MindView actions listed in the paragraph 
"Using gestures" below by making the corresponding gesture with your input device. 

Recognizer: This is the active recognizer used to convert the ink data to text. Click the right arrow to see the list 
of handwriting recognizers installed on the computer and choose the recognizer corresponding to your language. 

Default picture size for floating pictures: When you use your pen to draw pictures, it is often easier to make 
large drawings. You can use this field to define a factor which MindView will automatically use to reduce your 
hand-drawn pictures before attaching them to the selected branch. 
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Using Pen Mode 
When pen input is enabled, a Pen Mode button is shown in the bottom right corner of the status bar. 

 Click it to enable Pen Mode. 

The Ink Tools tab appears in front of the Home tab on the ribbon. 

 

You can now use your input device to start writing or drawing on the free space available in the view (i.e. not on 
top of a branch, floating comment, floating picture or other MindView element). 

 Before you start writing or drawing, you can use your input device to select the branch to which you want to 
add the ink data. After your first stroke, you are free to draw anywhere on the workspace, including on top of 
branches or other MindView elements. 

 As you start writing or drawing, MindView attempts to interpret the ink data as text and displays the result in the "Ink to 
Text" field shown just below the ribbon. This lets you correct any misinterpretation by deleting the last stroke or strokes until 
you obtain the required result.  

 

Here is a short description of the tools contained in the Ink Tools tab: 

• As in the Home and Insert tabs, the Branch icon  lets you add a branch at the same level as the selected 
branch, and the Sub-Branch icon  lets you add a sub-branch to the selected branch. 

• The icons contained in the Add Ink to Selected Branch group are only enabled when you have selected a 
branch and drawn at least one stroke: 

 Branch Label: Click this icon to convert the ink data to text and use it as branch label for the selected 
branch. 

 Comment: Click this icon to convert the ink data to text and add it to the selected branch as pop-up 
comment. 

 Floating Comment: Click this icon to convert the ink data to text and add it to the selected branch as 
floating comment. You can then move the floating comment on the workspace just as you would in standard 
mouse input mode. 

 Text Note: Click this icon to convert the ink data to text and add it to the selected branch as text note. 

 Branch Picture: Click this icon to convert the ink data to a picture (.png) and insert it on the selected 
branch as branch picture. 

 Floating Picture: Click this icon to convert the ink data to a picture (.png) and add it to the selected 
branch as a floating picture. The picture is reduced by a predefined factor, which you can modify in the 
MindView Options dialog as described above in the paragraph "Enabling pen input". You can then move the 
floating picture on the workspace just as you would in standard mouse input mode. 

• The Color and Weight icons of the Format group let you redefine respectively the color and the width of the 
pen. 

• To delete the last stroke drawn, click the Delete Last Stroke icon . 
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• The Delete All Strokes icon  removes from the workspace all the ink data that has not yet been converted 
to a MindView. 

Using gestures 
As well as using the commands above, you can use pen movements, also called "gestures", to perform particular 
actions. For this to work, you must enable gestures in the MindView Options dialog, as described above in the 
paragraph "Enabling pen input". 

 Gestures are only recognized when done as a first stroke.  

Here is a list of the gestures you can use: 

     Gesture Name Action Drawing Method 

 

Scratch-out Delete Draw at least 3 strokes, as horizontal 
as possible. 

 

Curlicue Cut Draw the curlicue at an angle, from 
bottom left to top right. 

 

Double-Curlicue Copy Draw the double-curlicue at an 
angle, from bottom left to top right. 

 

Caret Paste Draw both sides with equal length, 
with a sharp angle. You can draw in 
either direction. 

 

Left-semicircle Undo Draw the semicircle from right to 
left. The two ends should be on the 
same horizontal line. 

 

Right-semicircle Redo Draw the semicircle from left to 
right. The two ends should be on the 
same horizontal line. 

 

Right Insert Branch Draw a single line from left to right. 

 

Down-right Insert Sub-Branch Start with the down stroke, without 
lifting the pen. Draw the two sides 
with equal length and at a right 
angle. 
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Square Insert New Root Draw the square from the upper left 
corner, without lifting the pen. You 
can draw in either direction. 

 
Using the Tablet PC Input Panel 
As well as using your pen to input text into MindView, you can also use the Windows built-in Tablet PC Input 
Panel. On Microsoft Vista and Windows 7, this panel can also be used to edit existing text. 

 

If for instance you use your pen to select a part of a branch label that you want to edit, the text will be shown in 
the Windows Tablet PC Input Panel. Conversely any change you make to the text shown in the panel is reflected 
on the branch label. 

You can use the same method for text notes, comments and anywhere else in MindView where you can input 
text, including all edit fields. 

Using an interactive whiteboard 
MindView is able to detect and support interactive whiteboards. All the operations described above are 
supported. 

If you are using a SMART Board, MindView automatically switches to Pen Mode when you pick up a pen from 
the pen tray. In addition, MindView automatically sets its pen color and width to the color and width of the pen 
you picked up. When no pen is picked up (or when you pick the eraser pen), a default black color is used.  

The pen can also be used to navigate the MindView ribbon and menus in the same way as when using a mouse. 

To do a right click, you can press the right click button of the pen tray, use the SMART Board Tools menu, or do 
a slow click with the pen by pressing it and holding it down for a few seconds. 
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Reference 

The reference section contains a description of the following MindView features: 

• Properties 

These topics give a full description of the properties applicable to each of the MindView elements, such as 
the view itself, the root, the branches and the various objects. 

• Shortcuts 

This topic lists all the keyboard shortcuts provided by MindView. 

Properties 

Overview 

 The Properties dialog shows the properties of the MindView element currently selected, for example the 
root, a branch or a floating comment. If nothing is selected the properties of the current view are shown. 

You can use the Properties dialog to make fine-tuning changes to these elements, as described in "Using the 
Properties dialog." 

 Rather than applying properties one by one to enhance the visual aspect of your branches, it is normally easier to use 
the Format tab shown at the right of the ribbon when the branch is selected. Using this tab, you can apply branch shapes, 
branch colors and other coordinated attributes in one step. Similarly, the Design tab lets you apply predefined layouts and 
styles to the entire map in one step. 

The topics of this section describe in detail the properties shown in the Properties dialog for the various 
MindView elements. 

Notes: 

• If the Properties dialog is not visible, choose View | Show/Hide | Properties to open it. 

• The properties described are not always applicable to all views. The Properties dialog only lists the 
properties applicable to the selected element in the current view. 

View 
View properties: General tab 
When you click the workspace (in other words away from the root or any branch), the following properties are 
shown in the Properties dialog. 

 

Page Color: Click the small rectangle to choose a new color for the workspace. 
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Word Wrap Text: Check this box if you want the text to wrap automatically to the next line when you enter 
long branch names. This setting applies to all the branches of your document. 

Show Duration Bars: (Timeline view only) If you have entered both a start time and an end time for a particular 
event, you can use this property to show the duration of the event as a bar below the time axis. 

Show Title: (Timeline view only) By default, the timeline displays the root name as title, or, if you are focusing 
on a particular branch, the name of that branch. You can use this property to change the title position or to 
remove the default title altogether. 

Show Time Breaks: (Timeline view only) You can use this property to replace any empty space on the time axis 
with one or more break marks. This optimizes the use of the horizontal space when events are not evenly 
distributed along the timeline. 

Critical Path Color: (Gantt view only) Click the small rectangle to choose a different color for the tasks 
highlighted when viewing the project's critical path (to display the critical path, choose Gantt Tools | View | 
Show Critical Path). 

Today's Date Color: (Gantt view only) Click the small rectangle to choose a different color for the vertical line 
displayed on the Gantt chart to highlight the current date (to display the current date, choose Gantt Tools | View | 
Show Today's Date). 

View properties: Branches tab 
The Branches tab of the View properties dialog allows you to define default properties for the branches of your 
map. 

 

Vertical Branch Gap: This value represents the vertical spacing between each set of branches. The default 
value depends on the view used. 

Horizontal Branch Gap: This value represents the horizontal spacing between each set of branches. The default 
value depends on the view used. 

Show Branch Connections: This box is checked by default. Uncheck it if you do not want branch connections 
to be visually represented on your map. See "Creating branch connections" for more information. 

Auto-Layout: By default, MindView automatically arranges the main branches as you insert them to prevent 
any overlap. You can however choose to reposition the main branches yourself after their insertion by 
unchecking this box to disable the auto-layout mode. See "Moving a branch" for more information. 

Root 
Root properties: General tab 
When you select the main root or any other root contained on your map, the following properties are shown in 
the Properties dialog. 
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Text: This property shows the label of the currently selected root. You can edit it or enter a new label by typing 
in the input field. If you have split a long label on several lines by pressing Ctrl + Enter at the end of each line 
when creating the branch (rather than let the label wrap automatically), this field will not be editable and will 
only contain the first line of the label. 

Fill Type: Choose the fill type required for the space enclosed by the root outline. 

Fill Color 1: Click the small rectangle to choose a new fill color. 

Fill Color 2: This property only appears if you have chosen a gradient fill type. It lets you choose the end color 
for the gradient. 

Fill Mode: This property only appears if you have chosen a gradient fill type. It lets you choose the direction of 
the gradient. 

Outline Color: Click the small rectangle to choose a new outline color. 

Outline Width: This value defines the width of the outline. 

Root properties: Text tab 
The Text tab of the Root properties dialog allows you to define all the properties related to the root label. 

 

Font Name: Click this field to choose a new font for the label. 

Font Size: Use this field to specify the font size. 

Bold/Italic/Underline/Strikethrough: Check the relevant box to enable the corresponding effect. 

Text Highlight Color: Click the small rectangle to choose a new color for the label background. 

Text Color: Click the small rectangle to choose a new color for the label. 

Alignment: This property lets you right-align, left-align or center the label within the root shape. 

Root properties: Picture tab 
The Properties dialog of the root only contains a Picture tab if you have inserted a branch picture on the root. 
The Picture tab allows you to define the properties related to the branch picture. 
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Picture Name: By default, this field shows the name of the picture file. You can however replace it with a name 
of your choice. 

• If you export your document to HTML, this picture name will also be inserted in the Alt meta-tag for the 
picture in the .html file. When viewing the HTML page in the browser and moving the mouse pointer over 
the picture, you will therefore see the name of the picture appear in a small frame under the picture. 

• Similarly, if you export your document to Mediator, the picture name will be inserted in the Notes tab of the 
Properties dialog of the picture in Mediator. 

Path: This shows the path of the picture. Enter a new folder and/or file name or click the Browse button  to 
choose a different picture. 

Width: This field shows the current width of the picture. You can resize the picture by entering a different value. 

Height: This field shows the current height of the picture. You can resize the picture by entering a different 
value. 

Aspect Ratio: This box is checked by default. Uncheck it if you do not want to preserve the proportions of the 
picture (in other words, the ratio between its width and its height) when resizing it. 

To reset the picture to its initial size, uncheck the box and check it again. 

Opacity: By default, this field has the value 100, which means that the picture is 100% visible. You can give it a 
transparency effect by entering a lower value, thereby decreasing its opacity. The value 1 means that the picture 
is completely transparent. 

Include in Export: This box is checked by default. Uncheck it if you intend to export your map to another 
format (HTML, Mediator, Word and so on) but do not want the branch picture to be exported. 

Branch 
Branch properties: General tab 
When you select a branch or sub-branch on your map, the following properties are shown in the Properties 
dialog. 
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Text: This property shows the label of the currently selected branch. You can edit it or enter a new label by 
typing in the input field. If you have split a long label on several lines by pressing Ctrl + Enter at the end of each 
line when creating the branch (rather than let the label wrap automatically), this field will not be editable and 
will only contain the first line of the label. 

Fill Type: Choose the fill type required for the space enclosed by the branch outline. 

Fill Color 1: Click the small rectangle to choose a new fill color. 

Fill Color 2: This property only appears if you have chosen a gradient fill type. It lets you choose the end color 
for the gradient. 

Fill Mode: This property only appears if you have chosen a gradient fill type. It lets you choose the direction of 
the gradient. 

Outline Color: Click the small rectangle to choose a new outline color. 

Outline Width: This value defines the width of the outline. 

Task Name Color: (Gantt view only) Click the small rectangle to choose a new color for the task name 
displayed after the task bar. 

Task Resources Color: (Gantt view only) Click the small rectangle to choose a new color for the task resources 
names displayed after the task bar. 

Line Color: Click the small rectangle to choose new color for the line connecting the branch to its parent 
branch. 

Line Width: Enter a value between 1 and 5 to specify the width of the line connecting the branch to its parent 
branch. 

Boundary: Check this box to show a boundary around the branch and all its sub-branches. 

The next fields only appear if you have checked the Boundary property. 

Boundary Fill Type: Choose the fill type required for the space enclosed by the boundary. 

Boundary Fill Color 1: Click the small rectangle to choose a new fill color. 

Boundary Fill Color 2: This property only appears if you have chosen a gradient fill type. It lets you choose the 
end color for the gradient. 
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Boundary Fill Mode: This property only appears if you have chosen a gradient fill type. It lets you choose the 
direction of the gradient. 

Boundary Outline Color: Click the small rectangle to choose a new color for the boundary outline. 

Boundary Outline Width: Enter a value between 1 and 5 to define the width of the boundary. 

Boundary Outline Roundness: Enter a value between 1 and 50 to define how rounded the corners of the 
boundary should be. 

Boundary Outline Dash Style: Click the down arrow to choose a style for the boundary. 

Include in Export: This box is checked by default. Uncheck it if you intend to export your map to another 
format (HTML, Mediator, Word and so on) but do not want the branch and all its sub-branches to be exported. 

Branch properties: Text tab 
The Text tab of the Branch properties dialog allows you to define all the properties related to the branch label. 

 

This tab is identical to the Text tab of the root. See "Root properties: Text tab" for more information. 

Branch properties: Picture tab 
The Properties dialog of a particular branch only contains a Picture tab if a branch picture has been inserted on 
the branch. The Picture tab allows you to define the properties related to the branch picture. 

 

This tab is identical to the Picture tab of the root. See "Root properties: Picture tab" for more information. 

Text note 
Text note properties: General tab 
When you select a text note in the Object list of a branch, the following properties are shown in the Properties 
dialog. 
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Name: This shows the default name of the text note. You can edit it or enter a different name to help you 
identify the text note. 

Include in Export: This box is checked by default. Uncheck it if you intend to export your map to another 
format (HTML, Mediator, Word and so on) but do not want the text note to be exported. 

Floating comment 
Floating comment properties: General tab 
When you select a floating comment on the workspace, the following Properties dialog is shown. 

  

Text: This shows the contents of the comment. You can edit it by typing in this field. 

Outline Color: Click the small rectangle to choose a new color for the frame surrounding the comment.  

Outline Width: Edit this field to increase or decrease the width of the frame surrounding the comment. 

The next three properties only appear if the floating comment is connected to a branch. 

Line Color: Click the small rectangle to choose a new color for the line connecting the comment to the branch. 
  

Line Width: Edit this field to increase or decrease the width of the line connecting the comment to the branch. 

Include in Export: This box is checked by default. Uncheck it if you intend to export your map to another 
format (HTML, Mediator, Word and so on) but do not want the floating comment to be exported. 

Floating comment properties: Text tab 
The Text tab of the Floating comment properties dialog allows you to define all the properties related to the 
comment text. 
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Font Name: Click this field to choose a new font for the comment. 

Font Size: Use this field to specify the font size. 

Bold/Italic/Underline/Strikethrough: Check the relevant box to enable the corresponding effect. 

Text Highlight Color: Click the small rectangle to choose a new color for the comment background. 

Text Color: Click the small rectangle to choose a new color for the comment text. 

Text Wrap Width: This defines the length of text that can be typed before wrapping onto the next line. 

Alignment: This property lets you right-align, left-align or center the text of the floating comment within its 
frame. 

Floating picture 
Floating picture properties: General tab 
When you select a floating picture on the workspace, the following properties are shown in the Properties dialog, 
provided that the floating picture is connected to a branch. If the floating picture is not connected to any branch, 
the Properties dialog only shows the Picture tab. 

  

Line Color: Click the small rectangle to choose a new color for the line connecting the floating picture to the 
branch.   

Line Width: Edit this field to increase or decrease the width of the line connecting the floating picture to the 
branch. 

Include in Export: This box is checked by default. Uncheck it if you intend to export your map to another 
format (HTML, Mediator, Word and so on) but do not want the floating picture to be exported. 

Floating picture properties: Picture tab 
Clicking the Picture tab of the Floating picture properties dialog shows the following dialog. 

 

This tab is identical to the Picture tab of the root. See "Root properties: Picture tab" for more information. 

Attachment 
Attachment properties: General tab 
When you select an attachment in the Object list of a branch, the following properties are shown in the 
Properties dialog. 
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Name: By default, this field shows the name of the attached file. You can however replace it with a name of 
your choice to help you identify the attachment. 

If the attachment is a picture file, the name is also used as descriptive label when exporting to HTML or 
Mediator: 

• If you export your document to HTML, this picture name will also be inserted in the Alt meta-tag for the 
picture in the .html file. When viewing the HTML page in the browser and moving the mouse pointer over 
the picture, you will therefore see the name of the picture appear in a small frame under the picture. 

• If you export your document to Mediator, the picture name will be inserted in the Notes tab of the Properties 
dialog of the picture in Mediator. 

Path: This shows the path of the attached file. Enter a new folder and/or file name or click the Browse button 
 to choose a different file. 

Export As: By default, the attachment is exported in the format you define during the export procedure for all 
attachments of this type. This property however gives you the option to export the selected attachment in a 
different format. If for instance you choose during the HTML export procedure to export all text attachments as 
buttons, you can override this choice for the selected attachment, and choose instead to export it as a hyperlink. 

Include in Export: This box is checked by default. Uncheck it if you intend to export your map to another 
format (HTML, Mediator, Word and so on) but do not want the attached file to be exported. 

Hyperlink 
Hyperlink properties: General tab 
When you select a hyperlink in the Object list of a branch, the following properties are shown in the Properties 
dialog.  

 

Text: By default, this field shows the name of the hyperlink. If you export your map, it is the text that will make 
up the hyperlink. You can replace it with any other text as required. 

URL: This shows the URL of the hyperlink. You can edit this field as required or enter a new URL. 

Export As: By default, hyperlinks are usually exported as hyperlinks. This property gives you the option to 
override this default export format for the selected hyperlink, and export it instead as a button. 

Include in Export: This box is checked by default. Uncheck it if you intend to export your map to another 
format (HTML, Mediator, Word and so on) but do not want the hyperlink to be exported. 
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Branch connection 
Branch connection properties: General tab 
When you select a branch connection in the Object list of a branch, the following properties are shown in the 
Properties dialog. 

 

Name: This shows the name given to the branch connection, which by default is the name of the end branch. 

Line Color: This defines the color of the branch connection. Click the small rectangle to choose a new color. 

Line Width: Edit this field to increase or decrease the width of the branch connection. 

Active Color: This defines the color of the branch connection when hovered. 

Dash Style: This field lets you choose between various line styles. 

Include in Export: This box is checked by default. Uncheck it if you intend to export your map to another 
format (HTML, Mediator, Word and so on) but do not want the branch connection to be exported. 
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Keyboard shortcuts 

The table below lists all the keyboard shortcuts provided by MindView. 

Keyboard shortcut Description 

Enter Add a new branch at the same level as the selected branch 

Insert Add a new sub-branch to the selected branch 

Shift + Enter Add a new branch just before the selected branch 

Delete Delete the selected branch or element 

Up Select the branch placed above the currently selected branch 

Down Select the branch placed below the currently selected branch 

Left Select the branch to the left of the currently selected branch in the map 

Right Select the branch to the right of the currently selected branch in the map 

F1 Help 

F2 Edit the name of the selected branch or the selected floating comment 

F3 Toggle Focus Mode on and off 

F4 Resize the map so that it fits entirely in the workspace 

F6 Apply branch focus to restrict the display to the selected branch 

Ctrl + Shift + F6 Remove branch focus to display the entire map again 

F7 Spellcheck the document 

Ctrl + F7 Spellcheck the selected element 

F8 Toggle between selected branch and Text Note editor 

F9 Toggle Full Screen mode on and off 

F11 Insert or edit a pop-up comment on the selected branch 

F12 Specify a start time for the selected branch 

Ctrl + F12 Specify an end time for the selected branch 

Ctrl + A Select all branches 

Ctrl + F Find and replace text in document 

Ctrl + N Create a new document 

Ctrl + O Open and browse for an existing document 

Ctrl + P Print the active document 

Ctrl + S Save the active document 

Ctrl + Z Undo the last action 

Ctrl + Y Reverse the last Undo 

Ctrl + C Copy the selected data to the clipboard 

Ctrl + X Cut the selected data to the clipboard 

 244



Ctrl + V Paste the data contained in the clipboard to the selected destination 

Ctrl + Shift + C Copy the formatting from one element to another with the Format Painter 

Ctrl + F6 

Ctrl + Tab 

Go from one open document to the next 

Ctrl + F8 Open the Text Note editor to create a new text note 

Ctrl + Up Move the selected branch up (Mind Map, Left/Right and Outline views only) 

Ctrl + Down Move the selected branch down (Mind Map, Left/Right and Outline views only)

Ctrl + Left Move the selected branch left (Top Down view only) 

Collapses the selected branch (Outline view only) 

Ctrl + Right Move the selected branch right (Top Down view only) 

Expands the selected branch (Outline view only) 

Ctrl + Home Go to the first cell of the Outline (Outline view, Timeline view, Gantt view) 

Ctrl + End Go to the last cell of the Outline (Outline view, Timeline view, Gantt view) 

Ctrl + "+" 

Alt + mouse wheel 

Zoom in 

Ctrl + "-" 

Alt + mouse wheel 

Zoom out 

Ctrl + mouse wheel Scroll the workspace horizontally 

Shift + drag Navigate the Mind Map by panning the view within the workspace 

Ctrl + 1 Show only the main branches 

Ctrl + 2, 3, 4 Show only two, three or four levels of branches 

Ctrl + 5 Show all levels of branches 

Ctrl + Shift + "+" Expands the selected branch 

Ctrl + Shift + "-" Collapses the selected branch 

Ctrl + Shift + 1 Display the document in Mind Map view 

Ctrl + Shift + 2 Display the document in Top Down view 

Ctrl + Shift + 3 Display the document in Left/Right view 

Ctrl + Shift + 4 Display the document in Timeline view 

Ctrl + Shift + 5 Display the document in Outline view 

Ctrl + Shift + 6 Display the document in Gantt view 

Ctrl + F2 Link tasks (Gantt view only) 

Ctrl + Shift + F2 Unlink tasks (Gantt view only) 

Shift + F2 Open the Task Information dialog (Gantt view only) 

Alt + Shift + Right Indent the selected branch (Outline view) or task (Gantt view) 

Alt + Shift + Left Outdent the selected branch (Outline view) or task (Gantt view) 
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